NI
CISCO.

FlexPod Datacenter with Fibre Channel
Storage using VMware vSphere 6.5
Updatel, NetApp AFF A-series, and
Cisco UCS Manager 3.2

Deployment Guide for FlexPod Datacenter with Fibre Chan-
nel Storage using VMware vSphere 6.5 Updatel, NetApp
AFF A-series, and Cisco UCS Manager 3.2 with Cisco UCS
B200 M5 Servers

Last Updated: November 18, 2019



About Cisco Validated Designs

The CVD program consists of systems and solutions designed, tested, and documented to facilitate faster,
more reliable, and more predictable customer deployments. For more information, go to:

http://www.cisco.com/go/designzone.

ALL DESIGNS, SPECIFICATIONS, STATEMENTS, INFORMATION, AND RECOMMENDATIONS
(COLLECTIVELY, ""DESIGNS™) IN THIS MANUAL ARE PRESENTED "AS IS," WITH ALL FAULTS. CISCO AND
ITS SUPPLIERS DISCLAIM ALL WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM
A COURSE OF DEALING, USAGE, OR TRADE PRACTICE. IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE
LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING,
WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR
INABILITY TO USE THE DESIGNS, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

THE DESIGNS ARE SUBJECT TO CHANGE WITHOUT NOTICE. USERS ARE SOLELY RESPONSIBLE FOR
THEIR APPLICATION OF THE DESIGNS. THE DESIGNS DO NOT CONSTITUTE THE TECHNICAL OR OTHER
PROFESSIONAL ADVICE OF CISCO, ITS SUPPLIERS OR PARTNERS. USERS SHOULD CONSULT THEIR
OWN TECHNICAL ADVISORS BEFORE IMPLEMENTING THE DESIGNS. RESULTS MAY VARY DEPENDING ON
FACTORS NOT TESTED BY CISCO.

CCDE, CCENT, Cisco Eos, Cisco Lumin, Cisco Nexus, Cisco StadiumVision, Cisco TelePresence, Cisco
WebEX, the Cisco logo, DCE, and Welcome to the Human Network are trademarks; Changing the Way We
Work, Live, Play, and Learn and Cisco Store are service marks; and Access Registrar, Aironet, AsyncOS,
Bringing the Meeting To You, Catalyst, CCDA, CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, CCVP, Cisco, the
Cisco Certified Internetwork Expert logo, Cisco I0S, Cisco Press, Cisco Systems, Cisco Systems Capital, the
Cisco Systems logo, Cisco Unified Computing System (Cisco UCS), Cisco UCS B-Series Blade Servers,
Cisco UCS C-Series Rack Servers, Cisco UCS S-Series Storage Servers, Cisco UCS Manager, Cisco UCS
Management Software, Cisco Unified Fabric, Cisco Application Centric Infrastructure, Cisco Nexus 9000
Series, Cisco Nexus 7000 Series. Cisco Prime Data Center Network Manager, Cisco NX-OS Software, Cisco
MDS Series, Cisco Unity, Collaboration Without Limitation, EtherFast, EtherSwitch, Event Center, Fast Step,
Follow Me Browsing, FormShare, GigaDrive, HomeLink, Internet Quotient, 10S, iPhone, iQuick Study,
LightStream, Linksys, MediaTone, MeetingPlace, MeetingPlace Chime Sound, MGX, Networkers, Networking
Academy, Network Registrar, PCNow, PIX, PowerPanels, ProConnect, ScriptShare, SenderBase, SMARTnet,
Spectrum Expert, StackWise, The Fastest Way to Increase Your Internet Quotient, TransPath, WebEx, and
the WebEx logo are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and
certain other countries.

All other trademarks mentioned in this document or website are the property of their respective owners. The
use of the word partner does not imply a partnership relationship between Cisco and any other company.
(O809R)

© 2019 Cisco Systems, Inc. All rights reserved.


http://www.cisco.com/go/designzone

Table of Contents

EXECULIVE SUMIMIAIY .. etu i etetit et et e et e ettt e e et e e e et e e e et e e e eaa e eeee s e e eeta e e e saa e e e eaa e e eaa e e e s neeean e e e aanneeessnneeeaanneeesneeessnneeessnneeennnaeesnnaeesnnnns 9
S0 [W1 [ A I @ V=T AV 1= PP TSUPPPPPRPN 10
Ty geTo [UTex (o] o H TP PPPPTPPPPTRRPRRPPIN 10

F 0o 1= o o= PP TUPPPPPPPTRRRPPRPPPN 10
PUIPOSE OFf thiS DOCUIMENT ... ..ttt e ettt oo e ettt oo e e e et ettt oo oo e et eeeta e e e e et e ee b e ba e e e e e e e e ebaa e e e eeeeessba e eeeaeesbbanaeeaeeennnen 10
AT = L N[ PP TR PPPPPPPTRTRPPSPPIN 10

IS Y0111 o T I 1= o o S 11
Y g a1 (=T o (U U PP TUPPPPPPPTRRRPPUPPIN 11

[ 07 oz= U ] oL ] [o o Y PP PPTPPTRT SRR 12
Deployment HAardwWare and SOFIWEIE .........viieuiiiiiieee e et e e e e e e et e e et e e e ea e e e et e e e et e e eeta e e e eas s eeeaan e eeannaeennnnnenesnnseennnneennnnaas 14
101V L= =Y (o] o L TP UUPPPPPTRR 14
(e ] g1 To [0 =N i) g W €1V ] Lo [=1 1 0 T=T TSP 14

[ 01 AT L0= U ) =T 1 0o U PR 16

[ [23dd To = o] 1o S 16
NetwOrk SWILCh CONTIQUIALION .......ciiiiiiii e e e et e e e e e e e e e e bbbt e e e st e e bt e e e s e e e s bt s e e e e s e estba s e e eeees 19
[ 01 VAT o= LN @ T =T ox €AY/ PPN 19
FIEXP OO CISCO NEXUS BASE......iiiiiiiiiiee ettt e ettt e e ettt e e e e ettt ta et e et e et et s e e e et e ee s et e e e e et ee et e et e e e e e eese b e e eeeeesnbnn e eeeeeennnen 19
Set UP INItIAL CONFIQUIATION. .....ete oottt e oottt e oo e e ettt tb e oo e e e e et baa e e e e e e e esebaa e e e e eeeebea e e eeeeeestbanaaeeeeeeennen 19
FlexPod Cisco NexXus SWItCh CONFIQUIALION ..........iiiiiiiiiiii ettt et e et e ettt e e e et e e e e ea e e eaa e e een e e eean e eeenneeeennneeennnnaas 21

S g E= o] [ o= g YT TSP PPPPPPTRRPPPPPIN 21

Set Global CONTIQUIALIONS ... s 22
(01 f T 1 LY Y N L PP PPRPP 22

Add NTP DiIStrIDULION INTEITACE ......eeeiieii ettt oo e et ettt e e e e e et e e et e e e e et e e eb e e e e e e e e ee s e e e e e e eenenaa s 22

Add Individual Port Descriptions for TroubIESNOOTING ...........uuiiiiiiiiiiiiiii ittt ee e e ee e e e seeeeeeeaeeeeeeeeeeeeeenneeneees 23

(@Y= LSl oo A 1 g F= T T =] USRS 24
(o] a1 e 0T g=T =lo] oy @ aF= T o T=T I oo = Uy 1= (T £ 25
(@e] a1 T 18T =INY AT (8 F= U = o f O o - T 1= S 26
Uplink into EXisting NetwWOrK INFIASTIUCTUIE .........cooiiiiiiiii et e et e e e e ettt e e e e e e en b e eeaees 28

ST o =T [ @0 1T 01 =14 o] o S 29
NetAPP All FIASh FAS AS00 CONTIOIEIS .....eeieieetitiee et e et e et e e e et e e e et eeeeaa e e eaa e e eeaa e eeeeaaeeeaanaeeeaaaaeesnaaeennaeesnnneennnaeeennneeennnns 29
NETAPP HAIAWAIE UNIVEISE......euuiiiiiiiiiiiiiiiii s 29
(0] o1 4 o] =T = PRSPPI 29

DIUSK SNEIVES ...ttt oo oottt oo e et ettt h oo e e e ettt e th e oo ettt e e R h e e oo e et e ee bRt e e ettt e eh et e e e e e eeee b e e e e eeeernaaaaaaaes 29
NETADPD ONT AP O e oo oo e et e e e e e e e oot et s oo e s e e et ba s e e e e et eaa b b s e e e e e ea bbb s e s e e e e e s bbb s e e s s e enabaa s e e eaes 29
Complete ConfigUration WOTKSNEEL . ........couui it e e et e e et e ettt e e e et e e e ea e e e et e e eatn s eaeaan e eeeanneaeeen 29



(@0] a1 e 8T =I@ AV 17N S N[0T =S 30

[ Yo |1 I (o TR 1 [T O 11 (T PPN 38
ZEr0 All SPAre DISKS ....coiiiiiiiiiiie e 38
Set Onboard Unified Target Adapter 2 POrt PerSONAIILY .........viiiiiiiiiie et e e e e e e e e e e e e e e e eaa e e e enneeeennns 38
Set AULO-ReVErt 0N ClUSTEr IMANAGEIMENT ... ...... it e e e e e et e e ee e e e eat e e e eaa e e e aa e eeatanaeeasaaeeasn e aessnaaessnaaessnneeesnnaeeesnneerennns 39
Set Up Management BroadCast DOMEIN ..........iiiiiiiuuiiiiie ittt r et e e s et e e e e e et e e bbb s e e e s et e e bt e e e e e s eesbbeaneeeeees 39
Set Up Service Processor NetWOTIK INTEITACE ...... oot e et e e et e e e et e e e et s e e eaaneeeannaeeees 40
(O (T 1 Lo [ £ o F= L OO ORI 40
VEIITY STOrA0E FAIIOVET ......citiiiiii it e et e e e e e e e e e e e e et e bt e e e e e e e e e b e e e e e e e e eaeb s e e e e s enabaa s 40
Disable Flow Control on 10GDE and 40GDhE POITS .......uiiiiiieieii et e et e et e e e e e e e e et e e e ea s e e eat s e e eaa s eeeta e eeatn s eeeaanaeeeannaeeeen 41
Disable Unused FCOE Capability ON CNA POITS .....iiiiiiiiiie et e et e s e e e e e e e e e e et e e e ea s e e eaa e e e eaaseeeannaeeatnseaeannaeeeannneeeen 42
(0] a1 1o T8 =T\ =Y Y/ ¢ G T g =T 0 (Y | PN 42
Configure Simple Network Management PrOtOCOI .........c...iiiiiei e e e e e e et e e e e e e e et e e e e e e e e eanaeeeen 42
(@0] a1 8T =30 AN 035 U] o] o o o (S 43
Enable CiSCO DISCOVEIY PrOTOCON ... .c.uuuiiiiii e ettt e ettt e e et e e e et e e e et e e e e e e e e et e e e eaa e e e eaaeeeanneeeatnseeesnnaeeesnnaaeeen 43
Create Jumbo Frame MTU Broadcast DOmMaiNS iN ONTAP ...ttt e e e et e e e et s e e e e e e e eaneaeeen 43
(@3 LT (I ) (=T g 1= o €] (0T o LN 43
(O = LY I APPSR PUPPIN 43
Create Storage Virtual MaCINE . .........oooiiiiiii et e e e e e e e e e e e e e e e b s e e e s e esbb e e e aees 43
Create Load-Sharing Mirrors 0f SVM ROOt VOIUMIE........ccuuiiiiiiie ettt e et e e et e e et e e e et e e e eat s e eeaan e eeeannaeeeen 44
(@=Ll = o Tod T o] o Lo o] I (2l @ RS TT o/ o - S 44
CONTIGUIE HTTPS ACCESS ... iiiiiiiiiie ittt ettt e ettt e e e et et e b e et e e et e e et e e e et et e bbb et e e et e e e bbbt e e et et e aaba e e e e et eenabaaneeaaees 45
(0] a1 0 0T =0 Y2 S 46
CrEale FIEXVOI VOIUMES ... ettt ettt oot ettt e e b e oo e et ettt ha o e e e e e e e ta b oo e e et e et bab e e e e e eeees b e eeeeeenbnnnaaeeaees 46
(O ¢=T= 1Sl =To o B I UL PSPPSR PUPPPN 46
Yot LYo (U1 TSI =T o [ o) Lo 4] o 47
(O = L O I PPN 47
(O = LI NS T I | PP SPPPTPUPPPNN 47
Add INFrastruCture SVIM AGMINISTIALOL ....... ittt e et e e et a e e e et e et et s e ettt e e e e ta e e e ta e e e eab e e eeba e eeebaneaenennaas 47
Y= VL= g @ e 18] =1 1T S 49
CiSCO UCS BaSE CONFIGUIALION ... s 49
Perform Initial Setup of Cisco UCS 6332-16UP Fabric Interconnects for FlexPod ENVIrONMeNts ...........covveeviiiieiiiiiieiinneeeiieeees 49
(@S0 T O L@ 0= 1 1] o S 51
[T T I (o I @ =Yoo J O L @S|V = g - Vo =1 S 51
Upgrade Cisco UCS Manager SOftWare tO VEISION 3.2 .....cooiiiiiiiiii ittt e et e e e e et e e e et ee b e e e ees 51
2N Lo 0377041 T8 L 3N = =T oY) o 1] o S 51
(@] a1 o 0TI O T=Y oo I U @S T O || N o 3 = PN 52



(@0] a1 e 0TI 1oy 1T=T o [ = 0] o £ 52

Add BIOCK Of IP AQAIESSES FOI KVIM ACCESS ...c..tuieeet ettt e ettt e ettt et oo e et ettt ae e e e e e et e eetaa e e e e e et et baa e e e e eeeeesbaa e eeeaeennnnnnnnns 54
SYNCHIONIZE CISCO UCS 10 NTP ... e 54
Edit ChasSisS DISCOVEIY POICY ... ceeuuieiiiieeeitie et e e et et e e e et e e et e e e aa e e e eaa e e e eaa e e e ean e e eeaa e e e eaneeeenn e eeenneeeasnneenannseeeannaeenen 56
Enable Server and UPINK POITS .......iiii it e et e e e et e e e et e e e eat e e e et s e e eaa e e e eta e e e eaan e e e eaaeeessneaeasnneeesnnseeesnnaaeeen 56
Acknowledge CiSCO UCS ChasSIS AN FEX........uuiiiiiiiiiiiiiiii it e e e e e e e e e e e e e e e e et e e e e s anabae s 57
Create Uplink Port Channels t0 CiSCO NEXUS SWITCNES .......iiiiuiiiiiiiiie et e e e e e et e e e et eeeat s e e eaa e e e eanaeeeen 58
Create @ WWINN POOI FOr FC BOOL .......ciiiiiiiiiie e eeieeitt ettt e e e e ettt e e e ettt et b e e e e e e eeba b e e e e et ee e b a bt e e e eeeeenba e e eeeeeennnnnaaaeaees 59
CrEALE WWVPN POOIS ... ettt ettt ettt ettt ettt ettt e e et e e et a e et eh e et et s e et et e e et ea e e e et e e e e e e e e eh e e e et e e eatn s eeeaa e e e eannaeeeen 61
CrEALE VSAN ..ot 64
Create FC UPINK POt CRANNEIS .......iiiieeeie e e ettt e e e e e e e e e e e e e e e eaa s e e eaa e e eeta e e e eaneeeean e eeenneeeasnneanannseeesnnaeenen 66
CrEate VHBA ToMIPIALES. ... ettt ettt oo ettt e oo e ettt bt e e e e e et e et aa e e e e e e eetaba e e e e e e eeebaa e e eeeeeebbban e eeaeeeebnanaaeaaaes 68
Create SAN CONNECHIVILY POIICY ....uuiiiiiiieiiiie ettt e et e ettt e et et e e eat e e ettt s e e eea e e e eta e e e eaaeeeeaaseeeaneeeatnneenannneeesnnaaeeen 71
Create MAC AAArESS POOIS .....oouiiii ettt oottt e e e et ettt e et e ettt et ba e e e e e et e ta b e e e e et eeeba b e e e eeeeesn b e e eeeeeerrnnaaeeaaes 73
Create UUID SUTTIX POOL ... ..ttt e oo et ettt oo e e et ettt ta e e e e ettt tata e e e e e e e et baa e e e e e e eeaaba e eeaeeesbnanaaeaaaes 76
(O T= L LI V=T g = o To | OO PUPPINN 77
(@8 T (Y Y N 77
Modify Default HOSt FITMWAIrE PACKAGE .........uuui ittt oottt e e ettt e e e e et et tbb s e e e e e eeesta e e eaeeesananaeaaaees 80
Set JUMDO Frames iN CISCO UCS FADIIC .......uiiii ettt ettt e et e e e eh e e et e e e et s e e e aa s eeeanneeeeen 81
Create Local Disk Configuration POIICY (OPLIONAI) .......iieiuiiieiiie et e e e e e et e e et e e e et s e e eat s e eeaan e eeeannaaeees 82
Create Network Control Policy for Cisco Discovery Protocol (CDP) and Link Layer Discovery Protocol (LLDP) ........c.cc.ccceuvneeee. 83
Create POWET CONIOI POIICY .....cuiiiiiieii ittt ettt e e e ettt et e e et et e b et e e e et e e e bbb e e e et et eaab e e e e et eenbbaaneeaaees 84
Create Server Pool Qualification POICY (OPLIONAI) ......iiiieiieiiie it e e e e e e e e et e e e ea e e eat s e eeaan e eeeannaeeeen 85
(O L E SIS T =T Y= g 2110 1S =0 T3 S 86
Update the Default MaiNteNANCE PONCY ... s 91
(@=L LIV N (@ =T g1 o F= LTS 92
Create LAN ConNECLIVItY POIICY FOI FC BOOT ......uuiiiiiiieiiiieeeiie ettt e ettt e e et e e e e e e ettt e e e ea e e e et e e e eaa e e e eaneeeanneeeasnseaennnseeennnaaeeen 95
Create vMedia Policy for VMware ESXi 6.5 UL ISO INStall BOOL...........uu s 97
CrEale FC BOOT POICY .....uuiiiiiiiiiiiie ettt e e e et e e et e e et et e b e e e e e e et e e bbb e e e et et e ab b e e e et e e e aba e e eaees 99
Create ServiCe Profile TEMPIALES .........u ittt e e e et e e et e e e et e et et e e eata e e eeaanaeeeta e e eetn e eeannneeeenneeeennaees 102
Create vMedia-Enabled Service Profile TEMPIALE.........ccoooi i 109
CrEate SEIVICE PrOTIES ...ttt ettt ettt e et eh e e et b e et et e e et et e e e et e e e et e e e et e e eea e e eananaaes 110
Add MOTe SErvers t0 FIEXPO UNI ........iiiiiieiii ettt e et e e e ettt e e e e et e e et e e e e et e e e b e e e e e e et e eeaa e e e e e e eennen e es 110
Gather NeCESSAIY INTOMMALION .......cieii e e et e e e e e e et e e e et e e e et e e eeta e e e eaaa e e eaan e eeaa e eeeannneeesnneeannaeessnneeesnnneenenn 110
PRYSICAI CONNMECTIVILY ....etvieiieieeiieetee ettt oottt e e e oo et e et e e e ettt e e s e e e e e et e e st e e e et et et b e e e e e e et e ebea e e e e e s eesabaaneeeeanens 112
FIEXP OO CISCO IMDS BASE......ciiiittiiieeeeeeettt e ettt e e e et ettt e et e e et et et e e ettt e he e e e e e e et e e eha et e e et e e e sea e et e e e e eesta e e e e e eennntneeeeeeens 112
Y= 108 o a T = I @ o] a1 U1 =11 o o N 112



FlexPod CiSCO MDS SWItCh CONFIQUIALION.........cuuiiiiiii s e et e e e e e e e e e e e ea e e e et e e eeea e e eaan e e ean e eeannaeeennnaeeennnaeneens 114

=g F= o] [ I Tot=T g YT TP PP PP PPPPTR PR URPPPPPIN 114
COoNfIGUIE INAIVIAUAL POITS ... e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e s e e e e e e e e e e e n e e e ne s 115
(O oo Y [ S S TP 115
Create POrt DESCIIPLIONS = FADIIC B....... ittt e e e e e e et e e e et e e e et e e e eat e e e eaan e e e et e e eesaaeeananseesnnneennnaeaes 116
CrEALE VS ANS. ...ttt ettt ettt ettt ettt e ettt r ettt e ettt e et et e et e a et e oo e e E e et e h e e et b e e e et n e e e ea e e ettt e et e e e eaa e e e eh e e eraneae 117
CrEALE DBVICE AlIBSES ... .. eiiieittte ettt oo et e et ettt et e oo e et e et b e e e oo e et e e e bt e e e et e e e e e e e ettt e e e e e e et e et e e e e eene 117

L@ L= 11 A o ) T PR 118
Storage Configuration = BOOT LUNS........ooiiiiiiiiii ettt e e et e e e e e s et e b e e e e e e st e et e e e e s et e s b b s e e e s e eabbbneeeeenens 119
(@R T To B (o] =T [T =] (U o BT PP TP 119
(@3 1= 11N T | {0 11 o 119

Y T ol =ToTo) MU NS (oI o (o101 o TP UPPPPTT TR 119
VIMWATE VSPRNEIE 6.5 UL SBIUP . ...uuiiiiiieiiiiieeiite ettt e et e et e e e et e e e et e et et e et ea e e e ea e e e eetneeeaaee e et e e eatn e eeeeaneeetnneeeeenneeeennnes 120
VIMWAIE ESXI 6.5 UL ...ttt ettt ettt ettt ettt et et et e e et et e et e e e e e e e e e e e e e e et e e e e e aaaaeaens 120
Download ESXi 6.5 UL frOM VIMWAIE .......ccoiiiiuiiieeieiiiiet e e e ettt e e et e ettt e e e e e e eebaa s e e e e et e e eba e e e e e e eebab e e e eeeee bbb e e eaeeeesnnnn e eeas 120
Log into Cisco UCS 6300/6200 FaDIC INTEICONNECT ........ciiiiiiiiiiiii et e e e e e e e e r e e e 120
Set Up VMWAre ESXI INSTAIIALION ......ceeuiiiiie ettt e e et e e e ea e ettt e e e e et s e e e et s e e eta e e e etn e e eeaneeeenneeeennaaes 121
S = 1| S PP UPPPPTTTRR PP 121
Set Up Management Networking fOr ESXI HOSTES.........oiiiiiiiiiiii e e e e e 122
Reset VMware ESXi Host VMkernel Port vmkO MAC Address (OPtioNaAl) ........oeeuuieiiiiiieiiiie et eae e e 124
Log into VMware ESXi Hosts by Using VMWare HOSt CHENT ........ciiiiiiiiiiii et e e e e e e e e e e e e e e e eeennnes 125
Set Up VMKernel Ports and VirtUal SWILCH .........cooiiiiiii e e e e e e e eaees 125
Install VMware Driver for the Cisco Virtual Interface Card (VIC) ....oeuu it e e e et e e e e eeennnes 127

Y oTU Lo L=To [U 1= To I - 1= o = 128
CoNfIGUIE NTP 0N ESXI HOSES ... e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e 130
YA V=L SRR O =T g =T g TR U L PP 131
Build the VMware VCeNter SEIVEr APPIIANCE .......uu ettt e e e et e e e et e e e aa e e eea e e eana e e esaseeeannseeesnnaaeeennaeeennnes 132
SELUP VIMWAIE VCENTET SEIVEN ....uuiiiiiiiiii ettt e e e e e e e e e e b e e e e e et e s e b e e e e s e e s ba s e e e e e e saabba s e e s s sasabba s e e eeaanes 143
Cisco UCS Manager Plug-in for VMware vSphere Web Clent ..o 149
Cisco UCS Manager PIUug=iN INSTAIIALION ........oiiii e e et e e e e e e et e e e et e e e et e e e et e e eanneeeenneeeenneees 149
FlexPOod UCS DOMAIN REQISTIALION ......ccoiieiieei e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e nae s 151
Use the CiSCO UCS VCENTET PIUGIN ......oiiiiiiiiiie ettt e e ettt e e e e et e et e e e e et e e e b e e e e e e e e te st e e e e e eeaabb s e e eeeeens 152
FlexPod VMware vSphere Distributed SWITCH (VDS) ...t iiiiiiii ettt et e e et e e et e e e e e e e e e e e e e e e e eateeeeanneeneens 155
Configure the VIMIWAIE VDS IN VCENTET ... .cceuiieiiii e e et e et e e e et e e e et e e e et e e e et e e e et e e e et e e e eatn e e aeaan e eeetnn e eetnaeeannnseesnnnneennnnaees 155
FlexPod ManagemeENnt TOOIS SETUD .....uuuuiiiiiiiiiii ettt e ettt e e e e et e e e e e e et e et et e e e et e e b b e e e e e et esseb e e e e e e s enabaaneeeaenens 163
NetApp Virtual Storage Console 6.2.1 DeployMENt PrOCEAUIE ... .....ii i e e et e e e e e e e e ea e e e ea e e e eae e eaennaeeeens 163
Virtual Storage Console 6.2.1P1 Pre-installation CONSIAEIatiONS .........c..uiiiiiiiieiiiiieeeii e e e e e e e e e e e e e e e e et e e eeeaeeeananes 163



Install Virtual Storage CONSOIE B.2. 1P L. .....c.uieiiiii e et e e e e et e e et e e e eat e e e eaa e e eeaa e e e ean e e ees e e eenneeeasnaeaeannseeesnnaaeesnnaeeennnes 163

Register Virtual Storage Console WIth VCENTET SEIVET ........ccuuuieeiiieeeeiie e et e e et e e e e e e et e e e et e e aeaa e e eetaeeetaaeeanneerenneeennnaaaes 165
INSTAll NETADPD NFS VAAD PIUG =N 1 ..tttttttitiitttittittteeetbeeteeee ettt ettt sttt sttt enne e 165
DI[SYeT0)VI=T o Ta o AN [0 BES] o] = Vo T= Tl Lo Yo LU o7 166
Optimal Storage SettingS fOr ESXi HOSES .....iiiiuiiiiiiieeiie et e et e e et e e et e e e et e e e et e e e et e e e esneeeasaeeeanneaessnaeeesnnaeensnn 166
Virtual Storage Console 6.2.1P1 ProvisSioning DAtaStOreS ..........ccuuuuiiiiiiiiiiiiiii et e e e e e 168
Virtual Storage Console 6.2.1P1 BACKUP ANA RECOVEIY ......uuiiiiiiieeiiiieeeiie ettt e et e e et e e et e e e et s e e e et e e e eaa e e e et e e eeaneeeennnes 176

ST Taa] o] [T =T o= UL 0 Y7 T T o1 T RS 182
Y o] 1= g T [ PP PPTOT 184
CisCO UCS FCOE DirecCt StOrage CONMNECT SETUP ....icuuuiiiiiieeiii et e et e et e e et e ettt e e e et e e e eata s e aeaan s e e eta e e eetnaeeennseeenneeeennaaes 188
Upgrade Cisco UCS Manager SOftware t0 VErsion 3.2(L1d) .....ueeeuuuiieeiieeeeeiiseeetseeeeis e e eetaeeeeat e e aeaa s eeeaaaeeeenaeeanneeesnneeeennaaees 188

Y gl ] )Y 4T 1 ER (=T oTo] 4 1o Ve H PP UUUPPPPTPTP 188
CoNfIGUre CISCO UCS Call HOME ....iiiiiiiieeiee ettt e et e e et e e e ea e e e ea e e e e et e e e e et e e e eta e e e eta e e eanneeeenneeeennaaes 189
Place Cisco UCS Fabric Interconnects in Fiber Channel SWitChing MOE.............iiiiiiiiiiie e 189
Edit ChasSisS DISCOVEIY POICY ... .cuuuieiiiiieiiie e ettt e et e et e e e e e e e et e e e et e e e asa e e e eaaee e et eeeatn e eesanaeeesanaeessanaaeannnseessnnneennnnaes 191
Enable Server and UPIINK POITS ... e e e e e e s e e e e e e e e e e e st e e e e s e e aabb e e e e eaees 192
Acknowledge CiSCO UCS ChasSiS AN FEX......cciiuuiiiiiiiii it e e et e e e et e e et e e e eaa e e e et e e e et e e eat e e aeaan s e e eaneeeeaneeeennnes 193
Create @ WWNN POOI fOr FCOE BOOL ... ..ottt ettt oo e ettt e e e e e e ettt e e e e et e et ba e e e e e e eeesta e e eeeeeetntaaaeeaeeees 195
CrEALE WWVPN POOIS ...ttt ettt ettt et e e et e ettt e e et e e e et e e et e e et ea e e et b e e e e et s e e e et e e e e ta e e e e ta e e e eaa e e eenaneeenaeaes 197

P IS o [ Y S A N[ (ol o @fo ] =S (o) = To [ 2o £ OO PPPOPPTRPPTRRP 202
CrEALE SEIVEE POON ...ttt oottt e oot ettt e oo e e ettt hta e oo e ettt et bt e e e et e e e b a e e e e e ettt e th e e e et eeennt e e eeeeee 210
(01T LY Y N PO PP UPT PP PPPPPIR 210
Modify Default HOSt FIrMWAIrE PACKAGE ... ..c..uieiiii ettt e et e e et e e e e e e e ea e e e e e e eae e e e ean s e e etneeeeaneeeennnes 213
Set JUMDO Frames iN CISCO UCS FADIIC ... .ottt ettt e e e e et ettt e e e e e et et st e e e e e eeeebnaaaeeeeeees 214
Create Local Disk Configuration POlICY (OPLIONAI) ........coeiieeieeeeeee e 215
Create Network Control Policy for Cisco Discovery Protocol (CDP) and Link Layer Discovery Protocol (LLDP) ....................... 216
(O LTI T = Y= g 21 1@ 1S =0 T3 219
Update the Default MaiNtENANCE POICY ........ccooeieeee e 224
Create VNIC TEMPIALES ... .ottt ettt et e e et et e b e e e e e et e b e b e e e e et e e e b e e e e e e e e eestb e e e e e eeaabbaneeeeenens 225
Create LAN ConNECLiVIty POIICY FOF FC BOOL ......uuiiiiiieeii et e e e ettt e et e e ettt e e e et e e e e et e e e e e e e et e e e et e e ennneeeenneeeennaee 228
Create vMedia Policy for VMware ESXi 6.5 UL ISO INSall BOOL.........ccooeiiieeieee e 230
Create BOOt POICY (FCOE BOOL) ... ..ttt ettt e e e et e et e e e e et e e e b b e e e e e e eeatb e e e e e eenabb s e e eeeanes 232
Create Service Profile Templates (FCOE BOOL)........cuuiiiiiiieeiie e et e et e e e e e e et e e e et e e e et e e e et e e eanneeeenneeeennaaee 235
Create vVMedia ServiCe Profile TeMPIALE. .......cccuu it e e e e et e e e et e e e e et e e e eaa e e e et e e eean e e eanneeesnneeennnanees 242
Add MOTre SErvers t0 FIEXPOO UNIL ... ettt e ettt e e et e e et et e e ettt e e e et e e et e e e e aaa e e eenaeeeeaneaes 243
Gather NeCeSSArY INFOMMALION ... ..ot e et e et e e et e e et e e e et e e e eaaa e e e ean e e e eta e e e ean e e e enneeeenneeeesnneeennneeneenn 243
AddDirect Connected TENANT FCOE STOMAQE .. .. iiiuuiiiiiiieeeie e et e et e e et e e e et e e e et e eeata e e eet e eesta s eaeaanaaeetanaaesennaaeennnseeannaeeesnnnaaes 244



(1T (I (o] = Vo TSI @ o T T=Tox ] I = o [T ox 1= 244

Map Storage Connection Policies VHBA Initiator Groups in SAN ConNECLiVIty POIICY .....cccuvuiiiiiiiiiiiiieee e 245
FIEXPOO BACKUDS ... oo e oo £ e oo £ e e e e e e e e e e e e e e e e e e e e e e e e 246
L@l T 0L @3 = T T (0 o 246

(O Tt TN VLoD (W ES == o U] o 1PN 247
VIMWAEATE VCSA BACKUP....ccciiiiiiii ittt e e et et e e e e e e e bbb e e e et et e e bt e e e s e e s bbb e s e e e e esaba e e e e s eenbabaas 248
Breakout Interface Configuration in the Cisco Nexus 9332PQ SWILCNES .....ccuuuiiiiiiii i e e a e e eeeas 250
Cisco Workload Optimization Manager (CWOM) Addition t0 @ FIEXPOA ..........oiiiiiiiiiii e e e e eeees 251

F A o To 1B 1 = U 11 oo ] T PSP 271
F Ao g0 Y/ =T [ 1T g 1T o PPN 271



I
CISCO. NetApp

Executive Summary

Executive Summary

Cisco Validated Designs include systems and solutions that are designed, tested, and documented to
facilitate and improve customer deployments. These designs incorporate a wide range of technologies and
products into a portfolio of solutions that have been developed to address the business needs of customers.
Cisco and NetApp have partnered to deliver FlexPod, which serves as the foundation for a variety of
workloads and enables efficient architectural designs that are based on customer requirements. A FlexPod
solution is a validated approach for deploying Cisco and NetApp technologies as a shared cloud
infrastructure.

This document describes the Cisco and NetApp® FlexPod Datacenter with Cisco UCS Manager unified
software release 3.2 and VMware vSphere 6.5 U1. Cisco UCS Manager (UCSM) 3.2 provides consolidated
support of all current Cisco UCS Fabric Interconnect models (6200, 6300, 6324 (Cisco UCS Mini)),
2200/2300 series IOM, Cisco UCS B-Series, and Cisco UCS C-Series. FlexPod Datacenter with Cisco UCS
unified software release 3.2, and VMware vSphere 6.5 U1 is a predesigned, best-practice data center
architecture built on the Cisco Unified Computing System (UCS), the Cisco Nexus® 9000 family of switches,
MDS 9000 multilayer fabric switches, and NetApp AFF.
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Solution Overview

Introduction

The current industry trend in data center design is towards shared infrastructures. By using virtualization
along with pre-validated IT platforms, enterprise customers have embarked on the journey to the cloud by
moving away from application silos and toward shared infrastructure that can be quickly deployed, thereby
increasing agility and reducing costs. Cisco and NetApp have partnered to deliver FlexPod, which uses best
of breed storage, server and network components to serve as the foundation for a variety of workloads,
enabling efficient architectural designs that can be quickly and confidently deployed.

Audience

The audience for this document includes, but is not limited to; sales engineers, field consultants, professional
services, IT managers, partner engineers, and customers who want to take advantage of an infrastructure
built to deliver IT efficiency and enable IT innovation.

Purpose of this Document

This document provides a step by step configuration and implementation guide for the FlexPod Datacenter
with Cisco UCS Fabric Interconnects, NetApp AFF, and Cisco Nexus 9000 solution. For the design decisions
and technology discussion of the solution, please refer to the FlexPod Datacenter with VMware vSphere 6.5

Update 1 and NetApp AFF A-series with Cisco UCS Manager 3.2 Design Guide.

What's New?

The following design elements distinguish this version of FlexPod from previous FlexPod models:

e Support for the Cisco UCS 3.2 unified software release, Cisco UCS B200-M5 servers, and Cisco UCS
C220-M4 servers

e Support for the latest release of NetApp ONTAP® 9.1
e Fiber channel and NFS storage design

e Validation of VMware vSphere 6.5 Ul


http://www.cisco.com/c/en/us/td/docs/unified_computing/ucs/UCS_CVDs/flexpod_esxi65u1design.html
http://www.cisco.com/c/en/us/td/docs/unified_computing/ucs/UCS_CVDs/flexpod_esxi65u1design.html
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Solution Design
_________________________________________________________________________________________________________________________________|

Architecture

FlexPod is a defined set of hardware and software that serves as an integrated foundation for both
virtualized and non-virtualized solutions. VMware vSphere® built on FlexPod includes NetApp All Flash FAS
storage, Cisco Nexus® networking, the Cisco Unified Computing System (Cisco UCS®), and VMware
vSphere software in a single package. The design is flexible enough that the networking, computing, and
storage can fit in one data center rack or be deployed according to a customer's data center design. Port
density enables the networking components to accommodate multiple configurations of this kind.

One benefit of the FlexPod architecture is the ability to customize or "'flex"" the environment to suit a
customer's requirements. A FlexPod can easily be scaled as requirements and demand change. The unit can
be scaled both up (adding resources to a FlexPod unit) and out (adding more FlexPod units). The reference
architecture detailed in this document highlights the resiliency, cost benefit, and ease of deployment of a
Fiber Channel and IP-based storage solution. A storage system capable of serving multiple protocols across
a single interface allows for customer choice and investment protection because it truly is a wire-once
architecture.

Figure 1 shows the VMware vSphere built on FlexPod components and the network connections for a
configuration with the Cisco UCS 6332-16UP Fabric Interconnects. This design has end-to-end 40 Gb
Ethernet connections between the Cisco UCS 5108 Blade Chassis and C-Series rackmounts and the Cisco
UCS Fabric Interconnect, between the Cisco UCS Fabric Interconnect and Cisco Nexus 9000, and between
Cisco Nexus 9000 and NetApp AFF A300. This infrastructure option expanded with Cisco MDS switches
sitting between the Cisco UCS Fabric Interconnect and the NetApp AFF A300 to provide FC-booted hosts
with block-level access to shared storage. The reference architecture reinforces the "wire-once"" strategy,
because as additional storage is added to the architecture, no re-cabling is required from the hosts to the
Cisco UCS fabric interconnect.
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Physical Topology
Figure 1  FlexPod with Cisco UCS

6332-16UP Fabric Interconnects
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The reference 40Gb based hardware configuration includes:
e Two Cisco Nexus 9332PQ switches
e Two Cisco UCS 6332-16UP fabric interconnects
e Two Cisco MDS 9148S multilayer fabric switches
e One NetApp AFF A300 (HA pair) running ONTAP with Disk shelves and Solid State Drives (SSD)

Figure 2 shows the VMware vSphere built on FlexPod components and the network connections for a
configuration with the Cisco UCS 6248UP Fabric Interconnects. This design is identical to the 6332-16UP
based topology, but has 10 Gb Ethernet connecting through a pair of Cisco Nexus 93180YC-EX switches to
access iISCSI and NFS access to the AFF A300. Alternately, the same Cisco Nexus 9332PQ switch can be
used with QSFP breakout cables and port configuration settings on the 9332PQ switch.

12
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Figure 2
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The reference hardware configuration includes:

e Two Cisco Nexus 93180YC-EX switches

e Two Cisco UCS 6248UP fabric interconnects

e Two Cisco MDS 9148S multilayer fabric switches

e One NetApp AFF A300 (HA pair) running ONTAP with Disk shelves and Solid State Drives (SSD)

For server virtualization, the deployment includes VMware vSphere 6.5. Although this is the base design,
each of the components can be scaled easily to support specific business requirements. For example, more
(or different) servers or even blade chassis can be deployed to increase compute capacity, additional disk
shelves can be deployed to improve 1/0O capability and throughput, and special hardware or software
features can be added to introduce new features. This document guides you through the low-level steps for
deploying the base architecture, as shown in Figure 1 and Figure 2. These procedures cover everything from

Legend
10GbE only

—— 10 GbE Converged ——
~ SFO Interconnect ——

16Gb FC
8Gb FC

physical cabling to network, compute and storage device configurations.
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Software Revisions

Table 1 lists the software revisions for this solution.

Table 1 Software Revisions

Layer Device Image Comments

Compute Cisco UCS Fabric 3.2(1d) Includes the Cisco UCS-
Interconnects 6200 and IOM 2304 Cisco UCS
6300 Series, UCS B-200 Manager, Cisco UCS VIC
M5, UCS C-220 M4 1340 with Port Expander

and Cisco UCS VIC 1385

Network Cisco Nexus 9000 NX-0OS 7.0(3)14(5)

Storage NetApp AFF A300 ONTAP 9.1
Cisco MDS 9148S 7.3(1)DY(1)

Software Cisco UCS Manager 3.2(1d)

Cisco UCS Manager Plugin | 2.0.2
for VMware vSphere Web

Client

VMware vSphere ESXi 6.5U1

VMware ESXi fnic FC Driver | 1.6.0.34 Included in 6.5 Ul
VMware ESXi nenic 1.0.6.0 VMware source

Ethernet Driver

VMware vCenter 6.5 U1

NetApp Virtual Storage 6.2.1P1
Console (VSC)

Configuration Guidelines

This document provides details for configuring a fully redundant, highly available configuration for a FlexPod
unit with ONTAP storage. Therefore, reference is made to which component is being configured with each
step, either 01 or 02 or A and B. For example, node01 and node02 are used to identify the two NetApp
storage controllers that are provisioned with this document, and Cisco Nexus A or Cisco Nexus B identifies
the pair of Cisco Nexus switches that are configured. The Cisco UCS fabric interconnects are similarly
configured. Additionally, this document details the steps for provisioning multiple Cisco UCS hosts, and
these examples are identified as: VM-Host-Infra-01, VM-Host-Infra-02 to represent infrastructure hosts
deployed to each of the fabric interconnects in this document. Finally, to indicate that you should include
information pertinent to your environment in a given step, <text> appears as part of the command structure.
See the following example for the network port vlan create command:

14
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Usage:
network port vlan create ?
[-node] <nodename>
{ [-vlan-name] {<netport>|<ifgrp>}
|  -port {<netport>|<ifgrp>}
[-vlan-id] <integer> }

Example:

Node

VLAN Name

Associated Network Port

Network Switch VLAN Identifier

network port vlan -node <node0Ol> -vlan-name i0a-<vlan id>

This document is intended to enable you to fully configure the customer environment. In this process, various
steps require you to insert customer-specific naming conventions, IP addresses, and VLAN schemes, as well
as to record appropriate MAC addresses. Table 3 lists the virtual machines (VMs) necessary for deployment
as outlined in this guide. Table 2 describes the VLANs necessary for deployment as outlined in this guide.

Table 2 Necessary VLANs

VLAN Name VLAN Purpose ID Used in Validating This Document
Out of Band VLAN for out-of-band management interfaces 13

Mgmt

In-Band Mgmt | VLAN for in-band management interfaces 113

Native VLAN to which untagged frames are assigned 2

NFS VLAN for Infrastructure NFS traffic 3050

FCoE-A VLAN for FCoOE encapsulation of VSAN-A 101

FCoE-B VLAN for FCoE encapsulation of VSAN-B 102

vMotion VLAN for VMware vMotion 3000

VM-Traffic VLAN for Production VM Interfaces 900

Table 3 lists the VMs necessary for deployment as outlined in this document.

Table 3 Virtual Machines

Virtual Machine Description

Host Name

Active Directory (AD)

vCenter Server

NetApp VSC

15
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Physical Infrastructure

FlexPod Cabling

The information in this section is provided as a reference for cabling the physical equipment in a FlexPod
environment. To simplify cabling requirements, the tables include both local and remote device and port
locations.

The tables in this section contain details for the prescribed and supported configuration of the NetApp AFF
A300 running NetApp ONTAP® 9.1.

# For any modifications of this prescribed architecture, consult the NetApp Interoperability Matrix Tool (IMT).

This document assumes that out-of-band management ports are plugged into an existing management
infrastructure at the deployment site. These interfaces will be used in various configuration steps.

‘ﬂ Be sure to use the cabling directions in this section as a guide.

The NetApp storage controller and disk shelves should be connected according to best practices for the
specific storage controller and disk shelves. For disk shelf cabling, refer to the Universal SAS and ACP

Cabling Guide.

Figure 3 details the cable connections used in the validation lab for the 40Gb end-to-end with Fibre Channel
topology based on the Cisco UCS 6332-16UP fabric interconnect. Two 16Gb uplinks connect as port-
channels to each Cisco UCS Fabric Interconnect from the MDS switches, and a total of four 16Gb from the
MDS switches to the AFF controllers. Additional 1Gb management connections will be needed for an out-
of-band network switch that sits apart from the FlexPod infrastructure. Each Cisco UCS fabric interconnect
and Cisco Nexus switch is connected to the out-of-band network switch, and each AFF controller has two
connections to the out-of-band network switch.

# To obtain 40Gb end-to-end connectivity, the VIC 1340 along with the Port Expander must be used in the B-
Series servers. If just the VIC 1340 is used, server virtual network interface cards (VNICs) will have 20Gb con-
nectivity. More information on server network connectivity is provided in the Design Guide for this solution.

16
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Figure 3 FlexPod Cabling with Cisco UCS 6332-16UP Fabric Interconnect
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Figure 4 details the cabling connections used in the alternate 10Gb end-to-end topology based on the Cisco
UCS 6248UP fabric interconnect using the MDS switches for 8Gb Fibre Channel links. As with the 40Gb
topology, out-of-band connections will also be needed, with each Cisco UCS fabric interconnect and Cisco
Nexus Switch will have a connection to the out-of-band network switch, and each AFF controller will have

two connections to the out-of-band network switch.

Figure 4
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Network Switch Configuration

This section provides a detailed procedure for configuring the Cisco Nexus 9000s for use in a FlexPod
environment. Follow these steps precisely since failure to do so could result in an improper configuration.

Physical Connectivity

Follow the physical connectivity guidelines for FlexPod as covered in the section FlexPod Cabling.

FlexPod Cisco Nexus Base

The following procedures describe how to configure the Cisco Nexus switches for use in a base FlexPod
environment. This procedure assumes the use of Cisco Nexus 9000 7.0(3)I4(5), and is valid for both the
Cisco Nexus 9332PQ switches deployed with the 40Gb end-to-end topology, and the Cisco Nexus
93180YC-EX switches used in the 10Gb based topology.

# The following procedure includes the setup of NTP distribution on the in-band management VLAN. The inter-
face-vlan feature and ntp commands are used to set this up. This procedure also assumes that the default
VREF is used to route the in-band management VLAN.

Set Up Initial Configuration

Cisco Nexus A

To set up the initial configuration for the Cisco Nexus A switch on <nexus-A-hostname>, complete the
following steps:

1. Configure the switch.

# On initial boot and connection to the serial or console port of the switch, the NX-OS setup should au-
tomatically start and attempt to enter Power on Auto Provisioning.

Abort Power on Auto Provisioning and continue with normal setup? (yes/no) [n]: yes
Do you want to enforce secure password standard (yes/no) [y]: Enter

Enter the password for "admin": <password>

Confirm the password for "admin": <password>

Would you like to enter the basic configuration dialog (yes/no): yes

Create another login account (yes/no) [n]: Enter

Configure read-only SNMP community string (yes/no) [n]: Enter

Configure read-write SNMP community string (yes/no) [n]: Enter

Enter the switch name: <nexus-A-hostname>

Continue with Out-of-band (mgmtO) management configuration? (yes/no) [y]: Enter

MgmtO0 IPv4 address: <nexus-A-mgmtO-ip>
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Mgmt0 IPv4 netmask: <nexus-A-mgmtO-netmask>

Configure the default gateway? (yes/no) [y]: Enter

IPv4 address of the default gateway: <nexus-A-mgmtO-gw>
Configure advanced IP options? (yes/no) [n]: Enter
Enable the telnet service? (yes/no) [n]: Enter

Enable the ssh service? (yes/no) [y]: Enter

Type of ssh key you would like to generate (dsa/rsa) [rsal]: Enter

Number of rsa key bits <1024-2048> [1024]: Enter

Configure the ntp server? (yes/no) [n]: y

NTP server IPv4 address: <global-ntp-server-ip>

Configure default interface layer (L3/L2) [L3]: L2

Configure default switchport interface state (shut/noshut) [shut]: Enter

Configure CoPP system profile (strict/moderate/lenient/dense/skip) [strict]: Enter

Would you like to edit the configuration? (yes/no) [n]: Enter

2. Review the configuration summary before enabling the configuration.
Use this configuration and save it? (yes/no) [y]: Enter

Cisco Nexus B

To set up the initial configuration for the Cisco Nexus B switch on <nexus-B-hostname>, complete the
following steps:

1. Configure the switch.

# On initial boot and connection to the serial or console port of the switch, the NX-OS setup should au-
tomatically start and attempt to enter Power on Auto Provisioning.

Abort Power on Auto Provisioning and continue with normal setup? (yes/no) [n]: yes
Do you want to enforce secure password standard (yes/no) [y]: Enter

Enter the password for "admin": <password>

Confirm the password for "admin": <password>

Would you like to enter the basic configuration dialog (yes/no): yes

Create another login account (yes/no) [n]: Enter

Configure read-only SNMP community string (yes/no) [n]: Enter

Configure read-write SNMP community string (yes/no) [n]: Enter

Enter the switch name: <nexus-B-hostname>
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Continue with Out-of-band (mgmt0O) management configuration? (yes/no) [y]:

Mgmt0 IPv4 address: <nexus-B-mgmtO-ip>

MgmtO IPv4 netmask: <nexus-B-mgmtO-netmask>

Configure the default gateway? (yes/no) [y]: Enter

IPv4 address of the default gateway: <nexus-B-mgmtO-gw>
Configure advanced IP options? (yes/no) [n]: Enter
Enable the telnet service? (yes/no) [n]: Enter

Enable the ssh service? (yes/no) [y]: Enter

Type of ssh key you would like to generate (dsa/rsa) [rsal: Enter
Number of rsa key bits <1024-2048> [1024]: Enter

Configure the ntp server? (yes/no) [n]: y

NTP server IPv4 address: <global-ntp-server-ip>

Configure default interface layer (L3/L2) [L3]: L2

Configure default switchport interface state (shut/noshut) [shut]: Enter

Enter

Configure CoPP system profile (strict/moderate/lenient/dense/skip) [strict]: Enter

Would you like to edit the configuration? (yes/no) [n]: Enter

Review the configuration summary before enabling the configuration.

Use this configuration and save it? (yes/no) [y]: Enter

FlexPod Cisco Nexus Switch Configuration

Enable Licenses

Cisco Nexus A and Cisco Nexus B

To license the Cisco Nexus switches, complete the following steps:

1.

Log in as admin.
Run the following commands:

config t

feature interface-vlan
feature lacp

feature vpc

feature 1lldp

feature nxapi
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Set Global Configurations

Cisco Nexus A and Cisco Nexus B
To set global configurations, complete the following step on both switches:

Run the following commands to set global configurations:
spanning-tree port type network default
spanning-tree port type edge bpduguard default
spanning-tree port type edge bpdufilter default
port-channel load-balance src-dst l4port
ntp server <global-ntp-server-ip> use-vrf management
ntp master 3
ip route 0.0.0.0/0 <ib-mgmt-vlan-gateway>

copy run start

Create VLANs

Cisco Nexus A and Cisco Nexus B
To create the necessary virtual local area networks (VLANS), complete the following step on both switches:

From the global configuration mode, run the following commands:
vlan <ib-mgmt-vlan-id>
name IB-MGMT-VLAN
vlan <native-vlan-id>
name Native-VLAN
vlan <vmotion-vlan-id>
name vMotion-VLAN
vlan <vm-traffic-vlan-id>
name VM-Traffic-VLAN
vlan <infra-nfs-vlan-id>
name Infra-NEFS-VLAN

exit

Add NTP Distribution Interface

Cisco Nexus A
From the global configuration mode, run the following commands:

ntp source <switch-a-ntp-ip>

interface Vlan<ib-mgmt-vlan-id>
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ip address <switch-a-ntp-ip>/<ib-mgmt-vlan-netmask-length>
no shutdown
exit
Cisco Nexus B
From the global configuration mode, run the following commands:
ntp source <switch-b-ntp-ip>
interface Vlan<ib-mgmt-vlan-id>
ip address <switch-b-ntp-ip>/<ib-mgmt-vlan-netmask-length>
no shutdown

exit

Add Individual Port Descriptions for Troubleshooting

Cisco Nexus A

To add individual port descriptions for troubleshooting activity and verification for switch A, complete the
following step:

# In this step and in the later sections, configure the AFF nodename <st-node> and Cisco UCS 6332-16UP or
Cisco UCS 6248UP fabric interconnect clustername <ucs-clustername> interfaces as appropriate to your de-
ployment.

From the global configuration mode, run the following commands:
interface Ethl/3
description <st-node>-1l:e2a
interface Ethl/4
description <st-node>-2:e2a
interface Ethl/25
description <ucs-clustername>-a:1/27
interface Ethl/26
description <ucs-clustername>-b:1/27
interface Ethl/27
description <nexus-hostname>-b:1/27
interface Ethl/28
description <nexus-hostname>-b:1/28

exit
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Cisco Nexus B

To add individual port descriptions for troubleshooting activity and verification for switch B, complete the
following step:

From the global configuration mode, run the following commands:

interface Ethl/3

description <st-node>-1l:e2e
interface Ethl/4

description <st-node>-2:e2e
interface Ethl/25

description <ucs-clustername>-a:1/28
interface Ethl/26

description <ucs-clustername>-b:1/28
interface Ethl/27

description <nexus-hostname>-a:1/27
interface Ethl/28

description <nexus-hostname>-a:1/28

exit

Create Port Channels

Cisco Nexus A and Cisco Nexus B
To create the necessary port channels between devices, complete the following step on both switches:

From the global configuration mode, run the following commands:

interface Pol0

description vPC peer-link
interface Ethl/27-28
channel-group 10 mode active
no shutdown

interface Pol3

description <st-node>-1
interface Ethl/3
channel-group 13 mode active
no shutdown

interface Pol4

description <st-node>-2
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interface Ethl/4

channel-group 14 mode active

no shutdown

interface Pol25

description <ucs-clustername>-a
interface Ethl/25

channel-group 125 mode active
no shutdown

interface Pol26

description <ucs-clustername>-b
interface Ethl/26

channel-group 126 mode active
no shutdown

exit

copy run start

Configure Port Channel Parameters

Cisco Nexus A and Cisco Nexus B
To configure port channel parameters, complete the following step on both switches:

From the global configuration mode, run the following commands:
interface Pol0
switchport mode trunk
switchport trunk native vlan 2

switchport trunk allowed vlan <ib-mgmt-vlan-id>, <infra-nfs-vlan-id>, <vmotion-vlan-id>, <vm-traffic-
vlan-id>

spanning-tree port type network

interface Pol3

switchport mode trunk

switchport trunk native vlan 2

switchport trunk allowed vlan <infra-nfs-vlan-id>
spanning-tree port type edge trunk

mtu 9216

interface Pol4

switchport mode trunk
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switchport trunk native vlan 2

switchport trunk allowed vlan <infra-nfs-vlan-id>
spanning-tree port type edge trunk

mtu 9216

interface Pol25

switchport mode trunk

switchport trunk native vlan 2

switchport trunk allowed vlan <ib-mgmt-vlan-id>, <infra-nfs-vlan-id>, <vmotion-vlan-id>,
vlian-id>

spanning-tree port type edge trunk
mtu 9216

interface Pol26

switchport mode trunk

switchport trunk native vlan 2

switchport trunk allowed vlan <ib-mgmt-vlan-id>, <infra-nfs-vlan-id>, <vmotion-vlan-id>,
vlan-id>

spanning-tree port type edge trunk
mtu 9216
exit

copy run start

Configure Virtual Port Channels

Cisco Nexus A
To configure virtual port channels (vPCs) for switch A, complete the following step:

From the global configuration mode, run the following commands:
vpc domain <nexus-vpc-domain-id>
role priority 10
peer-keepalive destination <nexus-B-mgmtO-ip> source <nexus-A-mgmtO-ip>
peer-switch
peer—-gateway
auto-recovery
delay restore 150
interface Pol0

vpc peer-link
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interface Pol3
vpc 13
interface Pol4
vpc 14
interface Pol25
vpc 125
interface Pol26
vpc 126

exit

copy run start

Cisco Nexus B
To configure vPCs for switch B, complete the following step:

From the global configuration mode, run the following commands:
vpc domain <nexus-vpc-domain-id>
role priority 20
peer-keepalive destination <nexus-A-mgmtO-ip> source <nexus-B-mgmtO-ip>
peer-switch
peer—-gateway
auto-recovery
delay restore 150
interface Pol0
vpc peer-link
interface Pol3
vpc 13
interface Pol4
vpc 14
interface Pol25
vpc 125
interface Pol26
vpc 126
exit

copy run start
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Uplink into Existing Network Infrastructure

Depending on the available network infrastructure, several methods and features can be used to uplink the
FlexPod environment. If an existing Cisco Nexus environment is present, we recommend using vPCs to
uplink the Cisco Nexus switches included in the FlexPod environment into the infrastructure. The previously
described procedures can be used to create an uplink vPC to the existing environment. Make sure to run
copy run start to save the configuration on each switch after the configuration is completed.
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NetApp All Flash FAS A300 Controllers

See the following section (NetApp Hardware Universe) for planning the physical location of the storage
systems:

e Site Preparation
e System Connectivity Requirements

e Circuit Breaker, Power Outlet Balancing, System Cabinet Power Cord Plugs, and Console Pinout
Requirements

e AFF Series Systems

NetApp Hardware Universe

The NetApp Hardware Universe (HWU) application provides supported hardware and software components
for any specific ONTAP version. It provides configuration information for all the NetApp storage appliances
currently supported by ONTAP software. It also provides a table of component compatibilities.

Confirm that the hardware and software components that you would like to use are supported with the
version of ONTAP that you plan to install by using the HWU application at the NetApp Support site.

1. Access the HWU application to view the System Configuration guides. Click the Controllers tab to view
the compatibility between different version of the ONTAP software and the NetApp storage appliances
with your desired specifications.

2. Alternatively, to compare components by storage appliance, click Compare Storage Systems.

Controllers

Follow the physical installation procedures for the controllers found in the AEE A300 Series product
documentation at the NetApp Support site.

Disk Shelves

NetApp storage systems support a wide variety of disk shelves and disk drives. The complete list of disk
shelves that are supported by the AFF A300 is available at the NetApp Support site.

When using SAS disk shelves with NetApp storage controllers, refer to the SAS Disk Shelves Universal SAS
and ACP Cabling Guide for proper cabling guidelines.

NetApp ONTAP 9.1

Complete Configuration Worksheet

Before running the setup script, complete the cluster setup worksheet from the ONTAP 9.1 Software Setup
Guide. You must have access to the NetApp Support site to open the cluster setup worksheet.
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Configure ONTAP Nodes

Before running the setup script, review the configuration worksheets in the ONTAP 9.1 Software Setup
Guide to learn about configuring ONTAP. Table 4 lists the information needed to configure two ONTAP
nodes. Customize the cluster detail values with the information applicable to your deployment.

Table 4 ONTAP Software Installation Prerequisites

Cluster Detail Cluster Detail Value

Cluster node 01 IP address <node(l-mgmt-ip>
Cluster node 01 netmask <node(0l-mgmt-mask>
Cluster node 01 gateway <nodeOl-mgmt-gateway>
Cluster node 02 IP address <node(02-mgmt-ip>
Cluster node 02 netmask <node(02-mgmt-mask>
Cluster node 02 gateway <node(l2-mgmt-gateway>
Data ONTAP 9.1 URL <url-boot-software>

Configure Node 01
To configure node 01, complete the following steps:

1. Connect to the storage system console port. You should see a Loader-A prompt. However, if the storage
system is in a reboot loop, press Ctrl-C to exit the autoboot loop when the following message displays:

‘Starting AUTOBOOT press Ctrl-C to abort..

2. Allow the system to boot up.

‘autoboot

3. Press Ctrl-C when prompted.

ﬂ If ONTAP 9.1 is not the version of software being booted, continue with the following steps to install
new software. If ONTAP 9.1 is the version being booted, select option 8 and vy to reboot the node.
Then continue with step 14.

4. To install new software, select option 7.

5. Enter y to perform an upgrade.

6. Select e0M for the network port you want to use for the download.
7. Enter y to reboot now.

8. Enter the IP address, netmask, and default gateway for e0OM.
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‘<node01—mgmt—ip> <node(0l-mgmt-mask> <nodeOl-mgmt-gateway>

9. Enter the URL where the software can be found.

# This web server must be pingable.

‘<url—boot—software>

10. Press Enter for the user name, indicating no user name.

11. Enter y to set the newly installed software as the default to be used for subsequent reboots.

12. Enter y to reboot the node.

ﬂ When installing new software, the system might perform firmware upgrades to the BIOS and adapter

cards, causing reboots and possible stops at the Loader-A prompt. If these actions occur, the system
might deviate from this procedure.

13. Press Ctrl-C when the following message displays:

Press Ctrl-C for Boot Menu

14. Select option 4 for Clean Configuration and Initialize All Disks.
15. Enter vy to zero disks, reset config, and install a new file system.

16. Enter y to erase all the data on the disks.

r.

The initialization and creation of the root aggregate can take 90 minutes or more to complete, depend-
ing on the number and type of disks attached. When initialization is complete, the storage system re-
boots. Note that SSDs take considerably less time to initialize. You can continue with the node 02 con-
figuration while the disks for node 01 are zeroing.

Configure Node 02

To configure node 02, complete the following steps:

1. Connect to the storage system console port. You should see a Loader-A prompt. However, if the storage
system is in a reboot loop, press Ctrl-C to exit the autoboot loop when the following message displays:

‘Starting AUTOBOOT press Ctrl-C to abort..

2. Allow the system to boot up.

‘autoboot

3. Press Ctrl-C when prompted.

ﬂ If ONTAP 9.1 is not the version of software being booted, continue with the following steps to install

new software. If ONTAP 9.1 is the version being booted, select option 8 and vy to reboot the node.
Then continue with step 14.
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4. To install new software, select option 7.

5. Entery to perform an upgrade.

6. Select eOM for the network port you want to use for the download.
7. Entery to reboot now.

8. Enter the IP address, netmask, and default gateway for eOM.

‘<node02—mgmt—ip> <node02-mgmt-mask> <node02-mgmt-gateway>

9. Enter the URL where the software can be found.

ﬂ This web server must be pingable.

‘<url—boot—software>

10. Press Enter for the user name, indicating no user name.
11. Enter y to set the newly installed software as the default to be used for subsequent reboots.

12. Enter y to reboot the node.

# When installing new software, the system might perform firmware upgrades to the BIOS and adapter
cards, causing reboots and possible stops at the Loader-A prompt. If these actions occur, the system
might deviate from this procedure.

13. Press Ctrl-C when you see this message:

Press Ctrl-C for Boot Menu

14. Select option 4 for Clean Configuration and Initialize All Disks.
15. Enter y to zero disks, reset config, and install a new file system.

16. Enter y to erase all the data on the disks.

# The initialization and creation of the root aggregate can take 90 minutes or more to complete, depend-
ing on the number and type of disks attached. When initialization is complete, the storage system re-
boots. Note that SSDs take considerably less time to initialize.

Set Up Node

From a console port program attached to the storage controller A (node 01) console port, run the node
setup script. This script appears when ONTAP 9.1 boots on the node for the first time.

1. Follow the prompts to set up node 01:

Welcome to node setup.

You can enter the following commands at any time:
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"help" or "?" - if you want to have a question clarified,
"back" - if you want to change previously answered questions, and
"exit" or "quit" - if you want to quit the setup wizard.

Any changes you made before quitting will be saved.

You can return to cluster setup at any time by typing “cluster setup”.
To accept a default or omit a question, do not enter a value.

This system will send event messages and weekly reports to NetApp Technical Support.

To disable this feature, enter "autosupport modify -support disable" within 24 hours.

Enabling AutoSupport can significantly speed problem determination and resolution should a problem occur
on your system.

For further information on AutoSupport, see:

http://support.netapp.com/autosupport/

Type yes to confirm and continue {yes}: yes

Enter the node management interface port [eOM]: Enter

Enter the node management interface IP address: <nodeOl-mgmt-ip>

Enter the node management interface netmask: <nodeOl-mgmt-mask>

Enter the node management interface default gateway: <nodeOl-mgmt-gateway>

A node management interface on port eOM with IP address <node0Ol-mgmt-ip> has been created

Use your web browser to complete cluster setup by accesing https://<node0l-mgmt-ip>

Otherwise press Enter to complete cluster setup using the command line interface:

2. To complete the cluster setup, open a web browser and navigate to https://<node01-mgmt-ip.

Table 5 Cluster create in ONTAP prerequisites

Cluster Detall Cluster Detail Value

Cluster name <clustername>

ONTAP base license <cluster-base-license-key>
Cluster management IP address <clustermgmt-ip>
Cluster management netmask <clustermgmt-mask>
Cluster management gateway <clustermgmt-gateway>
Cluster node 01 IP address <nodel0l-mgmt-ip>
Cluster node 01 netmask <node0l-mgmt-mask>
Cluster node 01 gateway <nodel0l-mgmt-gateway>
Cluster node 02 IP address <node02-mgmt-ip>
Cluster node 02 netmask <node02-mgmt-mask>
Cluster node 02 gateway <node(O2-mgmt-gateway>
Node 01 service processor IP address <node01-SP-ip>

Node 02 service processor IP address <node02-SP-ip>
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Cluster Detail

Cluster Detail Value

DNS domain name

<dns-domain-name>

DNS server IP address

<dns-ip>

NTP server IP address

<ntp-ip>

3.

A Cluster setup can also be done using command line interface. This document describes the cluster
setup using NetApp System Manager guided setup.

Click Guided Setup on the Welcome screen.

&

NetApp OnCommand System Manager

(& | A Not Secure | b#p7%://192.168.156.61/sysmgr/SysMgr.html

‘ == Getting Started ‘

Language | English (English) |V |

Welcome to the Guided Cluster Setup

Perform the following to set up a cluster:
- Create a cluster, add nodes and admin credentials

- Configure AutoSupport Messages and Event Notifications

ﬂ For information related to setting up the cluster, click here

Template File

- Create management LIFs, configure Service Processar, DNS, and NTP servers

Browse to select a .csv file...

Browse

ﬂ To download the template, click file.csv or filexlsx

4. In the Cluster screen, do the following:

a. Enter the cluster and node names.

b. Select the cluster configuration.
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c. Enter and confirm the password.

d. (Optional) Enter the cluster base and feature licenses.

Cluster

Metwark Support Summary

Cluster Name | ppod-aff300

Nodes
'ﬂ' Mot sure all nodes have been discovered? Refresh

AFF-A300 T21653000058 AFF-A300 T21853000057
HA PAIR
@ | bbo4-af300-1 o @ | bbod-afz00-2
Cluster Configuration: Switched Cluster (03 Switchless Cluster

'ﬂ' Ensure that the hardware connectivity is set up for the two-node switchless cluster.

ﬂ Jsername admin
Paszwaord

(ECTTT T

Confirm Passwaord

(ECTTT T

Cluster Base License (Optional)

'ﬂ' For any queries related to licenses, contact mysupport.netapp.com

Feature Licenses (Optional)

'ﬂ' Cluster Base License is mandatory to add Feature Licenses.

ﬂ The nodes are discovered automatically; if they are not, click the Refresh link. By default, the cluster
interfaces will be created on all the new factory shipping storage controllers.
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‘ﬁ If all the nodes are not discovered, then configure the cluster using the command line.

ﬂ Cluster license and feature licenses can also be installed after completing the cluster creation.

5. Click Submit.
6. In the network page, complete the following sections:

a. Cluster Management
i Enter the IP address, netmask, gateway and port details.
b. Node Management
i. Enter the node management IP addresses and port details for all the nodes.
c. Service Processor Management
i. Enter the IP addresses for all the nodes.
d. DNS Details
i Enter the DNS domain names and server address.
e. NTP Details
i Enter the primary and alternate NTP server.

7. Click Submit.

Guided Setup to Configure a Cluster

Provide the information required below to configure your cluster:

,_
o 3

Cluster MNetwork Support Summary
@ Network (Management) © DNS Details (
IP Addresses (IPvd) Enter 1 Cluster Management, 1 Node Management, and 2 Service Processar IP Addresses. You can
required override the Service Processor [P Address DNS Domain Names

L o IP Address Range

192.168.156.9
DMS Server IP Address
You must enter the default network details manually.
L IP Address Netmask Gateway (Optional) o Port
@ NTP Details ([
Cluster Management | 152.165.156.60 255.255.255.0 192.168.156.1 elc -
Ensure that the cluster management LIF is reachable or a Gateway is configured for the same Primary NTP Server |1p.1.156.4

subnet in which the cluster management LIF is present.
Alternative NTP Server |10.1.1565

e Node Management Retain Netmask and Gateway configuration of the Cluster (Optional)

Management.

bb04-aff300-1 -

bb04-aff300-2 | 152 163.156.62 el -

e Service Processor Default values have been detected for the Service Processor.
Management I:‘ Cwverride the default value
Retain Netmask and Gat

ateway is mandatory)

configuration of the Cluster Management

bb04-aff300-1
bb04-aff300-2
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8. In the Support page, configure the AutoSupport and Event Notifications sections.

Guided Setup to Configure a Cluster

Provide the information required below to configure your cluster:

Cluster Metwark Support

@ AutoSupport @[

€ Proxy URL (Optional)

summary

ﬂ Connection is verified after configuring AutoSupport on all nodes.

@ Event Notifications
Motify me through:

SMTP Mail Host

Emnail testvikings.smip.cisco.com

SNMP Trap Host
[ ] snmp

Syslog Server
[ ] syslog

9. Click Submit.

10. In the Summary page, review the configuration details if needed.
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Guided Setup to Configure a Cluster

Provide the information required below to configure your cluster:

v v v -

Cluster MNetwork Support Summary

Click here to view the summary

The next step will be to configure your aggregates, SVM and Storage Objects.
Click the button below to start provisioning your storage.

‘ﬁ The node management interface can be on the same subnet as the cluster management interface, or it can be
on a different subnet. In this document, we assume that it is on the same subnet.

Login to the Cluster

To log in to the cluster, complete the following steps:

1. Open an SSH connection to either the cluster IP or host name.

2. Log in to the admin user with the password you provided earlier.

Zero All Spare Disks

To zero all spare disks in the cluster, run the following command:

‘disk zerospares

‘ﬁ Advanced Data Partitioning creates a root partition and two data partitions on each SSD drive in an All Flash
FAS configuration. Disk autoassign should have assigned one data partition to each node in an HA pair. If a
different disk assignment is required, disk autoassignment must be disabled on both nodes in the HA pair by
running the disk option modify command. Spare partitions can then be moved from one node to another
by running the disk removeowner and disk assign commands.

Set Onboard Unified Target Adapter 2 Port Personality
To set the personality of the onboard unified target adapter 2 (UTA2), complete the following steps:

1. Verify the Current Mode and Current Type properties of the ports by running the ucadmin show com-
mand:
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ucadmin show
Current Current Pending Pending Admin

Node Adapter Mode Type Mode Type Status
<st-node01>

Oe fc target - - online
<st-node01>

0f fc target - - online
<st-node01>

O0g cna target - - online
<st-node0O1l>

Oh cna target - - online
<st-node02>

Oe fc target - - online
<st-node02>

0f fc target - - online
<st-node02>

O0g cna target - - online
<st-node02>

Oh cna target - - online
8 entries were displayed.

2. Verify that the Current Mode and Current Type properties for all ports are set properly. Set the ports
used for FC connectivity to mode fc. The port type for all protocols should be set to target. Change the
port personality by running the following command:

‘ucadmin modify -node <home-node-of-the-port> -adapter <port-name> -mode fc -type target

# The ports must be offline to run this command. To take an adapter offline, run the fcp adapter modify -
node <home-node-of-the-port> -adapter <port-name> -state down command. Ports must be
converted in pairs (for example, Oe and 0f).

ﬂ After conversion, a reboot is required. After reboot, bring the ports online by running fcp adapter modify
-node <home-node-of-the-port> -adapter <port-name> -state up.

Set Auto-Revert on Cluster Management

To set the auto-revert parameter on the cluster management interface, complete the following step:

ﬂ A storage virtual machine (SVM) is referred to as a Vserver (or vserver) in the GUI and CLI.

Run the following command:

‘network interface modify -vserver <clustername> -1if cluster mgmt -auto-revert true

Set Up Management Broadcast Domain

By default, all network ports are included in the default broadcast domain. Network ports used for data
services (for example, e0d, e2a, and e2e) should be removed from the default broadcast domain, leaving
just the management network ports (e0c and e0M). To perform this task, run the following commands:

broadcast-domain remove-ports -broadcast-domain Default -ports bb04-affa300-1:e0d,bb04-affa300-
1:e0g,bb04-affa300-1:e0h,bb04-affa300-1:e2a,bb04-affa300-1:e2¢e,bb04-affa300-2:e0d,bb04-affa300-
2:e0g9,bb04-affa300-2:e0h,bb04-affa300-2:e2a,bb04-affa300-2:e2e

broadcast-domain show
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Set Up Service Processor Network Interface

To assign a static IPv4 address to the service processor on each node, run the following commands:

system service-processor network modify -node <st-nodeOl> -address-family IPv4 -enable true -dhcp none -
ip-address <node0Ol-sp-ip> -netmask <node0Ol-sp-mask> -gateway <nodeOl-sp-gateway>

system service-processor network modify -node <st-node02> -address-family IPv4 -enable true —-dhcp none -
ip-address <node02-sp-ip> -netmask <node02-sp-mask> -gateway <nodeO2-sp-gateway>

ﬂ The service processor IP addresses should be in the same subnet as the node management IP addresses.

Create Aggregates

An aggregate containing the root volume is created during the ONTAP setup process. To create additional
aggregates, determine the aggregate name, the node on which to create it, and the number of disks it
should contain.

To create new aggregates, complete the following steps:

1. Run the following commands:

aggr create -aggregate aggrl node0l -node <st-node0l> -diskcount <num-disks>
aggr create -aggregate aggrl node02 -node <st-node02> -diskcount <num-disks>

ﬂ You should have the minimum number of hot spare disks for hot spare disk partitions recommended for your
aggregate.

ﬂ For all flash aggregates, you should have a minimum of one hot spare disk or disk partition. For nonflash ho-
mogenous aggregates, you should have a minimum of two hot spare disks or disk partitions. For Flash Pool
aggregates, you should have a minimum of two hot spare disks or disk partitions for each disk type.

ﬂ Start with five disks initially; you can add disks to an aggregate when additional storage is required. In an AFF
configuration with a small number of SSDs, you might want to create an aggregate with all but one remaining
disk (spare) assigned to the controller.

# The aggregate cannot be created until disk zeroing completes. Run the aggr show command to display ag-
gregate creation status. Do not proceed until both aggrl nodel and aggrl node2 are online.

aggr show
aggr rename -aggregate aggr0 —newname <nodeOl-rootaggrname>

Verify Storage Failover

To confirm that storage failover is enabled, run the following commands for a failover pair:
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1. Verify the status of the storage failover.

‘storage failover show

# Both <st-node01> and <st-node02> must be capable of performing a takeover. Continue with step
3 if the nodes are capable of performing a takeover.

2. Enable failover on one of the two nodes.

storage failover modify -node <st-node0Ol> -enabled true

# Enabling failover on one node enables it for both nodes.

3. Verify the HA status for a two-node cluster.

ﬂ This step is not applicable for clusters with more than two nodes.

‘cluster ha show

4. Continue with step 6 if high availability is configured.

5. Only enable HA mode for two-node clusters. Do not run this command for clusters with more than two
nodes because it causes problems with failover.

cluster ha modify -configured true
Do you want to continue? {yln}: y

6. Verify that hardware assist is correctly configured and, if needed, modify the partner IP address.

storage failover hwassist show
storage failover modify -hwassist-partner-ip <node02-mgmt-ip> -node <st-node0l>
storage failover modify -hwassist-partner-ip <nodeOl-mgmt-ip> -node <st-node02>

Disable Flow Control on 10GbE and 40GbE ports

NetApp recommends disabling flow control on all the 10GbE and UTA2 ports that are connected to external
devices. To disable flow control, complete the following steps:

1. Run the following commands to configure node 01:

network port modify -node <st-node(0l> -port eOa,eOb,ele,el0f,e0g,el0h,e2a,e2e -flowcontrol-admin none
Warning: Changing the network port settings will cause a several second interruption in carrier.
Do you want to continue? {yln}: y

2. Run the following commands to configure node 02:

network port modify -node <st-node(02> -port eOa,elb,ele,e0f,e0g,el0h,e2a,e2e -flowcontrol-admin none
Warning: Changing the network port settings will cause a several second interruption in carrier.

Do you want to continue? {y|n}: y

network port show -fields flowcontrol-admin
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Disable Unused FCoE Capability on CNA Ports

If the UTA2 port is set to CNA mode and is only expected to handle Ethernet data traffic (for example NFS),
then the unused FCoOE capability of the port should be disabled by setting the corresponding FCP adapter to
state down with the fcp adapter modify command. Here are some examples:

fcp adapter modify -node <st-nodeOl> -adapter 0g -status-admin down
fcp adapter modify -node <st-node0l> -adapter Oh -status-admin down
fcp adapter modify -node <st-node02> -adapter 0g -status-admin down
fcp adapter modify -node <st-node(02> -adapter Oh -status-admin down
fcp adapter show -fields status-admin

Configure Network Time Protocol

To configure time synchronization on the cluster, complete the following steps:

1. Set the time zone for the cluster.

‘timezone <timezone>

# For example, in the eastern United States, the time zone is America/New York.

2. Set the date for the cluster.

‘date <ccyymmddhhmm. ss>

# The format for the date is < [Century] [Year] [Month] [Day] [Hour] [Minute] . [Second]> (for
example, 201703231549.30).

3. Configure the Network Time Protocol (NTP) servers for the cluster.

cluster time-service ntp server create -server <switch-a-ntp-ip>
cluster time-service ntp server create -server <switch-b-ntp-ip>

Configure Simple Network Management Protocol

To configure the Simple Network Management Protocol (SNMP), complete the following steps:

1. Configure basic SNMP information, such as the location and contact. When polled, this information is
visible as the sysLocation and sysContact variables in SNMP.

snmp contact <snmp-contact>
snmp location “<snmp-location>"
snmp init 1

options snmp.enable on

2. Configure SNMP traps to send to remote hosts, such as a DFM server or another fault management sys-
tem.

snmp traphost add <oncommand-um-server-fgdn>

Configure SNMPv1 Access
To configure SNMPv1 access, set the shared, secret plain-text password (called a community):
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snmp community add ro <snmp-community>

Configure AutoSupport

NetApp AutoSupport® sends support summary information to NetApp through HTTPS. To configure
AutoSupport, run the following command:

system node autosupport modify -node * -state enable -mail-hosts <mailhost> -transport https -support
enable -noteto <storage-admin-email>

Enable Cisco Discovery Protocol

To enable the Cisco Discovery Protocol (CDP) on the NetApp storage controllers, run the following
command to enable CDP on ONTAP:

‘node run -node * options cdpd.enable on

# To be effective, CDP must also be enabled on directly connected networking equipment such as switches and
routers.

Create Jumbo Frame MTU Broadcast Domains in ONTAP

To create a data broadcast domain with an MTU of 9000, run the following commands to create a broadcast
domain for NFS on ONTAP:

broadcast-domain create -broadcast-domain Infra NFS -mtu 9000

Create Interface Groups

To create the LACP interface groups for the 10GbE data interfaces, run the following commands:

ifgrp create -node <st-node(Ol> -ifgrp al0a -distr-func port -mode multimode lacp
ifgrp add-port -node <st-node0Ol> -ifgrp ala -port e2a
ifgrp add-port -node <st-node0l> -ifgrp ala -port ele

ifgrp create -node <st-node(02> -ifgrp ala -distr-func port -mode multimode lacp
ifgrp add-port -node <st-node02> -ifgrp ala -port e2a
ifgrp add-port -node <st-node02> -ifgrp ala -port ele

ifgrp show

Create VLANs
To create VLANS, create NFS VLAN ports and add them to the NFS broadcast domain:

network port modify -node <st-node0l> -port ala -mtu 9000
network port modify -node <st-node02> -port ala -mtu 9000
network port vlan create -node <st-node0Ol> -vlan-name aOa-<infra-nfs-vlan-id>
network port vlan create —node <st-node02> -vlan-name aOa-<infra-nfs-vlan-id>

broadcast-domain add-ports -broadcast-domain Infra NFS -ports <st-nodel0l>:ala-<infra-nfs-vlan-id>, <st-
node02>:al0a-<infra-nfs-vlan-id>

Create Storage Virtual Machine

To create an infrastructure SVM, complete the following steps:
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1. Runthe vserver create command.

vserver create -vserver Infra-SVM -rootvolume rootvol -aggregate aggrl nodeOl -rootvolume-security-style
unix

2. Remove the unused data protocols from the SVM - CIFS, iSCSI, and NDMP.

‘vserver remove-protocols -vserver Infra-SVM -protocols iscsi,cifs,ndmp

3. Add the two data aggregates to the Infra-SVM aggregate list for the NetApp VSC.

‘vserver modify -vserver Infra-SVM -aggr-list aggrl node0Ol,aggrl node02

4. Enable and run the NFS protocol in the Infra-SVM.

‘nfs create -vserver Infra-SVM -udp disabled

ﬂ If NFS license is not installed during the cluster configuration, make sure install the license for staring
the NFS service.

5. Turn on the SVM vstorage parameter for the NetApp NFS VAAI plug-in.

vserver nfs modify -vserver Infra-SVM -vstorage enabled
vserver nfs show

Create Load-Sharing Mirrors of SVM Root Volume

To create a load-sharing mirror of an SVM root volume, complete the following steps:

1. Create a volume to be the load-sharing mirror of the infrastructure SVM root volume on each node.

volume create -vserver Infra-SVM -volume rootvol m0l -aggregate aggrl node0l -size 1GB -type DP
volume create -vserver Infra-SVM -volume rootvol m02 -aggregate aggrl node02 -size 1GB —-type DP

2. Create a job schedule to update the root volume mirror relationships every 15 minutes.

job schedule interval create -name 15min -minutes 15

3. Create the mirroring relationships.

snapmirror create -source-path Infra-SVM:rootvol -destination-path Infra-SVM:rootvol m0l -type LS -
schedule 15min
snapmirror create -source-path Infra-SVM:rootvol -destination-path Infra-SVM:rootvol m02 -type LS -

schedule 15min

4. Initialize the mirroring relationship.

snapmirror initialize-ls-set -source-path Infra-SVM:rootvol
snapmirror show

Create Block Protocol (FC) Service

Run the following command to create the FCP service on each SVM. This command also starts the FCP
service and sets the WWN for the SVM.
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fcp create -vserver Infra-SVM
fcp show

ﬂ If FC license is not installed during the cluster configuration, make sure install the license for creating FC ser-
vice

Configure HTTPS Access

To configure secure access to the storage controller, complete the following steps:

1. Increase the privilege level to access the certificate commands.

set -privilege diag
Do you want to continue? {y|n}: y

2. Generally, a self-signed certificate is already in place. Verify the certificate and obtain parameters (for
example, <serial-number>) by running the following command:

security certificate show

3. For each SVM shown, the certificate common name should match the DNS FQDN of the SVM. Delete the
two default certificates and replace them with either self-signed certificates or certificates from a certifi-
cate authority (CA). To delete the default certificates, run the following commands:

security certificate delete -vserver Infra-SVM -common-name Infra-SVM -ca Infra-SVM -type server -serial
<serial-number>

ﬂ Deleting expired certificates before creating new certificates is a best practice. Run the security
certificate delete command to delete the expired certificates. In the following command, use
TAB completion to select and delete each default certificate.

4. To generate and install self-signed certificates, run the following commands as one-time commands.
Generate a server certificate for the Infra-SVM and the cluster SVM. Use TAB completion to aid in the
completion of these commands.

security certificate create -common-name <cert-common-name> -type server -size 2048 -country <cert-
country> -state <cert-state> -locality <cert-locality> -organization <cert-org> -unit <cert-unit> -
email-addr <cert-email> -expire-days <cert-days> -protocol SSL -hash-function SHA256 -vserver Infra-SVM

5. To obtain the values for the parameters required in step 5 (<cert-ca> and <cert-serial>), run the security
certificate show command.

6. Enable each certificate that was just created by using the -server-enabled true and -client-enabled false
parameters. Use TAB completion to aid in the completion of these commands.

security ssl modify -vserver <clustername> -server-enabled true -client-enabled false -ca <cert-ca> -
serial <cert-serial> -common-name <cert-common-name>

7. Disable HTTP cluster management access.

system services firewall policy delete -policy mgmt -service http -vserver <clustername>
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# It is normal for some of these commands to return an error message stating that the entry does not ex-
ist.

8. Change back to the normal admin privilege level and set up the system to allow SVM logs to be available
by web.

set -privilege admin
vserver services web modify -name spi|ontapi|compat -vserver * -enabled true

Configure NFSv3
To configure NFSv3 on the SVM, complete the following steps:

1. Create a new rule for the infrastructure NFS subnet in the default export policy.

vserver export-policy rule create -vserver Infra-SVM -policyname default -ruleindex 1 -protocol nfs -
clientmatch <infra-nfs-subnet-cidr> -rorule sys -rwrule sys -superuser sys -allow-suid false

2. Assign the FlexPod export policy to the infrastructure SVM root volume.

volume modify -vserver Infra-SVM -volume rootvol -policy default

Create FlexVol Volumes

The following information is required to create a NetApp FlexVol® volume:
e The volume name
e The volume size
e The aggregate on which the volume exists

To create a FlexVol volume, run the following commands:

volume create -vserver Infra-SVM -volume infra datastore 1 -aggregate aggrl node(Ol -size 500GB -state
online -policy default -junction-path /infra datastore 1 -space-guarantee none -percent-snapshot-space 0

volume create -vserver Infra-SVM -volume infra datastore 2 -aggregate aggrl node(02 -size 500GB -state
online -policy default -junction-path /infra datastore 2 -space-guarantee none -percent-snapshot-space 0
volume create -vserver Infra-SVM -volume esxi boot -aggregate aggrl nodeOl -size 100GB -state online -
policy default -space-guarantee none -percent-snapshot-space 0

snapmirror update-ls-set -source-path Infra-SVM:rootvol

Create Boot LUNs

To create two boot LUNSs, run the following commands:

lun create -vserver Infra-SVM -volume esxi boot -lun VM-Host-Infra-01 -size 15GB -ostype vmware -space-

reserve disabled
lun create -vserver Infra-SVM -volume esxi boot -lun VM-Host-Infra-02 -size 15GB -ostype vmware -space-

reserve disabled
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Schedule Deduplication

On NetApp All Flash FAS systems, deduplication is enabled by default. To schedule deduplication, complete
the following step:

1. After the volumes are created, assign a once-a-day deduplication schedule to esxi boot, in-
fra datastore 1 and infra datastore 2:

efficiency modify -vserver Infra-SVM -volume esxi boot -schedule sun-sat@0
efficiency modify -vserver Infra-SVM -volume infra datastore 1 -schedule sun-sat@0
efficiency modify -vserver Infra-SVM -volume infra datastore 2 —-schedule sun-sat@O

Create FC LIFs

Run the following commands to create four FC LIFs (two on each node):

network interface create -vserver Infra-SVM -1if fcp 1lifOla -role data -data-protocol fcp -home-node
<st-nodel0l> -home-port Oe -status-admin up

network interface create -vserver Infra-SVM -1if fcp 1if0lb -role data -data-protocol fcp -home-node
<st-nodel0l> -home-port 0f -status-admin up

network interface create -vserver Infra-SVM -1if fcp 1if02a -role data -data-protocol fcp -home-node
<st-node02> -home-port 0Oe -status-admin up

network interface create -vserver Infra-SVM -1if fcp 1if02b -role data -data-protocol fcp -home-node
<st-node02> -home-port 0f -status-admin up

network interface show

Create NFS LIF

To create an NFS LIF, run the following commands:

network interface create -vserver Infra-SVM -1lif nfs 1if0l -role data -data-protocol nfs -home-node <st-
node01> -home-port ala-<infra-nfs-vlan-id> -address <node0Ol-nfs 1if0l-ip> -netmask <node(Ol-nfs 1if0l-
mask> -status-admin up -failover-policy broadcast-domain-wide -firewall-policy data —-auto-revert true

network interface create -vserver Infra-SVM -1if nfs 1if02 -role data -data-protocol nfs -home-node <st-
node02> -home-port ala-<infra-nfs-vlan-id> -address <node02-nfs 11f02-ip> -netmask <node02-nfs_1if02-
mask>> -status-admin up -failover-policy broadcast-domain-wide -firewall-policy data —-auto-revert true

network interface show

Add Infrastructure SVM Administrator

To add the infrastructure SVM administrator and SVM administration LIF in the out-of-band management
network, complete the following steps:

1. Run the following commands:

network interface create -vserver Infra-SVM -1if svm-mgmt -role data -data-protocol none -home-node <st-
node02> -home-port eOc -address <svm-mgmt-ip> -netmask <svm-mgmt-mask> -status-admin up -failover-
policy broadcast-domain-wide -firewall-policy mgmt —-auto-revert true

# The SVM management IP in this step should be in the same subnet as the storage cluster manage-
ment IP.
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2. Create a default route to allow the SVM management interface to reach the outside world.

network route create -vserver Infra-SVM -destination 0.0.0.0/0 -gateway <svm-mgmt-gateway>

network route show

3. Set a password for the SVM vsadmin user and unlock the user.

security login password -username vsadmin -vserver Infra-SVM
Enter a new password: <password>
Enter it again: <password>

security login unlock -username vsadmin -vserver Infra-SVM

# A cluster serves data through at least one and possibly several SVMs. We have just gone through
creating a single SVM. If you would like to configure your environment with multiple SVMs, this is a
good time to create additional SVMs.
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Server Configuration
__________________________________________________________________________________________________________________________________

Cisco UCS Base Configuration

This FlexPod deployment will show configuration steps for the Cisco UCS 6332-16UP Fabric Interconnects
(FI) in a design that will support Fibre Channel to the NetApp AFF through the Cisco Nexus.

Perform Initial Setup of Cisco UCS 6332-16UP Fabric Interconnects for FlexPod Environments

This section provides detailed procedures for configuring Cisco Unified Computing System (Cisco UCS) for
use in a FlexPod environment. The steps are necessary to provision the Cisco UCS B-Series and C-Series
servers and should be followed precisely to avoid improper configuration.

Cisco UCS Fabric Interconnect A
To configure the Cisco UCS for use in a FlexPod environment, complete the following steps:

1. Connect to the console port on the first Cisco UCS fabric interconnect.

Enter the configuration method: gui
Physical switch MgmtO IP address: <ucsa-mgmt-ip>
Physical switch MgmtO IPv4 netmask: <ucsa-mgmt-mask>

IPv4 address of the default gateway: <ucsa-mgmt-gateway>

2. Using a supported web browser, connect to https://<ucsa-mgmt-ip>, accept the security prompts, and
click the ‘Express Setup’ link under HTML.

3. Select Initial Setup and click Submit.
4. Select Enable clustering, Fabric A, and IPv4.
5. Fillin the Virtual IP Address with the UCS cluster IP.

6. Completely fill in the System setup section. For system name, use the overall UCS system name. For the
Mgmt IP Address, use <ucsa-mgmt-ip>.
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Basic Settings

Cluster and Fabric setup-

= Enable clustering
T Standalone mode
© Synchronize

Fabric Setup: & Fabric A © Fabric B

& IPvd
T IPvE

Virual IP Address: |192 -|168 . (156 .|12

System setup

Enforce strong password?: * Yes © No

System name: [bbos-6332

Admin Password: [sevesees Confirm Admin password:  [esssssse

Mgmt IP Address: [192 .[168 .[156 .[10 Mgmt IP Netmask: [as5 .[ass 255 .o
Default Gateway: ’K W [E ’F

DNS Server IP: [0 i .fise .o Domain Name : [lexpod.cisco.com

—UCS Central d

UCS Central IP: . " I 8 Shared Secret:

7. Click Submit.

Cisco UCS Fabric Interconnect B
To configure the Cisco UCS for use in a FlexPod environment, complete the following steps:

1. Connect to the console port on the second Cisco UCS fabric interconnect.
Enter the configuration method: gui
Physical switch MgmtO IP address: <ucsb-mgmt-ip>
Physical switch MgmtO IPv4 netmask: <ucsb-mgmt-mask>
IPv4 address of the default gateway: <ucsb-mgmt-gateway>

2. Using a supported web browser, connect to https://<ucsb-mgmt-ip>, accept the security prompts, and
click the ‘Express Setup’ link under HTML.

3. Under System setup, enter the Admin Password entered above and click Submit.

4. Enter <ucsb-mgmt-ip> for the Mgmt IP Address and click Submit.
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Cisco UCS Setup

Log in to Cisco UCS Manager

To log in to the Cisco Unified Computing System (UCS) environment, complete the following steps:

1. Open a web browser and navigate to the Cisco UCS fabric interconnect cluster address.

# You may need to wait at least 5 minutes after configuring the second fabric interconnect for UCS
Manager to come up.

2. Click the Launch UCS Manager link under HTML to launch Cisco UCS Manager.

3. If prompted to accept security certificates, accept as necessary.

4. When prompted, enter admin as the user name and enter the administrative password.
5. Click Login to log in to Cisco UCS Manager.

Upgrade Cisco UCS Manager Software to Version 3.2

This document assumes the use of Cisco UCS 3.2(1d). To upgrade the Cisco UCS Manager software and
the Cisco UCS Fabric Interconnect software to version 3.2(1d), refer to Cisco UCS Manager Install and
Upgrade Guides.

Anonymous Reporting

To create anonymous reporting, complete the following step:

1. In the Anonymous Reporting window, select whether to send anonymous data to Cisco for improving fu-
ture products. If you select Yes, enter the IP address of your SMTP Server. Click OK.

Anonymous Reporting

Cisco Systems, Inc. will be collecting feature configuration and usage statistics which will be
sent to Cisco Smart Call Home server anonymously. This data helps us priontize the features
and improvements that will most benefit our customers.

If you decide to enable this feature in future, you can do so from the " Anonymous Reporting
in the Call Home settings under the Admin tab.

View Sample Data

Do you authorize the disclosure of this information to Cisco Smart CallHome?

C ves ' No

I’ Don't show this message again.

Cancel
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Configure Cisco UCS Call Home

It is highly recommended by Cisco to configure Call Home in Cisco UCS Manager. Configuring Call Home
will accelerate resolution of support cases. To configure Call Home, complete the following steps:

1.

2.

In Cisco UCS Manager, click Admin on the left.
Select All > Communication Management > Call Home.
Change the State to On.

Fill in all the fields according to your Management preferences and click Save Changes and OK to com-
plete configuring Call Home.

Configure Unified Ports

Fiber Channel port configurations differ slightly between the 6332-16UP and the 6248UP Fabric
Interconnects. Both Fabric Interconnects have a slider mechanism within the Cisco UCS Manager GUI
interface, but the fiber channel port selection options for the 6332-16UP are from the first 16 ports starting
from the first port on the left, and configured in increments of the first 6, 12, or all 16 of the unified

ports. With the 6248UP, the port selection options will start from the right of the 32 fixed ports, or the right
of the 16 ports of the expansion module, going down in contiguous increments of 2.

To enable the fiber channel ports, complete the following steps for the 6332-16UP:

1.

2.

In Cisco UCS Manager, click Equipment on the left.
Select Equipment > Fabric Interconnects > Fabric Interconnect A (primary).
Select Configure Unified Ports.

Click Yes on the pop-up window warning that changes to the fixed module will require a reboot of the
fabric interconnect and changes to the expansion module will require a reboot of that module.

Within the Configured Fixed Ports pop-up window move the gray slider bar from the left to the right to
select either 6, 12, or 16 ports to be set as FC Uplinks.

52



Server Configuration

Configure Unified Ports ?
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Instructions

The position of the slider determines the type of the ports
All the ports to the left of the slider are Fibre Channel ports (Purple), while the ports to the right are Ethermnet ports (Blue).

Port Transport If Role or Port Channel Membership Desired if Role
Port 1 ether Unconfigured FC Uplink
Port 2 ether Unconfigured FC Uplink
Port 3 ether Unconfigured FC Uplink
Port 4 ether Unconfigured FC Uplink
Port 5 ether Unconfigured FC Uplink
Port 6 ether Unconfigured FC Uplink
Part 7 ether Unconfigured

Port 8 ether Unconfigured

Port 9 ether Unconfigured

Port 10 ether Unconfigured

Port 11 ether Uncenfigured

Port 12 ether Unceonfigured

Port 13 ether Unconfigured

Port 14 ether Unconfigured

Port 15 ether Unconfigured

Port 16 ether Unconfigured

6. Click OK, then click Yes, then click OK to continue
7. Select Equipment > Fabric Interconnects > Fabric Interconnect B (primary).
8. Select Configure Unified Ports.

9. Click Yes on the pop-up window warning that changes to the fixed module will require a reboot of the
fabric interconnect and changes to the expansion module will require a reboot of that module.

10. Within the Configured Fixed Ports pop-up window move the gray slider bar from the left to the right to
select either 6, 12, or 16 ports to be set as FC Uplinks.

11. Click OK, then Yes, then OK to continue.
12. Wait for both Fabric Interconnects to reboot.

13. Log back into Cisco UCS Manager.
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# This process will be similar for the Cisco UCS 6248UP Fabric Interconnect, but will be in increments of two
unified ports that can be converted to FC uplinks, and will slide from the right to the left instead of the left to the
right process used with the Cisco UCS 6332-16UP Fabric Interconnects.

Add Block of IP Addresses for KVM Access

To create a block of IP addresses for in band server Keyboard, Video, Mouse (KVM) access in the Cisco UCS
environment, complete the following steps:

1. In Cisco UCS Manager, click LAN on the left.

N

Expand Pools > root > IP Pools.

w

Right-click IP Pool ext-mgmt and select Create Block of IPv4 Addresses.

4. Enter the starting IP address of the block, number of IP addresses required, and the subnet mask and
gateway information.

Create Block of IPv4 Addresses 7 X
From . [192.768.156.101 Size -2 .

Subnet Mask - (295.255.255.0 Default Gateway - |192.168.156.1

Prirmary DMS - |L'].'J£.E.'. Secondary DNS - (0.0.0.0

5. Click OK to create the block.

6. Click OK in the confirmation message.

Synchronize Cisco UCS to NTP

To synchronize the Cisco UCS environment to the NTP servers in the Nexus switches, complete the
following steps:

1. In Cisco UCS Manager, click Admin on the left.
2. Expand All > Time Zone Management.
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w

Select Timezone.

»

In the Properties pane, select the appropriate time zone in the Timezone menu.
5. Click Save Changes, and then click OK.
6. Click Add NTP Server.

7. Enter <switch-a-ntp-ip> and click OK. Click OK on the confirmation.

Add NTP Server ? X

MNTP Server: | 10.71.156.4

8. Click Add NTP Server.

9. Enter <switch-b-ntp-ip> and click OK. Click OK on the confirmation.

All /
Actions s
Add NTP Server Time Zone : |America/New_York (Eastern v

NTP Servers

Y, Advanced Filter 4 Export /% Print
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Edit Chassis Discovery Policy

Setting the discovery policy simplifies the addition of Cisco UCS B-Series chassis and of additional fabric
extenders for further Cisco UCS C-Series connectivity. To modify the chassis discovery policy, complete the
following steps:

1. In Cisco UCS Manager, click Equipment on the left and select Policies within the pulldown list on the left.

2. Under Global Policies, set the Chassis/FEX Discovery Policy to match the minimum number of uplink
ports that are cabled between the chassis or fabric extenders (FEXes) and the fabric interconnects.

3. Set the Link Grouping Preference to Port Channel. If Backplane Speed Preference appears, leave it set at
40G. If the environment being setup contains a large amount of multicast traffic, set the Multicast Hard-
ware Hash setting to Enabled.

ﬂ To achieve end-to-end 40Gb connectivity to the B-Series servers, the Backplane Speed Preference
must be set to 40G and VIC 1340 along with the Port Expander should be used. With this setting, indi-
vidual flows or TCP sessions can have a maximum speed of 40Gbps. If the Backplane Speed Prefer-
ence is set to 4x10G and VIC 1340 along with the Port Expander is used, vNICs will be displayed with
a speed of 40Gbps, but individual flows or TCP sessions will be limited to 10Gbps.

Policies Policles

E.
Port Auto-Discovery Policy Global Polici Autocanta Policies Server Inheritance Policies s erver Discavery Policie: SEL Poli Pows x Port Auto-Discovery P
FEXD
Action + |2 Link
Link Grouping Preference : Mone () Port Channel

Backplane Speed Preference : (s 240G £4x10G

4. Click Save Changes.

5. Click OK.

Enable Server and Uplink Ports

To enable server and uplink ports, complete the following steps:

1. In Cisco UCS Manager, click Equipment on the left.
2. Expand Equipment > Fabric Interconnects > Fabric Interconnect A (primary) > Fixed Module.
3. Expand Ethernet Ports.

4. Select the ports that are connected to the chassis, Cisco FEX, and direct connect Cisco UCS C-Series
servers, right-click them, and select “Configure as Server Port.”

5. Click Yes to confirm server ports and click OK.

6. Verify that the ports connected to the chassis, C-series servers and Cisco FEX are now configured as
server ports.
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7.

10.

11.

12.

13.

14.

Select the ports that are connected to the Cisco Nexus switches, right-click them, and select Configure
as Uplink Port.

# The last 6 ports of the UCS 6332 and UCS 6332-16UP Fls will only work with optical based QSFP
transceivers and AOC cables, so they can be better utilized as uplinks to upstream resources that
might be optical only.

Click Yes to confirm uplink ports and click OK.
Select Equipment > Fabric Interconnects > Fabric Interconnect B (subordinate) > Fixed Module.
Expand Ethernet Ports.

Select the ports that are connected to the chassis, C-series servers or to the Cisco 2232 FEX (two per
FEX), right-click them, and select Configure as Server Port.

Click Yes to confirm server ports and click OK.

Select the ports that are connected to the Cisco Nexus switches, right-click them, and select Configure
as Uplink Port.

Click Yes to confirm the uplink ports and click OK.

Acknowledge Cisco UCS Chassis and FEX

To acknowledge all Cisco UCS chassis and any external 2232 FEX modules, complete the following steps:

1.

2.

3.

In Cisco UCS Manager, click Equipment on the left.
Expand Chassis and select each chassis that is listed.

Right-click each chassis and select Acknowledge Chassis.
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Acknowledge Chassis X

Ammnnyoummxnodmmm 1?
This operstion will rebuild the network connectivity between the Chassis and the Fabrics it is connected
to.
Currently there are 2 active links to Fabric A ond there ore 2 active links to Fabric B.

4. Click Yes and then click OK to complete acknowledging the chassis.
5. If Nexus 2232 FEX are part of the configuration, expand Rack Mounts and FEX.
6. Right-click each FEX that is listed and select Acknowledge FEX.

7. Click Yes and then click OK to complete acknowledging the FEX.

Create Uplink Port Channels to Cisco Nexus Switches

To configure the necessary port channels out of the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click LAN on the left.

& In this procedure, two port channels are created: one from fabric A to both Cisco Nexus switches and
one from fabric B to both Cisco Nexus switches.

2. Under LAN > LAN Cloud, expand the Fabric A tree.
3. Right-click Port Channels.
4. Select Create Port Channel.

5. Enter 125 as the unique ID of the port channel.
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6. Enter vPC-125-Nexus as the name of the port channel.

7. Click Next.

8. Select the ports connected to the Nexus switches to be added to the port channel:
9. Click >> to add the ports to the port channel.

10. Click Finish to create the port channel.

11. Click OK.

12. In the navigation pane, under LAN > LAN Cloud, expand the fabric B tree.

13. Right-click Port Channels.

14. Select Create Port Channel.

15. Enter 126 as the unique ID of the port channel.

16. Enter vPC-126-Nexus as the name of the port channel.

17. Click Next.

18. Select the ports connected to the Nexus switches to be added to the port channel:
19. Click >> to add the ports to the port channel.

20. Click Finish to create the port channel.

21. Click OK.

Create a WWNN Pool for FC Boot

To configure the necessary WWNN pool for the Cisco UCS environment, complete the following steps on
Cisco UCS Manager.

1. Select SAN on the left.

2. Select Pools > root.

3. Right-click WWNN Pools under the root organization.
4. Select Create WWNN Pool to create the WWNN pool.
5. Enter WWNN-Pool for the name of the WWNN pool.

6. Optional: Enter a description for the WWNN pool.

7. Select Sequential for Assignment Order.
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Create WWNN Pool i
Define Name and Description Marme - WWHNN-Pool
Description
Add WWN Blocks
Assignment Order : Default (e Sequential
Next » Cancel
8. Click Next.
9. Click Add.

10. Modify the From field as necessary for the UCS Environment

ﬁ Modifications of the WWNN block, as well as the WWPN and MAC Addresses, can convey identifying
information for the Cisco UCS domain. Within the From field in our example, the 6" octet was
chan%ed from 00 to 32 to represent as identifying information for this being in the Cisco UCS 6332 in
the 4" cabinet.

ﬁ When there are multiple UCS domains sitting in adjacency, it is important that these blocks; the
WWNN, WWPN, and MAC, hold differing values between each set.

11. Specify a size of the WWNN block sufficient to support the available server resources.
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Create WWN Block

From: | 20:00:00:25:85:32:00:00 Size : | 16 b=

To ensure unigueness of WWNs in the SAN fabric, you are strongly encouraged to use
the following WWHN prefix:

20:00:00:25:bS:x0co0

12. Click OK.

13. Click Finish and OK to complete creating the WWNN pool.

Create WWPN Pools

To configure the necessary WWPN pools for the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click SAN on the left.

2. Select Pools > root.

3. In this procedure, two WWPN pools are created, one for each switching fabric.
4. Right-click WWPN Pools under the root organization.

5. Select Create WWPN Pool to create the WWPN pool.

6. Enter WWPN-Pool-A as the name of the WWPN pool.

7. Optional: Enter a description for the WWPN pool.

8. Select Sequential for Assignment Order.
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Create WWPN Pool f
Define Mame and Description Marme c WWEN-Pool-A
Description
Add WWN Blocks
Assignment Order : | Default (o) Sequential
Next > Cancel
9. Click Next.
10. Click Add.

11. Specify a starting WWPN

‘& For the FlexPod solution, the recommendation is to place 02 in the next-to-last octet of the starting
WWPN to identify all of the WWPNs as fabric A addresses. Merging this with the pattern we used for
the WWNN we see a WWPN block starting with 20: 00:00:25:B5:32:0A:00

12. Specify a size for the WWPN pool that is sufficient to support the available blade or server resources.
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13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

Create WWN Block

From : | 20:00:00:25:B5:32:0A:00 Size: | 16 =

To ensure unigueness of WWHNs in the SAN fabric, you are strongly encouraged to use
the: following WWHN prefix:

20:00:00:25:bS:0000Kx

Click OK.

Click Finish.

In the confirmation message, click OK.

Right-click WWPN Pools under the root organization.
Select Create WWPN Pool to create the WWPN pool.
Enter WwPN-Pool-B as the name of the WWPN pool.
Optional: Enter a description for the WWPN pool.
Select Sequential for Assignment Order.

Click Next.

Click Add.

Specify a starting WWPN.
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# For the FlexPod solution, the recommendation is to place 0B in the next-to-last octet of the starting
WWPN to identify all of the WWPNSs as fabric A addresses. Merging this with the pattern we used for
the WWNN we see a WWPN block starting with 20:00:00:25:B5:32:0B:00.

24. Specify a size for the WWPN address pool that is sufficient to support the available blade or server re-
sources.

25. Click OK.
26. Click Finish.

27. In the confirmation message, click OK

Create VSAN

To configure the necessary virtual storage area networks (VSANS) for the Cisco UCS environment, complete
the following steps:

1. In Cisco UCS Manager, click the SAN on the left.

# In this procedure, two VSANSs are created.

2. Select SAN > SAN Cloud.

3. Right-click VSANSs.

4. Select Create VSAN.

5. Enter VSAN-A as the name of the VSAN to be used for Fabric A

6. Leave FC Zoning set at Disabled.

7. Select Fabric A.

8. Enter a unique VSAN ID and a corresponding FCoE VLAN ID that matches the configuration in the MDS

switch for Fabric A. It is recommended to use the same ID for both parameters and to use something
other than 1.
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Create VSAN ? X

Marme - VSAN-A

FC Zoning Settings

FC Zoning : |(e) Disabled Enabled

Do NOT enable local zoning if fabrie interconnect is connected to an upstream FC/FCoE switch.

Common/Global e Fabric A Fabric B Both Fabrics Configured Differently

You are creating a local VSAN in fabric A that maps to ANVLAN can be used to carry FCoE traffic and can be mapped to this
a VSAN ID that exists only in fabric A, WSAN.

Enter the WSAN ID that maps to this WVSAN. Enter the WLAN ID that maps to this VSAN.

VSANID: 101 FCoE WLAN - | 101

o Cancel

10.

11.

12.

13.

14.

15.

Click OK and then click OK again.

Under SAN Cloud, right-click VSANSs.

Select Create VSAN.

Enter VSAN-B as the name of the VSAN to be used for Fabric B.

Leave FC Zoning set at Disabled.

Select Fabric B.

Enter a unique VSAN ID and a corresponding FCoE VLAN ID that matches the configuration in the MDS

switch for Fabric B. It is recommended use the same ID for both parameters and to use something other
than 1.
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Create VSAN ? X

MName :  VSAN-B

FC Zoning Settings

FC Zoning : |« Disabled Enabled

Do NOT enable local zoning if fabric interconnect is connected to an upstream FC/FCoE switch.

Common/Global Fabric A (e Fabric B Both Fabrics Configured Differently

You are creating a local VSAN in fabric B that maps to AVLAN can be used to carry FCoE traffic and can be mapped to this
aVSAN ID that exists only in fabric B. WEAMN.

Enter the WVSAN ID that maps to this VSAM. Enter the VLAN ID that maps to this VSAMN.

VSANID: 102 FCoE VLAN : | 102

n Cancel

16. Click OK and then click OK again.

Create FC Uplink Port Channels

To create the FC Uplink Port Channels and assign the appropriate VSANs to them for the Cisco UCS
environment, complete the following steps:

1. In Cisco UCS Manager, click SAN on the left.

2. Select SAN > SAN Cloud.

3. Expand Fabric A and select FC Port Channels.

4. Right-click FC Port Channels and select Create FC Port Channel.

5. Set a unique ID for the port channel and provide a unique name for the port channel.
6. Click Next.

7. Select the ports connected to Cisco MDS A and use >> to add them to the port channel.
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Create FC Port Channel |
Set FC Port Channel Name Port Channel Admin Speed : | Auto v
Ports Ports in the port channel
Port Slot ID WWPN Port Slot ID WWPN
3 1 20:03:8C:60... 1 1 20:01:8C:60...
4 1 20:04:8C:60... 2 i 20:02:8C:60...
5 1 20:05:8C:60_.. e
6 1 20:06:8C:60...
Slat ID: Slot ID:
WWWPN: WWEN:
< Prev m Cancel

8. Click Finish to complete creating the port channel.

9. Click OK the confirmation.

10. Under FC Port-Channels, select the newly created port channel.

11. In the right pane, use the pulldown to select VSAN-A.
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SAN / SAN Cloud [ Fabric A / FC Port Channels /

General Ports Faults Events Statistics

Status Properties
Cwerall Status : Y Failed D 10
Additional Info : No operational members Fabric ID A
Port Type - Aggregation
£ m >
Actions Transport Type : Fe
Name :  BPO-101
Disable Port Channel Description
Add Ports VSAN : |: Ajvsan VSAN-A (101] ¥
< m > Port Channel Admin Speed - | Auto L

Operational Speed(Gbps) : 0
12. Click Save Changes to assign the VSAN.
13. Click OK.
14. Expand Fabric B and select FC Port Channels.
15. Right-click FC Port Channels and select Create FC Port Channel.
16. Set a unique ID for the port channel and provide a unique name for the port channel.
17. Click Next.
18. Select the ports connected to Cisco MDS B and use >> to add them to the port channel.
19. Click Finish to complete creating the port channel.
20. Click OK on the confirmation.
21. Under FC Port-Channels, select the newly created port channel.
22. In the right pane, use the pulldown to select VSAN-B.
23. Click Save Changes to assign the VSAN.

24. Click OK.

Create VHBA Templates

To create the necessary virtual host bus adapter (vHBA) templates for the Cisco UCS environment, complete
the following steps:

1. In Cisco UCS Manager, click SAN on the left.
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2. Select Policies > root.

3. Right-click vHBA Templates.

4. Select Create VHBA Template.

5. Enter vHBA-Template-A as the VHBA template name.
6. Keep Fabric A selected.

7. Leave Redundancy Type set to No Redundancy.

8. Select VSAN-A.

9. Leave Initial Template as the Template Type.

10. Select WWPN-Pool-A as the WWPN Pool.

11. Click OK to create the vHBA template.

12. Click OK.
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Marme

Description

Fabric ID

Redundancy

Create vHBA Template

vHBA-Template-A

Redundancy Type

Select VSAN

Template Type

Mazx Data Field Size

WWPN Pool

QoS Policy

Pin Group

Stats Threshold Policy -

: | o) Mo Redundancy Primary Template

Secondary Template

- | WSAN-A v Create WSAN

: ‘ ») Initial Template Updating Template

2048

WWPN-Pool-A(16/16) ¥

<not set>

<not set> v

default »

Cancel

13.

14.

15.

16.

17.

18.

19.

20.

21.

Select VSAN-B.

Right-click vHBA Templates.

Select Create VHBA Template.

Enter vHBA-Template-B as the vHBA template name.
Leave Redundancy Type set to No Redundancy.

Select Fabric B as the Fabric ID.

Leave Initial Template as the Template Type.
Select WWPN-Pool-B as the WWPN Pool.

Click OK to create the VHBA template.
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22. Click OK.

Create SAN Connectivity Policy

To configure the necessary Infrastructure SAN Connectivity Policy, complete the following steps:

1. In Cisco UCS Manager, click SAN on the left.

2. Select SAN > Policies > root.

3. Right-click SAN Connectivity Policies.

4. Select Create SAN Connectivity Policy.

5. Enter FC-Boot as the name of the policy.

6. Select the previously created WWNN-Pool for the WWNN Assignment.
7. Click the Add button at the bottom to add a vHBA.

8. In the Create VHBA dialog box, enter Fabric-A as the name of the vHBA.
9. Select the Use VHBA Template checkbox.

10. In the vHBA Template list, select vHBA-Template-A.

11. In the Adapter Policy list, select VMWare.
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Configuration

Create vHBA

MName ;| Fabric-A
Use vHBA Template :

Redundancy Pair - ]

vHBA Template - vHBA-Template-A ¥

Adapter Performance Profile

Peer Mame :

Create vHBA Template

?

Adapter Policy | yiWare ¥

Create Fibre Channel Adapter Palicy

Cancel

12.

13.

14.

15.

16.

17.

18.

Click OK.

Click OK.

Select the Use VHBA Template checkbox.

In the Adapter Policy list, select VMWare.

Click the Add button at the bottom to add a second vHBA.

In the Create VHBA dialog box, enter Fabric-B as the name of the vHBA.

In the vHBA Template list, select vHBA-Template-B.
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Create SAN Connectivity Policy ? X
MNarme : FC-Boot ad
Description :

A server is identifhed on a SAN by its World Wide Node Name (WWNN). Specify how the system should assign a WWHNN to the server
associated with this profile.
World Wide Mode Name

WWHNN Assignment: WWRN-Paal(16/16) v

Create WWHNN Pool

The WAWNN will be assigned from the selected pool.
The available/total WWINNs are displayed after the pool name.

< m >
Narme WWPN
» vHBA Fabric-B Derived
» vHBA Fabric-A Derived

n Cancel

19. Click OK to create the SAN Connectivity Policy.

20. Click OK to confirm creation.

Create MAC Address Pools

To configure the necessary MAC address pools for the Cisco UCS environment, complete the following
steps:

1. In Cisco UCS Manager, click LAN on the left.

2. Select Pools > root.

‘& In this procedure, two MAC address pools are created, one for each switching fabric.

73



Server Configuration

3. Right-click MAC Pools under the root organization.

4. Select Create MAC Pool to create the MAC address pool.
5. Enter MAC-Pool-A as the name of the MAC pool.

6. Optional: Enter a description for the MAC pool.

7. Select Sequential as the option for Assignment Order.

8. Click Next.

9. Click Add.

10. Specify a starting MAC address.

# For the FlexPod solution, the recommendation is to place 02 in the next-to-last octet of the starting
MAC address to identify all of the MAC addresses as fabric A addresses. In our example, we have
implemented this practice, giving us 00:25:B5:32:0A:00 as our first MAC address.

11. Specify a size for the MAC address pool that is sufficient to support the available blade or server re-
sources.
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Create a Block of MAC Addresses

First MAC Address - | 00:25:85:32:0A:00 Size : | 64 a

To ensure unigqueness of MACs in the LAN fabric, you are strongly encouraged to use the following MAC
prefix:
00:25:B5:xx:XX:xX

12. Click OK.

13. Click Finish.

14. In the confirmation message, click OK.

15. Right-click MAC Pools under the root organization.

16. Select Create MAC Pool to create the MAC address pool.
17. Enter MAC-Pool-B as the name of the MAC pool.

18. Optional: Enter a description for the MAC pool.

19. Select Sequential as the option for Assignment Order.
20. Click Next.

21. Click Add.
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22. Specify a starting MAC address.

# For the FlexPod solution, it is recommended to place 0B in the next to last octet of the starting MAC
address to identify all the MAC addresses in this pool as fabric B addresses. Once again, we have
implemented this practice, giving us 00:25:B5:32:0B:00 as our first MAC address.

23. Specify a size for the MAC address pool that is sufficient to support the available blade or server re-
sources.

24. Click OK.
25. Click Finish.

26. In the confirmation message, click OK.

Create UUID Suffix Pool

To configure the necessary universally unique identifier (UUID) suffix pool for the Cisco UCS environment,
complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.

2. Select Pools > root.

3. Right-click UUID Suffix Pools.

4. Select Create UUID Suffix Pool.

5. Enter UUID-Pool as the name of the UUID suffix pool.
6. Optional: Enter a description for the UUID suffix pool.
7. Keep the prefix at the derived option.

8. Select Sequential for the Assignment Order.

9. Click Next.

10. Click Add to add a block of UUIDs.

11. Keep the From field at the default setting.

12. Specify a size for the UUID block that is sufficient to support the available blade or server resources.
13. Click OK.

14. Click Finish.

15. Click OK.
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Create Server Pool

To configure the necessary server pool for the Cisco UCS environment, complete the following steps:

# Consider creating unique server pools to achieve the granularity that is required in your environment.

1. In Cisco UCS Manager, click Servers on the left.

2. Select Pools > root.

3. Right-click Server Pools.

4. Select Create Server Pool.

5. Enter Infra-Pool as the name of the server pool.
6. Optional: Enter a description for the server pool.

7. Click Next.

8. Select two (or more) servers to be used for the VMware management cluster and click >> to add them to
the Infra-pPool server pool.

9. Click Finish.
10. Click OK.

Create VLANs

To configure the necessary virtual local area networks (VLANS) for the Cisco UCS environment, complete the
following steps:

1. In Cisco UCS Manager, click LAN on the left.

# In this procedure, five uniqgue VLANS are created. See Table 2

2. Select LAN > LAN Cloud.

3. Right-click VLANSs.

4. Select Create VLANS.

5. Enter Native-VLAN as the name of the VLAN to be used as the native VLAN.
6. Keep the Common/Global option selected for the scope of the VLAN.

7. Enter the native VLAN ID.

8. Keep the Sharing Type as None.

9. Click OK and then click OK again.
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Create VLANSs ? X
WVLAN Mame/Prefix o | Native-VLAN

Multicast Policy Name © | <not set> ¥ Create Multicast Policy

o Common/Global Fabric A Fabric B Both Fabrics Confgured Differently

You are creating global VLANS that map to the same VLAN IDs in all available fabrics.
Enter the range of VLAN [Ds.(e.g. * 2009-2019%, " 29,35 40-45" , " 23", " 23 34-45")

VELAN IDs: | 2

Sharing Type :© |(&) Mone Primary Isolated Community

Check Overlap o Cancel

10. Expand the list of VLANSs in the navigation pane, right-click the newly created Native-VLAN and select
Set as Native VLAN.

11. Click Yes, and then click OK.

12. Right-click VLANSs.

13. Select Create VLANs

14. Enter 1B-MGMT as the name of the VLAN to be used for management traffic.
15. Keep the Common/Global option selected for the scope of the VLAN.

16. Enter the In-Band management VLAN ID.

17. Keep the Sharing Type as None.

18. Click OK, and then click OK again.

19. Right-click VLANSs.

20. Select Create VLANS.
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21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.

37.

38.

Enter Infra-NFS as the name of the VLAN to be used for NFS.

Keep the Common/Global option selected for the scope of the VLAN.
Enter the Infrastructure NFS VLAN ID.

Keep the Sharing Type as None.

Click OK, and then click OK again.

Right-click VLANS.

Select Create VLANS.

Enter vMotion as the name of the VLAN to be used for vMotion.
Keep the Common/Global option selected for the scope of the VLAN.
Enter the vMotion VLAN ID.

Keep the Sharing Type as None.

Click OK, and then click OK again.

Select Create VLANS.

Enter vM-Traffic as the name of the VLAN to be used for VM Traffic.
Keep the Common/Global option selected for the scope of the VLAN.
Enter the VM-Traffic VLAN ID.

Keep the Sharing Type as None.

Click OK and then click OK again.

LAN Cloud - LAN Cloud | VLANs

+) Add
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Modify Default Host Firmware Package

Firmware management policies allow the administrator to select the corresponding packages for a given
server configuration. These policies often include packages for adapter, BIOS, board controller, FC adapters,
host bus adapter (HBA) option ROM, and storage controller properties.

To create a firmware management policy for a given server configuration in the Cisco UCS environment,
complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.

2. Select Policies > root.

3. Expand Host Firmware Packages.

4. Select default.

5. In the Actions pane, select Modify Package Versions.

6. Select the version 3.2(1d) for both the Blade and Rack Packages.

80



Server Configuration

Modity Package Versions X
Blade Package : | 3.2(1d)B v
Rack Package : |3.2(m}: -
Service Pack - | <not cets v

The images from Service Pack will take precedence over the images from Blade or Rack Package

Excluded Components:

Adapter [~

BIOS

Board Controller

CiMC

FC Adapters

Flex Flash Controller

GPUs

HBA Option ROM

Host NIC

Host NIC Option ROM
| Local Disk

PSU

SAS Fxnancler : ¥
< | m »

DK Apply Cancel Help

7. Click OK, then click OK again to modify the host firmware package.

Set Jumbo Frames in Cisco UCS Fabric

To configure jumbo frames and enable quality of service in the Cisco UCS fabric, complete the following
steps:

1. In Cisco UCS Manager, click LAN on the left.

2. Select LAN > LAN Cloud > QoS System Class.

3. In the right pane, click the General tab.

4. On the Best Effort row, enter 9216 in the box under the MTU column.
5. Click Save Changes in the bottom of the window.

6. Click OK.
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fm % m h

(7]

=
=
2,

LAN Cloud | QoS5 System Class
5 25
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Owner : Local
Priority Enabled CoS Packet Weight
Drop
Platinum r 5 r
Gold r 4 =4
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Bronze r 1 ~
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Effort
Fibre 4 3 r

Weight

(%)

NiA

N/A

NIA

NIA

NIA

MTU

ormal

normal

Multicast
Optimized

r

r

The only the Fibre Channel and Best Effort QoS System Classes are enabled in this FlexPod implementation.
The Cisco UCS and Nexus switches are intentionally configured this way so that all IP traffic within the
FlexPod will be treated as Best Effort. Enabling the other QoS System Classes without having a comprehen-
sive, end-to-end QoS setup in place can cause difficult to troubleshoot issues. For example, NetApp storage
controllers by default mark IP-based storage protocol packets with a CoS value of 4. With the default configu-
ration on the Nexus switches in this implementation, storage packets will pass through the switches and into
the Cisco UCS Fabric Interconnects with CoS 4 set in the packet header. If the Gold QoS System Class in the
Cisco UCS is enabled, these storage packets will be treated according to that class and if Jumbo Frames is
being used for the storage protocols, but the MTU of the Gold QoS System Class is not set to Jumbo, packet

drops will occur.

Create Local Disk Configuration Policy (Optional)

A local disk configuration for the Cisco UCS environment is necessary if the servers in the environment do
not have a local disk.

ﬂ This policy should not be used on servers that contain local disks.

To create a local disk configuration policy, complete the following steps:

1.

2.

In Cisco UCS Manager, click Servers on the left.
Select Policies > root.
Right-click Local Disk Config Policies.

Select Create Local Disk Configuration Policy.

Enter SAN-Boot as the local disk configuration policy name.

Change the mode to No Local Storage.

Click OK to create the local disk configuration policy.
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Create Local Disk Configuration Policy ? X
MNarme : | SAN-Boot

Description

Mode - [No Local Storage v

FlexFlash

FlexFlash State : |o Disable () Enable |

If FlexFlash State 1= disabled, S0 cards will become unavailable immediately.
Please ensure S0 cards are not in use before disabling the FlexFlash State.

FlexFlash RAID Reporting State - | ) [isable Enable |

o Cancel

8. Click OK.

Create Network Control Policy for Cisco Discovery Protocol (CDP) and Link Layer Discovery
Protocol (LLDP)

To create a network control policy that enables CDP and LLDP on virtual network ports, complete the
following steps:

1. In Cisco UCS Manager, click LAN on the left.
2. Select Policies > root.

3. Right-click Network Control Policies.
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4. Select Create Network Control Policy.

5. Enter Enable-CDP-LLDP as the policy name.

6. For CDP, select the Enabled option.

7. For LLDP, scroll down and select Enabled for both Transmit and Receive.

8. Click OK to create the network control policy.

Create Network Control Policy 5
CoP : Dizabled (o) Enabled
MAC Remqistar Mode - [(e) Only Mative Vlan All Host Vlans
Action on Uplink Fail ;|0 Link Down (0 Warning
MAC Security
Forge : (e Allow () Deny
LLDP
Tranzmit : Dizabled (o) Enabled
Receive : Dizabled () Enabled
9. Click OK.

Create Power Control Policy

To create a power control policy for the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click Servers tab on the left.
2. Select Policies > root.

3. Right-click Power Control Policies.

4. Select Create Power Control Policy.

5. Enter No-Power-Cap as the power control policy name.
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6. Change the power capping setting to No Cap.

7. Click OK to create the power control policy.

8. Click OK.
Create Power Control Policy ? X
MName - | No-Power-Cap
Description
Fan Speed Policy © | Any v

Power Capping

If you choose cap, the server is allocated a certain amount of power based on its priority
within its power group. Prionty values range from 1 to 10, with 1 being the highest prionty. If
you choose no-cap, the server is exempt from all power capping.

® Mo Cap cap

Cisco UCS Manager only enforces power capping when the servers in a power group require
more power than 1s currently available. With sufficient power, all servers run at full capacity
regardless of their priority.

o Cancel

Create Server Pool Qualification Policy (Optional)

To create an optional server pool qualification policy for the Cisco UCS environment, complete the following
steps:

‘ﬁ This example creates a policy for Cisco UCS B200 M5 servers for a server pool.

1. In Cisco UCS Manager, click Servers on the left.
2. Select Policies > root.

3. Right-click Server Pool Policy Qualifications.

4. Select Create Server Pool Policy Qualification.
5. Name the policy ucs-B200M5.

6. Select Create Server PID Qualifications.

7. Select UCSB-B200-M5 from the PID drop-down list.
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Create Server PID Qualifications

PID: |UCSB-B200-Mg
UCSB-B420-M4

B230-BASE-M2

B440-BASE-M2
UCSB-EX-M4-3
N20-B6625-2

N20-B6625-1

UCSC-C3X60-SVRNB
UCSC-C3X60-M4SRB
UCSC-C3K-M4SRB
UCSB-B420-M3
UCSB-B22-M3
UCSB-EX-M4-1
UCSB-EX-M4-2
UCSB-B480-M5

UCSC-C24-M352
UCSC-C24-M3L
UCSC-C22-M3L
UCSC-C22-M3S

8. Click OK.
9. Optionally select additional qualifications to refine server selection parameters for the server pool.

10. Click OK to create the policy then OK for the confirmation.

Create Server BIOS Policy

To create a server BIOS policy for the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.
2. Select Policies > root.
3. Right-click BIOS Policies.

4. Select Create BIOS Policy.

86



Server Configuration

5. Enter vM-Host as the BIOS policy name.

Create BIOS Policy

Name : VM-Host

Description

Reboot on BIOS Settings Change : O

Cancel

6. Select and right click the newly created BIOS Policy.

7. Within the Main tab of the Policy:
8. Change CDN Control to enabled.

9. Change the Quiet Boot setting to disabled.
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Policies | root | BIOS Policies /| VM-Host

Main Advanced Boot Options Server Management Events
Actions

Delete

Show Policy Usage

Properties

Name © VM-Host
Description
Owmer : Local

Reboot on BIOS Settings Change : [

Vo Adveanced Filter 4 Export & Print e
BIOS Tokens Settings
[ CDN Control Enabled v]
Front panel lockout i Delandt -

paus atform Default v
[ Quiet Boot Disabled ']
v

Resume on AC power loss Platform Default

10. Click the Advanced tab, leaving the Processor tab selected within the Advanced tab.
11. Set the following within the Processor tab:
12. DRAM Clock Throttling -> Performance:

a. Frequency Floor Override -> Enabled

b. Processor C State -> Disabled
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Policies | root | BIOS Policies /| VM-Host

Mamn Advanced l Boot Options Server Management Events

Processor Intel Directed 10 RAS Memory Serial Port use PCI apl LOM and PCle Slots Trusted Platform Graphics Configuration
Y, Advanced Fiter 4 Export  # Print el

BIOS Tokens Settings
Attitude Platform Default v =
CPU Hardware Power Management Platform Default v
CPU Performance Platform Default v
Core Multi Processing Platform Default ¥

L DRAM Clock Throttling Performance ']
Direct Cache Access Platform Default ¥
Energy Performance Tuning Platform Default ol
v

Enhanced Intel SpeedStep Tech

Execute Disable Bit

Platform Default

Platform Default

[_ Frequency Floor Ovemide

Enabled

ntel HyperThreading Tech
intel Turbo Boost Tech

ntel Virtualization Technology
Channel Interleaving

Memory Interleaving

Rank Interleaving

Local X2 Apic

Max Variable MTRR Setting

P STATE Coordination

Package C State Limit

Platform Default

Platform Default

Platform Default

Platform Default

Plati

Default

Platform Default

Platform Default

Platform Default

Platform Default

Platform Default

[ Processor C State

Disabled

13

Processor C1E -> disabled

a.
b. Processor C3 Report -> disabled

o

Processor C7 Report -> disabled

d. Energy Performance -> performance
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Palicies | root |/ BIOS Policies | VM-Host

Main Advanced Boot Options Server Management Events

m Intel Directed 10 RAS Memory Serial Port usB PCl aPl LOM and PCle Slats Trusted Platform Graphics Configuration

T, Advanced Fiter 4 Export @ Print £
BIOS Tokens Settings
Memary Interleaving Platform Default " 3
Rank Interleaving Platform Default v
Local X2 Apic Platform Default "
Max Variable MTRR Setting Platform Default i
P STATE Coordination Platform Default v
Package C State Limit Platform Default v
Processor C State Disabled v
Processor C1E Disabiled o
Processor C3 Report Disabled v
Processor Cf Report Platform Default &
Disabled 'j
Processor CMCI Platform Default o
Power Technology Platform Default "
[ Energy Performance Performance ']
Adjacent Cache Line Prefetcher Pl Default ol
DCU IP Prefetcher Platform Default B
DCU Streamer Prefetch Platform Default v
Hardware Prefetcher Platform Default v
Demand Scrub Platform Default v
Patrol Serub Platform Default r
Workload Configuration Platform Default v =1
Save Changes Reset Values

14. Click the RAS Memory tab and select LV DDR Mode -> performance-mode.
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Policies | root /| BIOS Policies | VM-Host

Serial Port use °C QP LOM and PCle Slots rusted Platform Graphics Configuration

T, Advanced Fiter 4 Export o Print el

15. Click Save Changes.

16. Click OK.

Update the Default Maintenance Policy

To update the default Maintenance Policy, complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.
2. Select Policies > root.

3. Select Maintenance Policies > default.

4. Change the Reboot Policy to User Ack.

5. Select “On Next Boot” to delegate maintenance windows to server administrators.
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Maintenance Policy X
General Events
Actions Properties
Name - default
Show Policy Usage Description
Owner . Local
Soft Shutdown Timer : | 150 Secs v
Storage Config. Deployment Policy : Immediate (s User Ack |
Reboot Policy . Immediate (s User Ack Timer Automatic

+| On Next Boot {Apply pending changes at next reboot. )

OK Cancel Help

6. Click Apply

7. Click OK to accept the change.

Create VNIC Templates

To create multiple virtual network interface card (vNIC) templates for the Cisco UCS environment, complete
the following steps. A total of 2 vNIC Templates will be created.

Create Infrastructure vNICs

1. In Cisco UCS Manager, click LAN on the left.
2. Select Policies > root.

3. Right-click vNIC Templates.

4. Select Create vNIC Template.

5. Enter Infra-A as the vNIC template name.
6. Keep Fabric A selected.

7. Select the Enable Failover checkbox.
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# Selecting Failover is a critical step to improve link failover time by handling it at the hardware level,
and to guard against NIC any potential for NIC failure not being detected by the virtual switch.

8. Select Primary Template for Redundancy Type.

9. Leave the Peer Redundancy Template set to <not set>.

10. Under Target, make sure that only the Adapter checkbox is selected.
11. Select Updating Template as the Template Type.

12. Under VLANS, select the checkboxes for IB-MGMT, Infra-NFS, vMotion, VM-Traffic, and Native-VLAN
VLANS.

13. Set Native-VLAN as the native VLAN.

14. Select vNIC Name for the CDN Source.
15. For MTU, enter 9000.

16. In the MAC Pool list, select MAC-Pool-A.

17. In the Network Control Policy list, select Enable-CDP-LLDP.
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Create vNIC Template ? X
Template Type : | Initial Template (s Updating Template
VLAMSs VLAN Groups
T, Advanced Filter 4 Export /% Print i
Selact Name Matrve VLAN
IOM-iSCSI-B
IOM-NFS
b Native-VLAN .
L VM-Traffic
o viMotion -
Create VLAN
CDN Source (@ wNIC Name () User Defined
MTU Q000
MAC Pool MAC-Pool-Al60/64) ¥
QoS Policy cnot sst> ¥
Metwork Control Policy © § Enghble-CDP-LLDP v
Pin Group <not set> v -
Stats Threshold Policy : | dafault
Connection Policies :I
Cancel

18. Click OK to create the vNIC template.

19. Click OK.

Create the secondary redundancy template Infra-B:

1. Select LAN on the left.

2. Select Policies > root.

3. Right-click vNIC Templates.
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4. Select Create vNIC Template

5. Enter Infra-B as the vNIC template name.

6. Select Fabric B.

7. Select the Enable Failover checkbox.

8. Set Redundancy Type to Secondary Template.

9. Select Infra-A for the Peer Redundancy Template.

10. In the MAC Pool list, select MAC-Pool-B.

# The MAC Pool is all that needs to be selected for the Secondary Template, all other values will be
propagated from the Primary Template.

11. Click OK to create the vNIC template.

12. Click OK.

Create LAN Connectivity Policy for FC Boot

To configure the necessary Infrastructure LAN Connectivity Policy, complete the following steps:

1. In Cisco UCS Manager, click LAN on the left.

2. Select LAN > Policies > root.

3. Right-click LAN Connectivity Policies.

4. Select Create LAN Connectivity Policy.

5. Enter FC-Boot as the name of the policy.

6. Click the upper Add button to add a vNIC.

7. In the Create vNIC dialog box, enter 00-Infra-A as the name of the vNIC.
8. Select the Use vNIC Template checkbox.

9. In the vNIC Template list, select Infra-A.

10. In the Adapter Policy list, select VMWare.

11. Click OK to add this vNIC to the policy.
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Create vNIC

Mame - | 00-Infra-A
Use vNIC Template - #

Redundancy Pair - Peer Mame -

vNIC Template © | |nfra-A » Create vNIC Template

Adapter Performance Profile

?

Adapter Policy S WMWare v Create Ethernet Adapter Policy

12.

13.

14.

15.

16.

17.

Click the upper Add button to add another vNIC to the policy.

In the Create VNIC box, enter 01-Infra-B as the name of the vNIC.
Select the Use vNIC Template checkbox.

In the vNIC Template list, select Infra-B.

In the Adapter Policy list, select VMWare.

Click OK to add the vNIC to the policy.
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Create LAN Connectivity Policy ? X
MName - FC-Boot
Description :

Click Add to specify one or more vNICs that the server should use to connect to the LAN.

MName MAC Address Jative VILAN

vNIC 01 =Infra-B

vNIC 00-Infra-A Derived

(%) Add

{# Add iSCSI vNICs

18. Click OK, then click OK again to create the LAN Connectivity Policy.

Create vMedia Policy for VMware ESXi 6.5 U1 ISO Install Boot

In the NetApp ONTAP setup steps an HTTP web server is required, which will be used for hosting ONTAP as
well as VMware software. The vMedia Policy created will map the VMware ESXi 6.5 U1 ISO to the Cisco UCS
server in order to boot the ESXi installation. To create this policy, complete the following steps:

1. In Cisco UCS Manager, select Servers on the left.

2. Select Policies > root.

w

Right-click vMedia Policies.

4. Select Create vMedia Policy.
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10.

11.

12.

13.

Name the policy ESXi-6.5U1-HTTP.

Enter “Mounts ISO for ESXi 6.5 U1l” in the Description field.
Click Add.

Name the mount ESXi-6.5U1-HTTP.

Select the CDD Device Type.

Select the HTTP Protocol.

Enter the IP Address of the web server.

# Since DNS server IPs were not entered into the KVM IP earlier, it is necessary to enter the IP of the
web server instead of the hostname.

Enter VMware-VMuvisor-Installer-6.5.0.update01-5969303.x86_64.iso as the Remote File name.

# This VMware ESXi 6.5 U1 ISO can be downloaded from VMware Downloads.

Enter the web server path to the ISO file in the Remote Path field.
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Name

Description

Device Type

Protocol
Hostname/IP Address
Image Name Variable
Remote File

Remote Path
Username

Paszsword

Remap on Eject

Create vMedia Mount

ESXi-65.U1-HTTP

e, CDD [ HDD

NFS CIFS (e HTTP HTTPS |

10.1.156.150

+ Mone Service Profile Mame

visor-Installer-6.5.0,update01-5969303.xB6_64.is0

bears/vSphere%206.5|

14. Click OK to create the vMedia Mount.

15. Click OK then OK again to complete creating the vMedia Policy.

‘ﬁ For any new servers added to the Cisco UCS environment the vMedia service profile template can be used to
install the ESXi host. On first boot the host will boot into the ESXi installer since the SAN mounted disk is
empty. After ESXi is installed, the vMedia will not be referenced as long as the boot disk is accessible.

Create FC Boot Policy

This procedure applies to a Cisco UCS environment in which two Fibre Channel logical interfaces (LIFs) are
on cluster node 1 (fcp_lif0la and fcp_lif01b) and two Fibre Channel LIFs are on cluster node 2 (fcp_lif02a
andfcp_lif02b). Also, it is assumed that the A LIFs are connected to Fabric A (Cisco UCS Fabric Interconnect

A) and the B LIFs are connected to Fabric B (Cisco UCS Fabric Interconnect B).

‘ﬁ One boot policy is configured in this procedure. The policy configures the primary target to be fcp_lif0la.

To create a boot policy for the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.

2. Select Policies > root.
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3. Right-click Boot Policies.
4. Select Create Boot Policy.
5. Enter Boot-Fabric-A as the name of the boot policy.

6. Optional: Enter a description for the boot policy.

# Do not select the Reboot on Boot Order Change checkbox.

7. Keep the Reboot on Boot Order Change option cleared.

8. Expand the Local Devices drop-down menu and select Add Remote CD/DVD.
9. Expand the vHBAs drop-down menu and select Add SAN Boot.

10. Select the Primary for type field.

11. Enter Fabric-A in vHBA field.

Add SAN Boot ? X

vHBA ;- | Fabric-A

Type : |[(e) Primary Secondary Any

o Cancel

12. Click OK.
13. From the vHBA drop-down menu, select Add SAN Boot Target.
14. Keep 0 as the value for Boot Target LUN.

15. Enter the WWPN for fcp_lifOla.

# To obtain this information, log in to the storage cluster and run the network interface show command.
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16

. Select Primary for the SAN boot target type.

Add SAN Boot Target ? X

Boot Target LUN ;- |0

Boot Target WWEN - | 20:07:00:20:98:39:fe:d2

Type o [fe Primary Secondary

o Cancel

17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

Click OK to add the SAN boot target.

From the vHBA drop-down menu, select Add SAN Boot Target.
Enter O as the value for Boot Target LUN.

Enter the WWPN for fcp_lif02a.

Click OK to add the SAN boot target.

From the vHBA drop-down menu, select Add SAN Boot.

In the Add SAN Boot dialog box, enter Fabric-B in the vVHBA box.
The SAN boot type should automatically be set to Secondary.
Click OK to add the SAN boot.

From the vHBA drop-down menu, select Add SAN Boot Target.
Keep O as the value for Boot Target LUN.

Enter the WWPN for fcp_lifO1b.

Select Primary for the SAN boot target type.

Click OK to add the SAN boot target.

From the vHBA drop-down menu, select Add SAN Boot Target.
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32. Keep 0 as the value for Boot Target LUN.
33. Enter the WWPN for fcp_Iif02b.

34. Click OK to add the SAN boot target.

35. Expand CIMC Mounted Media and select Add CIMC Mounted CD/DVD.

Create Boot Policy ? X
Mame : | Boot-Fabric-A
Description
Reboot on Boot Order Change - L
Enforce wNIG/vHBASISCS| Name : 1«
Boot Mode o |ie) Legacy Uefi
WARNINGS:
The type (primary/secondary) does not indicate a boot order presence.
The effective order of boot devices within the same device class (LAN/Storage(iSCS1) is determined by PCle bus scan order.
If Enforce vNIC/VHBASISCSI Name is selected and the vNIC/VHBANSCS! does not exist, a config errer will be reported.
If it is not selected, the vNICs/vHBAS are selected if they exist, otherwise the vNIC/vHBA with the lowest PCle bus scan order is used.
(¥ Local Devices Boot Order
+ =— T,Advanced Fiter 4 Export & Print -1:1-
I'.._-.'I 5
) VNICs Mame Or..a  wNIC/VHB.. Type LUNM M. SlotMN.. Boot.. BootP. Desecri.
= Remote CD/DVD 1
(=) vHBAs
w San 2
SAN Primary abric Erir
Add SAM Boot Target
SAN Secondary Fabric-B Secon.
. CIMC Mounted CD/DVD | 3
¥ iSCSIvNICs
(= CIMC Mounted vMedia
Add CIMC Mounted HDD
(# EFI Shell

36. Click OK, then click OK again to create the boot policy.

Create Service Profile Templates

In this procedure, one service profile template for Infrastructure ESXi hosts is created for Fabric A boot.

To create the service profile template, complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.

2. Select Service Profile Templates > root.
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3. Right-click root.

4. Select Create Service Profile Template to open the Create Service Profile Template wizard.

5. Enter VM-Host-Infra-FC-A as the name of the service profile template. This service profile template is
configured to boot from storage node 1 on fabric A.

6. Select the “Updating Template” option.

7. Under UUID, select UUID_Pool as the UUID pool.

Identify Service Profile Template

Storage Provisioning

Networking

SAN Connectivity

Zoning

vNIC/vHBA Placement

vMedia Policy

Server Boot Order

Maintenance Policy

Server Assignment

Operational Policies

Create Service Profile Template B

You must enter a name for the service profile template and specify the template type. You can also specify how a UUID will be assigned to this
template and enter a description.

Name :  WM-Host-Infra-FC-A

The template will be created in the following organization. Its name must be unique within this organization.
‘Where : org-root

The template will be created in the following organization. Its name must be unigue within this organization.

Type - Initial Template (o) Updating Template

Specify how the UUID will be assigned to the server associated with the service generated by this template.
uuID

UUID Assignment: UUID-Pool{12/12) v

The UUID will be assigned from the selected pool.
The availableftotal UUIDs are displayed after the pool name.

Optionally enter a description for the profile. The description can contain information about when and where the service profile should be used.

Next > m Cancel

8. Click Next.

Configure Storage Provisioning

1. If you have servers with no physical disks, click on the Local Disk Configuration Policy and select the
SAN-Boot Local Storage Policy. Otherwise, select the default Local Storage Policy.

2. Click Next.

Configure Networking Options

1. Keep the default setting for Dynamic vNIC Connection Policy.

2. Select the “Use Connectivity Policy” option to configure the LAN connectivity.

103




Server Configuration

3. Select FC-Boot from the LAN Connectivity Policy drop-down list.

4. Leave Initiator Name Assignment at <not set>.

Create Service Profile Template 7 X

Optionally specify LAN configuration information.
Identify Service Profile

Template

Dynamic vNIC Connection Policy: Select a Policy to use (no Dynamic vNIC Policy by default) v

Storage Provisioning

Create Dynamic vNIC Connection Policy

Networking
SAN Connectivity How would you like to configure LAN connectivity?
() Simple () Expert ) No wNICs (s) Use Connectivity Policy
Zoning H E . Cammeetivit in
LAN Connectivity Policy : | Fo-gBoot v Create LAN Connectivity Policy
wNIC/vHBA Placement Initiator Name
vMedia Policy Initiator Name Assignment: =not set> v
Create IQN Suffix Pool
Server Boot Order

WARNING: The selected pool does not contain any available entities.

. B ‘You can select it, but it is recommended that you add entities to it.
Maintenance Policy

Server Assignment

Operational Policies

< Prev Next > m Cancel

5. Click Next.

Configure Storage Options

1. Select the Use Connectivity Policy option for the “How would you like to configure SAN connectivity?”
field.

2. Select the FC-Boot option from the SAN Connectivity Policy drop-down list.
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Identify Service Profile
Template

Storage Provisioning

Networking

SAN Connectivity

Zoning

wNIC/vHBA Placement

vMedia Policy

Server Boot Order

Maintenance Policy

Server Assignment

Operational Policies

Create Service Profile Template

Optionally specify disk policies and SAN configuration information.

How would you like to configure SAN connectivity?

(1 Simple () Expert () No vHBAs (e) Use Connectivity Policy

SAN Connectivity Palicy - FCBoot v | Create SAN Connectivity Policy

< Prev

Next >

v

Cancel

3. Click Next.

Configure Zoning Options
1. Click Next.

Configure vNIC/HBA Placement

1.

2. Click Next.

Configure vMedia Policy

1. Do not select a vMedia Policy.

2. Click Next.

Configure Server Boot Order

1. Select Boot-Fabric-A for Boot Policy.
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Create Service Profile Template ?

Optionally specify the boot policy for this service profile template.
Identify Service Profile

Template
Select a boot policy.

Storage Provisioning Boot Policy:| Boot-Fabric-A w Create Boot Policy

MName : Boot-Fabric-A
Networking Description

Reboot on Boot Order Change  © No
SAN Connectivity Enforce vNIC/vHBASISCSI Name : Yes

Boot Mode . Legacy
Zoning WARNINGS:

The type (primary/secondary) does not indicate a boot order presence.

The effective order of boot devices within the same device class (LAN/Storage/iSCSI) is determined by PCle bus scan order.
VNIG/VHBA Placement If Enforce vNIC/vHBASISCSI Name 1= selected and the wNIC/VHBANSCSI does not exist, a config error will be reported

If it is not selected, the vNICs/vHBAS are selacted if they exist, otherwise the vNIC/vHBA with the lowest PCle bus scan order is used.

Boot Order
vMedia Policy
4+ ~— T,Advanced Filter 4 Export % Print 'm'

- o . yDa WWI " Slat ) sseriptio
P T Name Order  a vNIC/vHBA.. Type NWN LUN Name  Slot Numb Boot Name  Boot Path Description

Remote..
Maintenance Policy p San Z

CIMC M. 3

Server Assignment

Operational Policies

< Prev Next > m Cancel

2. Click Next.

Configure Maintenance Policy

1. Change the Maintenance Policy to default.
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Create Service Profile Template 7 X
) . Specify how disruptive changes such as reboots, network interruptions, and firmware upgrades should be applied to the server associated with this
Identify Service Profile service profile.
Template
Storage Provisioning (=) Maintenance Policy
Select a maintenance policy to include with this service profile or create a new maintenance policy that will be accessible to all service profiles.
Networking - -~
antenance Folicy: 0
default ¥ Create Maintenance Policy
SAN Connectivity
Zoning Name . default
Deseription
vNIC/vHBA Placement Soft Shutdown Timer : 150 Secs
Storage Config. Deployment Policy : User Ack
vMedia Policy Reboot Palicy . User Ack

Server Boot Order
Maintenance Policy
Server Assignment

Operational Policies

< Prev Next > m Cancel

2. Click Next.

Configure Server Assignment
To configure server assignment, complete the following steps:

1. Inthe Pool Assignment list, select Infra-Pool.
2. Select Down as the power state to be applied when the profile is associated with the server.
3. Optional: select “B200-M5” for the Server Pool Qualification to select only B200 M5 servers in the pool.

4. Expand Firmware Management at the bottom of the page and select the default policy.

107



Server Configuration

Create Service Profile Template ¥

Optionally specify a server pool for this service profile template.
Identify Service Profile

Template
You can select a server pool you want to associate with this service profile template.
Storage Provisioning Pool Assignment:| |nfra-Pool w Create Server Pool
N i Select the power state to be applied when this profile is associated
etworking with the server.

SAN Connectivity
Zoning The service profile template will be associated with one of the servers in the selected pool.

If desired, you can specify an additional server pool policy qualification that the selected server must meet. To do so, select the guahfication from

the list.
vNIC/vHBA Placement o

Server Pool Qualification © | <pot set> w

vMedia Policy Restrict Migration =

(=) Firmware Management (BIOS, Disk Controller, Adapter)
Server Boot Order -
If you select a host firmware policy for this service profile, the profile will update the firmware on the server that it is associated with.

. ) Otherwise the systemn uses the firmware already installed on the associated server.
Maintenance Policy

Host Firmware Package: default

Server Assignment
Create Host Firmware Package

Operational Policies

< Prev Mext > m Cancel

5. Click Next.

Configure Operational Policies
To configure the operational policies, complete the following steps:

1. In the BIOS Policy list, select VM-Host.

2. Expand Power Control Policy Configuration and select No-Power-Cap in the Power Control Policy list.
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Identify Service Profile
Template

Storage Provisioning

Metworking

SAN Connectivity

Zoning

vNIC/vHBA Placement

vMedia Policy

Server Boot Order

Maintenance Policy

Server Assignment

Operational Policies

Create Service Profile Template ?

Optionally specify information that affects how the system operates.

(= BIOS Configuration
If you want to override the default BIOS settings, select a BIOS policy that will be associated with this service profile

BIOS Paolicy © | WM-Host w

(#) External IPMI Management Configuration
) Management IP Address
(# Monitoring Configuration (Thresholds)

(=) Power Control Policy Configuration

Power control policy determines power allocation for a server in a given power group.

Power Control Palicy © | No-Power-Cap v Create Power Control Policy

(¥ Scrub Policy

# KVM Management Policy

< Prev m Cancel

3. Click Finish to create the service profile template.

4. Click OK in the confirmation message.

Create vMedia-Enabled Service Profile Template

To create a service profile template with vMedia enabled, complete the following steps:

1.

2.

Click OK to confirm.

Connect to UCS Manager and click Servers on the left.

Select Service Profile Templates > root > Service Template VM-Host-Infra-FC-A.

Right-click VM-Host-Infra-FC-A and select Create a Clone.

Name the clone VM-Host-Infra-FC-A-vM.

Select the newly-created VM-Host-Infra-FC-A-vM and select the vMedia Policy tab on the right.
Click Modify vMedia Policy.

Select the ESXi-6.5U1-HTTP vMedia Policy and click OK.
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Create Service Profiles

To create service profiles from the service profile template, complete the following steps:

1. Connect to UCS Manager and click Servers on the left.

2. Select Service Profile Templates > root > Service Template VM-Host-Infra-FC-A-vM.
3. Right-click VM-Host-Infra-FC-A and select Create Service Profiles from Template.

4. Enter VvM-Host-Infra-0 as the service profile prefix.

5. Enter 1 as “Name Suffix Starting Number.”

6. Enter 2 as the “Number of Instances.”

~

Click OK to create the service profiles.

Create Service Profiles From Template ? X

MNaming Prefix | VM

Mame Suffix Starting Mumber @ | 1

MNumber of Instances D2

8. Click OK in the confirmation message.

9. When VMware ESXi 6.5 U1 has been installed on the hosts, the host Service Profiles can be bound to the
VM-Host-Infra-FC-A Service Profile Template to remove the vMedia Mapping from the host.

Add More Servers to FlexPod Unit

Additional server pools, service profile templates, and service profiles can be created in the respective
organizations to add more servers to the FlexPod unit. All other pools and policies are at the root level and
can be shared among the organizations.

Gather Necessary Information

After the Cisco UCS service profiles have been created, each infrastructure server in the environment will
have a unique configuration. To proceed with the FlexPod deployment, specific information must be
gathered from each Cisco UCS server and from the NetApp controllers. Insert the required information into
Table 6 and Table 7 .
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Table 6 WWPNs from NetApp Storage

SVM Adapter MDS Switch Target: WWPN

Infra-SVM fcp_lif0la Fabric A <fcp lifOla-wwpn>
fcp_lifO1b Fabric B <fcp lif0lb-wwpn>
fcp_lif02a Fabric A <fcp lif02a-wwpn>
fcp_lif02b Fabric B <fcp 1if02b-wwpn>

# To obtain the FC WWPNS, run the network interface show command on the storage cluster manage-
ment interface.

Table 7 WWPNSs for Cisco UCS Service Profiles

Cisco UCS Service Profile Name MDS Switch Initiator WWPN

VM-Host-Infra-01 Fabric A vm-host-infra-0l-wwpna
Fabric B vm-host-infra-01l-wwpnb

VM-Host-Infra-02 Fabric A vm-host-infra-02-wwpna
Fabric B vm-host-infra-02-wwpnb

# To obtain the FC vHBA WWPN information in Cisco UCS Manager GUI, go to Servers > Service Profiles >
root. Click each service profile and then click the “Storage” tab, then “vHBASs” tab on the right. The WWPNs
are displayed in the table at the bottom of the page.
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SAN Switch Configuration

This section provides a detailed procedure for configuring the Cisco MDS 9000s for use in a FlexPod
environment. Follow these steps precisely because failure to do so could result in an improper configuration.

If directly connecting storage to the Cisco UCS fabric interconnects, skip this section.

Physical Connectivity

Follow the physical connectivity guidelines for FlexPod as covered in section FlexPod Cabling.

FlexPod Cisco MDS Base

The following procedures describe how to configure the Cisco Nexus switches for use in a base FlexPod
environment. This procedure assumes you are using the Cisco MDS 9148s with NX-0S.

Set Up Initial Configuration

Cisco MDS 9148S A

To set up the initial configuration for the Cisco MDS A switch, <mds-A-hosthame>, complete the following
steps:

# On initial boot and connection to the serial or console port of the switch, the NX-OS setup should automatically
start and attempt to enter Power on Auto Provisioning

1. Configure the switch using the command line.

Do you want to enforce secure password standard (yes/no) [y]: Enter
Enter the password for "admin": <password>

Confirm the password for "admin": <password>

Would you like to enter the basic configuration dialog (yes/no): yes
Create another login account (yes/no) [n]: Enter

Configure read-only SNMP community string (yes/no) [n]: Enter
Configure read-write SNMP community string (yes/no) [n]: Enter

Enter the switch name : <mds-A-hostname> Enter

Continue with Out-of-band (mgmtO) management configuration? (yes/no) [y]: Enter
Mgmt0O IPv4 address : <mds-A-mgmtO-ip> Enter

Mgmt0 IPv4 netmask : <mds-A-mgmtO-netmask> Enter

Configure the default gateway? (yes/no) [y]: Enter

IPv4 address of the default gateway : <mds-A-mgmtO-gw> Enter
Configure advanced IP options? (yes/no) [n]: Enter

Enable the ssh service? (yes/no) [y]: Enter

Type of ssh key you would like to generate (dsa/rsa) [rsa]: Enter
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Number of rsa key bits <1024-2048> [1024]: Enter

Enable the telnet service? (yes/no) [n]: Enter

Configure congestion/no credit drop for fc interfaces? (yes/no) [y]: Enter
Enter the type of drop to configure congestion/no_credit drop? (con/no) [c]: Enter

Enter milliseconds in multiples of 10 for congestion-drop for port mode F
in range (<100-500>/default), where default is 500. [d]: Enter

Enable the http-server? (yes/no) [y]: Enter

Configure timezone? (yes/no) [n]: Enter

Configure summertime? (yes/no) [n]: Enter

Configure the ntp server? (yes/no) [n]: yes

NTP server IPv4 address : <switch-a-ntp-ip>

Configure default switchport interface state (shut/noshut) [shut]: Enter
Configure default switchport trunk mode (on/off/auto) [on]: Enter
Configure default switchport port mode F (yes/no) [n]: yes

Configure default zone policy (permit/deny) [deny]: Enter

Enable full zoneset distribution? (yes/no) [n]: yes

Configure default zone mode (basic/enhanced) [basic]: Enter

2. Review the configuration.

Would you like to edit the configuration? (yes/no) [n]: Enter

Use this configuration and save it? (yes/no) [y]: Enter

Cisco MDS 9148S B

To set up the initial configuration for the Cisco MDS B switch, <mds-B-hostname>, complete the following
steps:

‘ﬁ On initial boot and connection to the serial or console port of the switch, the NX-OS setup should automatically
start and attempt to enter Power on Auto Provisioning

1. Configure the switch using the command line.

Do you want to enforce secure password standard (yes/no) [y]: Enter
Enter the password for "admin": <password>

Confirm the password for "admin": <password>

Would you like to enter the basic configuration dialog (yes/no): yes
Create another login account (yes/no) [n]: Enter

Configure read-only SNMP community string (yes/no) [n]: Enter
Configure read-write SNMP community string (yes/no) [n]: Enter

Enter the switch name : <mds-B-hostname> Enter
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Continue with Out-of-band (mgmt0) management configuration? (yes/no) [y]: Enter
Mgmt0 IPv4 address : <mds-B-mgmtO-ip> Enter

MgmtO IPv4 netmask : <mds-B-mgmtO-netmask> Enter

Configure the default gateway? (yes/no) [y]: Enter

IPv4 address of the default gateway : <mds-B-mgmtO-gw> Enter

Configure advanced IP options? (yes/no) [n]: Enter

Enable the ssh service? (yes/no) [y]: Enter

Type of ssh key you would like to generate (dsa/rsa) [rsal: Enter

Number of rsa key bits <1024-2048> [1024]: Enter

Enable the telnet service? (yes/no) [n]: Enter

Configure congestion/no credit drop for fc interfaces? (yes/no) [y]l: Enter
Enter the type of drop to configure congestion/no_credit drop? (con/no) [c]: Enter

Enter milliseconds in multiples of 10 for congestion-drop for port mode F
in range (<100-500>/default), where default is 500. [d]: Enter

Enable the http-server? (yes/no) [y]l: Enter

Configure timezone? (yes/no) [n]: Enter

Configure summertime? (yes/no) [n]: Enter

Configure the ntp server? (yes/no) [n]: yes

NTP server IPv4 address : <<var_global ntp server ip>>

Configure default switchport interface state (shut/noshut) [shut]: Enter
Configure default switchport trunk mode (on/off/auto) [on]: Enter
Configure default switchport port mode F (yes/no) [n]: yes

Configure default zone policy (permit/deny) [deny]: Enter

Enable full zoneset distribution? (yes/no) [n]: yes

Configure default zone mode (basic/enhanced) [basic]: Enter

2. Review the configuration.

Would you like to edit the configuration? (yes/no) [n]: Enter

Use this configuration and save it? (yes/no) [y]: Enter

FlexPod Cisco MDS Switch Configuration

Enable Licenses

Cisco MDS 9148S A and Cisco MDS 9148S B
To enable the correct features on the Cisco MDS switches, complete the following steps:

1. Login as admin

2. Run the following commands:
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configure terminal
feature npiv
feature fport-channel-trunk

Configure Individual Ports

Cisco MDS 9148S A

To configure individual ports and port-channels for switch A, complete the following step:

# In this step and in further sections, configure the <ucs-6248-clustername> and <ucs-6332-clustername> inter-
faces as appropriate to your deployment.

From the global configuration mode, run the following commands:

interface fcl/1

switchport description <st-node0l>:0e
switchport trunk mode off
port-license acquire

no shut

interface fcl/2

switchport description <st-node02>:0e
switchport trunk mode off
port-license acquire

no shutdown

exit

interface fcl/9

switchport description <ucs-6248-clustername>-a:1/31
port-license acquire

channel-group 110

no shutdown

exit

interface fcl/10

switchport description <ucs-6248-clustername>-b:1/31
port-license acquire

channel-group 110

no shutdown

exit

interface fcl/11

switchport description <ucs-6332-clustername>-a:1/1
port-license acquire

channel-group 112

no shutdown

exit

interface fcl/12

switchport description <ucs-6332-clustername>-b:1/1
port-license acquire

channel-group 112

no shutdown

exit

interface port-channelll0

channel mode active

switchport mode F

switchport trunk allowed vsan <vsan-a-id>
switchport description <ucs-6248-clustername>
switchport rate-mode dedicated

interface port-channelll?2
channel mode active
switchport mode F
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switchport trunk allowed vsan <vsan-a-id>
switchport description <ucs-6332-clustername>
switchport rate-mode dedicated

Create Port Descriptions - Fabric B

To configure individual ports and port-channels for switch B, complete the following step:

From the global configuration mode, run the following commands:

interface fcl/1

switchport description <st-node01>:0f
switchport trunk mode off
port-license acquire

no shut

interface fcl/2

switchport description <st-node02>:0f
switchport trunk mode off
port-license acquire

no shutdown

exit

interface fcl/9

switchport description <ucs-6248-clustername>-a:1/32
port-license acquire

channel-group 111

no shutdown

exit

interface fcl/10

switchport description <ucs-6248-clustername>-a:1/32
port-license acquire

channel-group 111

no shutdown

exit

interface fcl/11

switchport description <ucs-6332-clustername>-a:1/2
port-license acquire

channel-group 113

no shutdown

exit

interface fcl/12

switchport description <ucs-6332-clustername>-a:1/2
port-license acquire

channel-group 113

no shutdown

exit

interface port-channellll

channel mode active

switchport mode F

switchport trunk allowed vsan <vsan-b-id>
switchport description <ucs-6248-clustername>
switchport rate-mode dedicated

interface port-channelll3

channel mode active

switchport mode F

switchport trunk allowed vsan <vsan-b-id>
switchport description <ucs-6332-clustername>
switchport rate-mode dedicated
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Create VSANSs

Cisco MDS 9148S A
To create the necessary VSANSs for fabric A and add ports to them, complete the following steps:

From the global configuration mode, run the following commands:

vsan database

vsan <vsan-a-id>

vsan <vsan-a-id> name Fabric-A

exit

zone smart-zoning enable vsan <vsan-a-id>
vsan database

vsan <vsan-a-id> interface fcl/1

vsan <vsan-a-id> interface fcl/2

vsan <vsan-a-id> interface port-channelll0
vsan <vsan-a-id> interface port-channelll?2

Cisco MDS 9148S B
To create the necessary VSANSs for fabric A and add ports to them, complete the following steps:

From the global configuration mode, run the following commands:

vsan database

vsan <vsan-b-id>

vsan <vsan-b-id> name Fabric-B

exit

zone smart-zoning enable vsan <vsan-b-id>
vsan database

vsan <vsan-b-id> interface fcl/1

vsan <vsan-b-id> interface fcl/2

vsan <vsan-b-id> interface port-channellll
vsan <vsan-b-id> interface port-channelll3

Create Device Aliases

Cisco MDS 9148S A
To create device aliases for Fabric A that will be used to create zones, complete the following steps:

From the global configuration mode, run the following commands:

configure terminal

device-alias database

device-alias name Infra-SVM-fcp 1if0Ola pwwn <fcp_ lifOla-wwpn>
device-alias name Infra-SVM-fcp 1if02a pwwn <fcp_ lif02a-wwpn>
device-alias name VM-Host-Infra-01-A pwwn <vm-host-infra-0l-wwpna>
device-alias name VM-Host-Infra-02-A pwwn <vm-host-infra-02-wwpna>
device-alias commit

Cisco MDS 9148S B
To create device aliases for Fabric B that will be used to create zones, complete the following steps:

From the global configuration mode, run the following commands:

configure terminal

device-alias database

device-alias name Infra-SVM-fcp 1ifOlb pwwn <fcp 1if0lb-wwpn>
device-alias name Infra-SVM-fcp 1if02b pwwn <fcp 1if02b-wwpn>
device-alias name VM-Host-Infra-01-B pwwn <vm-host-infra-01l-wwpnb>
device-alias name VM-Host-Infra-02-B pwwn <vm-host-infra-02-wwpnb>
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‘device—alias commit

Create Zones

Cisco MDS 9148S A
To create the required zones on Fabric A, run the following commands:

configure terminal

zone name VM-Host-Infra-01-A vsan <vsan-a-id>
member device-alias VM-Host-Infra-01-A init
member device-alias Infra-SVM-fcp 1if0Ola target
member device-alias Infra-SVM-fcp 1if02a target
exit

zone name VM-Host-Infra-02-A vsan <vsan-a-id>
member device-alias VM-Host-Infra-02-A init
member device-alias Infra-SVM-fcp 1ifOla target
member device-alias Infra-SVM-fcp 1if02a target
exit

zoneset name Fabric-A vsan <vsan-a-id>

member VM-Host-Infra-01-A

member VM-Host-Infra-02-A

exit

zoneset activate name Fabric-A vsan <vsan-a—-id>
exit

show zoneset active vsan <vsan-a-id>

Cisco MDS 9148S B
To create the required zones on Fabric B, run the following commands:

configure terminal

zone name VM-Host-Infra-01-B vsan <vsan-b-id>
member device-alias VM-Host-Infra-01-B init
member device-alias Infra-SVM-fcp 1if0lb target
member device-alias Infra-SVM-fcp 1if02b target
exit

zone name VM-Host-Infra-02-B vsan <vsan-b-id>
member device-alias VM-Host-Infra-02-B init
member device-alias Infra-SVM-fcp 1if0lb target
member device-alias Infra-SVM-fcp 1if02b target
exit

zoneset name Fabric-B vsan <vsan-b-id>

member VM-Host-Infra-01-B

member VM-Host-Infra-02-B

exit

zoneset activate name Fabric-B vsan <vsan-b-id>
exit

show zoneset active vsan <vsan-b-id>
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Storage Configuration — Boot LUNs

ONTAP Boot Storage Setup

Create igroups

Create igroups by entering the following commands from the cluster management node SSH connection:

igroup create -vserver Infra-SVM -igroup VM-Host-Infra-01 -protocol fcp -ostype vmware —-initiator <vm-
host-infra-0l-wwpna>, <vm-host-infra-0l-wwpnb>

igroup create -vserver Infra-SVM -igroup VM-Host-Infra-02 -protocol fcp -ostype vmware —initiator <vm-
host-infra-02-wwpna>, <vm-host-infra-02-wwpnb>

igroup create -vserver Infra-SVM -igroup MGMT-Hosts -protocol fcp -ostype vmware —-initiator <vm-host-
infra-0l-wwpna>, <vm-host-infra-0l-wwpnb>, <vm-host-infra-02-wwpna>, <vm-host-infra-02-wwpnb>

ﬁ Use the values listed in Table 6 and Table 7 for the WWPN information.

To view the three igroups just created, type igroup show.

Map Boot LUNS to igroups

From the storage cluster management SSH connection, enter the following commands:

lun map -vserver Infra-SVM -volume esxi boot -lun VM-Host-Infra-01 -igroup VM-Host-Infra-01 -lun-id 0
lun map -vserver Infra-SVM -volume esxi boot —-lun VM-Host-Infra-02 -igroup VM-Host-Infra-02 -lun-id 0
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VMware vSphere 6.5 Ul Setup

VMware ESXi 6.5 Ul

This section provides detailed instructions for installing VMware ESXi 6.5 U1 in an environment. After the
procedures are completed, two booted ESXi hosts will be provisioned.

Several methods exist for installing ESXi in a VMware environment. These procedures focus on how to use
the built-in keyboard, video, mouse (KVM) console and virtual media features in Cisco UCS Manager to map
remote installation media to individual servers and connect to their boot logical unit numbers (LUNS).

Download ESXi 6.5 U1 from VMware

If the VMware ESXi ISO has not been downloaded, complete the following steps:

1.

2.

3.

Click the following link: YMware vSphere Hypervisor (ESXi) 6.5 U1.

You will need a user id and password on vmware.com to download this software.

Download the .iso file.

Log into Cisco UCS 6300/6200 Fabric Interconnect

Cisco UCS Manager

The Cisco UCS IP KVM enables the administrator to begin the installation of the operating system (OS)
through remote media. It is necessary to log in to the Cisco UCS environment to run the IP KVM.

To log in to the Cisco UCS environment, complete the following steps:

1.

9.

Open a web browser and enter the IP address for the Cisco UCS cluster address. This step launches the
Cisco UCS Manager application.

Click the Launch UCS Manager link under HTML to launch the HTML 5 UCS Manager GUI.
If prompted to accept security certificates, accept as necessary.

When prompted, enter admin as the user name and enter the administrative password.
To log in to Cisco UCS Manager, click Login.

From the main menu, click Servers on the left.

Select Servers > Service Profiles > root > VM-Host-Infra-01.

Right-click vM-Host-Infra-01 and select KVM Console.

Follow the prompts to launch the Java-based KVM console.

10. Select Servers > Service Profiles > root > VM-Host-Infra-02.
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11. Right-click VM-Host-Infra-02. and select KVM Console.

12. Follow the prompts to launch the Java-based KVM console.

Set Up VMware ESXi Installation

ESXi Hosts VM-Host-Infra-01 and VM-Host-Infra-02

.S

Skip this section if using vMedia policies. 1SO file will already be connected to KVM.

To prepare the server for the OS installation, complete the following steps on each ESXi host:

1. Inthe KVM window, click Virtual Media.
2. Click Activate Virtual Devices
3. If prompted to accept an Unencrypted KVM session, accept as necessary.
4. Click Virtual Media and select Map CD/DVD.
5. Browse to the ESXi installer ISO image file and click Open.
6. Click Map Device.
7. Click the KVM tab to monitor the server boot.
Install ESXi

ESXi Hosts VM-Host-Infra-01 and VM-Host-Infra-02
To install VMware ESXi to the FC-bootable LUN of the hosts, complete the following steps on each host:

1.

2.

Boot the server by selecting Boot Server and click OK, then click OK again.

On reboot, the machine detects the presence of the ESXi installation media. Select the ESXi installer
from the boot menu that is displayed.

After the installer is finished loading, press Enter to continue with the installation.
Read and accept the end-user license agreement (EULA). Press F11 to accept and continue.

Select the LUN that was previously set up as the installation disk for ESXi and press Enter to continue
with the installation.

Select the appropriate keyboard layout and press Enter.
Enter and confirm the root password and press Enter.

The installer issues a warning that the selected disk will be repartitioned. Press F11 to continue with the
installation.
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9.

After the installation is complete, click on the Virtual Media tab and clear the checkmark next to the ESXi
installation media. Click Yes.

# The ESXi installation image must be unmapped to make sure that the server reboots into ESXi and
not into the installer.

10. After the installation is complete, press Enter to reboot the server.

11. In Cisco UCS Manager, bind the current service profile to the non-vMedia service profile template to

prevent mounting the ESXi installation iso over HTTP.

Set Up Management Networking for ESXi Hosts

Adding a management network for each VMware host is necessary for managing the host. To add a
management network for the VMware hosts, complete the following steps on each ESXi host:

ESXi Host VM-Host-Infra-01 and VM-Host-Infra-02
To configure each ESXi host with access to the management network, complete the following steps:

1.

2.

After the server has finished rebooting, press F2 to customize the system.
Log in as root, enter the corresponding password, and press Enter to log in.
Select Troubleshooting Options and press Enter.

Select Enable ESXi Shell and press Enter.

Select Enable SSH and press Enter.

Press Esc to exit the Troubleshooting Options menu.

Select the Configure Management Network option and press Enter.

Select Network Adapters and press Enter.

Verify that the numbers in the Hardware Label field match the numbers in the Device Name field.
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Network Adapters

Select the adapters for this host’s default management network
connection. Use two or more adapters tor and
load-balancing.

Device Mame Hardware Label (MAC Address) Status
[¥]1 vnnich gi-Infra-A (...:65:42:0a:00) Connected (. ..]
[ 1 vmnicl Bl-Infra-B (...:b5:42:0b:00) Connected
D> Vieu Details <Space> Toggle Selected <Enter> K <Esc?> Cancel

# In lab testing, examples have been seen with the Cisco UCS C220M4 server and VIC 1385/1387
where the vmnic and device ordering do not match. If this is the case, use the Consistent Device Nam-
ing (CDN) to note which vmnics are mapped to which vNICs and adjust the upcoming procedure ac-
cordingly.

10. Press Enter.

11. Select the VLAN (Optional) option and press Enter.

12. Enter the <ib-mgmt-vlan-id> and press Enter.

13. Select IPv4 Configuration and press Enter.

14. Select the Set static IPv4 address and network configuration option by using the space bar.
15. Enter the IP address for managing the first ESXi host.

16. Enter the subnet mask for the first ESXi host.

17. Enter the default gateway for the first ESXi host.

18. Press Enter to accept the changes to the IP configuration.

19. Select the DNS Configuration option and press Enter.

# Because the IP address is assigned manually, the DNS information must also be entered manually.

20. Enter the IP address of the primary DNS server.
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21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

Optional: Enter the IP address of the secondary DNS server.

Enter the fully qualified domain name (FQDN) for the first ESXi host.
Press Enter to accept the changes to the DNS configuration.

Press Esc to exit the Configure Management Network submenu.

Select Test Management Network to verify that the management network is set up correctly and press
Enter.

Press Enter to run the test, press Enter again once the test has completed, review environment if there is
a failure.

Re-select the Configure Management Network and press Enter.

Select the IPv6 Configuration option and press Enter.

Using the spacebar, select Disable IPv6 (restart required) and press Enter.
Press Esc to exit the Configure Management Network submenu.

Press Y to confirm the changes and reboot the ESXi host.

Reset VMware ESXi Host VMkernel Port vmkO MAC Address (Optional)

ESXi Host VM-Host-Infra-01 and VM-Host-Infra-02

By default the MAC address of the management VMkernel port vmkO is the same as the MAC address of the
Ethernet port it is place on. If the ESXi host’s boot LUN is remapped to a different server with different MAC
addresses, a MAC address conflict will exist because vmkO will retain the assigned MAC address. To reset
the MAC address of vmkO to a random VMware-assigned MAC address, complete the following steps:

1.

From the ESXi console menu main screen, type Ctrl-Alt-F1 to access the VMware console command line
interface. In the UCSM KVM, Ctrl-Alt-F1 appears in the list of Static Macros.

Log in as root.

Type “esxcfg-vmknic -1” to get a detailed listing of interface vmk0. vmkO should be a part of the “Man-
agement Network” port group. Note the IP address and netmask of vmkO.

To remove vmkO, type “esxcfg-vmknic -d “Management Network””.

To re-add vmkO with a random MAC address, type “esxcfg-vmknic -a -i <vmkO-ip> -n <vmkO-
netmask> “Management Network””.

Verify vmkO has been re-added with a random MAC address by typing “esxcfg-vmknic -I”.
Type “exit” to log out of the command line interface.

Type Ctrl-Alt-F2 to return to the ESXi console menu interface.
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Log into VMware ESXi Hosts by Using VMware Host Client

ESXi Host VM-Host-Infra-01

To log in to the VM-Host-Infra-01 ESXi host by using the VMware Host Client, complete the following
steps:

1. Open a web browser on the management workstation and navigate to the vM-Host-Infra-01 man-
agement IP address.

2. Click Open the VMware Host Client.
3. Enter root for the user name.
4. Enter the root password.

5. Click Login to connect.

o

Repeat this process to log into VM-Host-Infra-02 in a separate browser tab or window.

Set Up VMkernel Ports and Virtual Switch

ESXi Host VM-Host-Infra-01 and VM-Host-Infra-02
To set up the VMkernel ports and the virtual switches on the ESXi hosts, complete the following steps:

1. From the Host Client, select Networking on the left.

2. In the center pane, select the Virtual switches tab.

3. Select vSwitchO.

4. Select Edit settings.

5. Change the MTU to 9000.

6. Click Save.

7. On the left, select Networking, then select the Port groups tab.
8. In the center pane, right-click VM Network and select Remove.
9. Click Remove to complete removing the port group.

10. In the center pane, select Add port group.

11. Name the port group IB-MGMT Network and enter <ib-mgmt-vlan-id> in the VLAN ID field, and make
sure Virtual switch vSwitchO is selected.

12. Click Add to finalize the edits for the IB-MGMT Network.

13. At the top, select the VMkernel NICs tab.
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14. Click Add VMkernel NIC.

15. For New port group, enter VMkernel-vMotion.

16. For Virtual switch, select vSwitchO.

17. Enter <vmotion-vlan-id> for the VLAN ID.

18. Change the MTU to 9000.

19. Select Static IPv4 settings and expand IPv4 settings.
20. Enter the ESXi host vMotion IP address and netmask.
21. Select the vMotion stack for TCP/IP stack.

22. Click Create.

23. Click Add VMkernel NIC.

24. For New port group, enter VMkernel-Infra-NFS

25. For Virtual switch, select vSwitchO.

26. Enter <infra-nfs-vlan-id> for the VLAN ID

27. Change the MTU to 9000.

28. Select Static IPv4 settings and expand IPv4 settings.
29. Enter the ESXi host Infrastructure NFS IP address and netmask.
30. Do not select any of the Services.

31. Click Create.

32. Select the Virtual Switches tab, then vSwitchO. The properties for vSwitchO VMkernel NICs should be
similar to the following example:
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(== v SwitchO
* v Switch Details + v Switch topology
MTU 9000 —
IB-MGMT Metwork Physical adapters
FPorts 9472 (9464 available) L3 — | e
VLANID: 113 ] =W vmnicO, 40000 Mbps, ..
Link discovery Listen / Cisco discovery protocol (CDF) —
Aftached Vs 0 (0 active) @ VMkemel-nfra-NFS ]
Beacon interval 1 VLAN ID: 3050
: - VMkemel ports (1) 1
+ NIC teaming policy B vmlk2: 192.168.50... _f‘:]
Motify switches Yes —
Policy Route based on originating port ID €3 VMikernel-vMotion
Reverse policy Yes VLAN ID: 3000
) « VMkemel ports (1) |
T e Mo | B vmic 19216810 (]
* Security policy
Allow promiscuous mode Mo g Management Network
Allow forged transmits Yes VLAN ID: 113 L
« ViMkernel ports (1)
Allow MAC changes Yes B vmk0 10115626 |
~ Shaping policy e

33. Select the VMkernel NICs tab to confirm configured virtual adapters. The adapters listed should be simi-
lar to the following example:

£3 esxi-01 - Networking
Port groups Virtual switches Physical NICs | VMkernel NICs TCP/P stacks Firewall rules
8 Add VMkernel NIC | @ Refresh | (@ search )
Name ~ | Portgroup ~ | TCPNP stack ~ | Senices ~ | IPv4 address ~ | IPv6 addresses v
[ vmk0 g Management Network == Default TCPAP stack Management 10.1.156.25 MNone
. vmk2 g VMkernel-NFS == Default TCPIP stack 192.168.50.25 Mone
. vmk1 g VMEkernel-vMotion == vMotion stack vMotion 192.168.100.25 Mone
Jitems
#

Install VMware Driver for the Cisco Virtual Interface Card (VIC)

Download and extract the offline bundle for the following VMware VIC Driver to the Management
workstation:

nenic Driver version 1.0.6.0

ESXi Hosts VM-Host-Infra-01 and VM-Host-Infra-02

To install VMware VIC Drivers on the ESXi host VM-Host-Infra-01 and VM-Host-Infra-02, complete the
following steps:

1. From each Host Client, select Storage on the left.
2. Right-click datastorel and select Browse.

3. In the Datastore browser, click Upload.
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8.

9.

Navigate to the saved location for the downloaded VIC drivers and select VMW-ESX-6.5.0-nenic-
1.0.6.0-offline_bundle-5894048.zip.

Click Open to upload the file to datastorel.

Make sure the file has been uploaded to both ESXi hosts.

Place each host into Maintenance mode if it isn’t already.

Connect to each ESXi host through ssh from a shell connection or putty terminal.

Login as root with the root password.

10. Run the following command on each host:

esxcli software vib update -d /vmfs/volumes/infra datastore 1/VMW-ESX-6.5.0-nenic-
1.0.6.0-offline bundle-5894048.zip

11. Reboot each host by typing reboot from the SSH connection after the command has been run.

12. Log into the Host Client on each host once reboot is complete.

Mount Required Datastores

ESXi Hosts VM-Host-Infra-01 and VM-Host-Infra-02
To mount the required datastores, complete the following steps on each ESXi host:

1.

2.

From the Host Client, select Storage on the left.
In the center pane, select Datastores.
In the center pane, select New Datastore to add a new datastore.

In the New datastore popup, select Mount NFS datastore and click Next.
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New datastore

Select creation type

2 Provide NFS mount details How would you like to create a datastore?

3 Ready to complete

Create new VMFS datastore Create a new datastore by mounting a remote NFS volume

Increase the size of an existing VMFS datastore

Mount NFS datastore

5. Input infra_datastore_1 for the datastore name. Input the IP address for the nfs 1i£f01 LIF for the NFS
server. Input /infra_datastore_1 for the NFS share. Leave the NFS version set at NFS 3. Click Next.

E
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New datastore - infra_datastore_1

+ 1 Select creation type Provide NFS mount details

2 Provide NFS mount details Provide the details of the NFS share you wish to mount

3 Ready to complete

Name | infra_datastore_1 |
NFS server [192.166.50.22 |
NFS share | finfra_datastore_1| |
MFS version ®NFS3I U NFS4

| Back H Next Finish cancel

&

6. Click Finish. The datastore should now appear in the datastore list.
7. In the center pane, select New Datastore to add a new datastore.
8. In the New datastore popup, select Mount NFS datastore and click Next.

9. Input infra_datastore_2 for the datastore name. Input the IP address for the nfs 1i£02 LIF for the NFS
server. Input /infra_datastore_2 for the NFS share. Leave the NFS version set at NFS 3. Click Next.

10. Click Finish. The datastore should now appear in the datastore list.

3 esxi-01.vikings.cisco.com - Storage
| Datastores | Adapters Devices
3 Mew datastore cresse capacily | g Registera VM (G Datastore browser | (3 Refresh Actions (a search )
Name ~  Drive Type ~ Capacity ~  Provisioned ~  Free ~  Type ~  Thin provision...~ | Access
B datastore1 MNon-55D 7.5 GB 3.95 GB 3.55 GB VMFS6 Supported Single
B infra_datastore_1 Unknown 500 GB 37.19GB 452.81 GB NFS Supported Single
B infra_datastore_2 Unknown 500 GB 60.79 GB 439.21 GB NFS Supported Single

11. Mount both datastores on both ESXi hosts.

Configure NTP on ESXi Hosts

ESXi Hosts VM-Host-Infra-01 and VM-Host-Infra-02

To configure Network Time Protocol (NTP) on the ESXi hosts, complete the following steps on each host:
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1. From the Host Client, select Manage on the left.

2. In the center pane, select the Time & date tab.

3. Click Edit settings.

4. Make sure Use Network Time Protocol (enable NTP client) is selected.

5. From the pulldown to select Start and stop with host.

o

Enter the two Nexus switch NTP addresses in the NTP servers box separated by a comma.

@ Edit time configuration

Specify how the date and time of this host should he set.
Manually configure the date and time an this host
)
#® Use Metwork Time Protocol (enable NTP client)

NTP service startup policy Start and stop with host ¥

LJUEE L 10.1.156.4,10.1.156.5|

P
Separate servers with commas, e.g. 10.31.21.2, fe00:2800

Save || Cancel

7. Click Save to save the configuration changes.
8. Select Actions > NTP service > Start.

9. Verify that NTP service is now running and the clock is now set to approximately the correct time.

# The NTP server time may vary slightly from the host time.

VMware vCenter 6.5 Ul

The procedures in the following subsections provide detailed instructions for installing the VMware vCenter
6.5 U1 Server Appliance in an environment. After the procedures are completed, a VMware vCenter Server
will be configured.
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Build the VMware vCenter Server Appliance

The VCSA deployment consists of 2 stages: install and configuration. To build the VMware vCenter virtual
machine, complete the following steps:

1. Locate and copy the VMware-VCSA-all-6.5.0-5973321.is0 file to the desktop of the management work-
station. This ISO is for the VMware vSphere 6.5 Ul vCenter Server Appliance.

2. Using ISO mounting software, mount the ISO image as a disk on the management workstation. (For ex-
ample, with the Mount command in Windows Server 2012).

3. In the mounted disk directory, navigate to the vcsa-ui-installer > win32 directory and double-click in-
staller.exe. The vCenter Server Appliance Installer wizard appear

vm VvCenter Server Appliance 6.5 Installer @ English

Install
Install a new vCenter Server Appliance or Platform Services Controller Appliance

Upgrade

Upgrade an existing vCenter Server Appliance

Migrate

Migrate from an existing vCenter Server for Windows to a vCenter Server Appliance

Restore
Restore from a previously created vCenter Server Appliance backup

4. Click Install to start the vCenter Server Appliance deployment wizard.
5. Click Next in the Introduction section.

6. Read and accept the license agreement and click Next.
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7.

Install - Stage 1: Deploy appliance

v 1 Introduction

2 End user license agreement

3 Select deployment type

4 Appliance deployment target

5 Setup appliance VM

6 Select deployment size

7 Select datastore

8 Configure network settings

9 Ready to complete stage 1

End user license agreement
Read and acceptthe following license agreement.

VMWARE END USER LICENSE AGREEMENT

PLEASE NOTE THAT THE TERMS OF THIS END USER LICENSE AGREEMENT SHALL GOVERN YOUR USE OF
THE SOFTWARE, REGARDLESS OF ANY TERMS THAT MAY APPEAR DURING THE INSTALLATION OF THE
SOFTWARE.

IMPORTANT-READ CAREFULLY: BY DOWNLOADING, INSTALLING, OR USING THE SOFTWARE, YOU (THE
INDIVIDUAL OF. LEGAL ENTITY) AGREE TO BE EOUND BY THE TERMS OF THIS EMD USER LICENSE
AGREEMENT ("EULA"). IFYOU DO NOT AGREE TO THE TERMS OF THIS EULA, YOU MUST NOT DOWNLOAD,
INSTALL, OR USE THE SOFTWARE, AND YOU MUST DELETE OR RETURN THE UNUSED SOFTWARE TQ THE
VENDOR FROM WHICH YOU ACQUIRED IT WITHIN THIRTY (30) DAYS AND REQUEST A REFUND OF THE
LICENSE FEE, IF ANY, THAT ¥YOU PAID FOR THE SOFTWARE.

EVALUATION LICENSE. IT You are licensing the Software for evaluation purposes, Your use of the Software is only
permitted in a non-production environment and for the period limited by the License Key. Notwithstanding any other
provision in this EULA, an Evaluation License of the Sofiware is provided “AS-15™ without indemnification, support or
warranty of any kind, expressed or implied.

1. DEFINITIONS.

[# | accept the terms ofthe license agreement.

In the “Select deployment type” section, select Embedded Platform Services Controller.
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Install - Stage 1: Deploy appliance

Select deployment type

1 Infroduction
v Select the deployment type you want to configure on the appliance.

7 ZEn R TR I e For mare information on deployment types, refer to the vSphere 6.5 documentation.

3 Select deployment type

Embedded Platform Services Controller Applance

Ehvpkan=deninamEatiael ® vCenter Server with an Embedded
Platform Services Controller Conirolter

5 Setup appliance VM vCenter
Server

6 Select deployment size

7 Select datastore
External Platform Services Controller Applance

& Configure network setlings
() Platform Services Controller Platform Services
Controller

9 Ready to complete stage 1 . )
() wCenter Server (Requires External
Platform Services Controller)

Appliance Appliance

vCenter
Server

8. Inthe “Appliance deployment target”, enter the ESXi host name or IP address, User name and Password.
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Install - Stage 1: Deploy vCenter Server with an Embedded Platform Services Controller

Appliance deployment target
Specify the appliance deployment target seftings. The target is the ESXi host or vCenter Server instance on which the
appliance will be deployed.

v 1 Introduction

+ 2 End userlicense agreement

+ 3 Select deployment type ESXi hostor vCenter Server name | 10.1.156.25 | ;

4 Appliance deployment target HTTPS port | 443

5 Setup appliance VM

User name | root

6 Select deployment size

Password |

7 Select datastore

8 Configure network settings

9 Ready to complete stage 1

9. Click Yes to accept the certificate.

10. Enter the Appliance name and password details in the “Set up appliance VM” section. Click Next.

135



VMware vSphere 6.5 Ul Setup

Install - Stage 1: Deploy vCenter Server with an Embedded Platform Services Controller

Set up appliance VM

1 Introduction
. Specify the WM settings for the appliance to be deployed.

2 End user license agreement

VM name |\rc

3 Select deployment type

Root password

4 Appliance deployment target

5 Setup appliance VM Confirm root password

6 Select deployment size

7 Select datastore

8 Configure network setftings

9 Ready to complete stage 1

11. In the “Select deployment size” section, Select the deployment size and Storage size. For example, “Ti-
ny.”

12. Click Next.
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Installer

Install - Stage 1: Deploy vCenter Server with an Embedded Platform Services Controller

Select deployment size

1 Introduction
& Select the deployment size for this vCenter Server with an Embedded Platform Services Controller.

B For more information on deployment sizes, refer to the vSphere 6.5 documentation.

3 Select deployment type Deployment size Tiny v

4 Appliance deployment target Storage size Default v

5 Setup appliance VM Resources required for different deployment sizes

6 Select deployment size Deployment Size vCPUs Memory (GB) Storage (GB} Hosts (upto) VMs (up to}

Tiny 2 10 250 10 100
7 Select datastore
Small 4 16 290 100

8 Configure network settings Medium 8 24 425

9 Ready to complete stage 1 Large 16 32 640

X-Large 45 980

13. Select the infra_datastore_1. Click Next.
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Install - Stage 1: Deploy vCenter Server with an Embedded Platform Services Controller

Select datastore

1 Introduction
<~ Select the storage location for this vCenter Server with an Embedded Platform Services Controller.

2 End user license agreement
Mame T  Type Y | Capacity T Freevw T | Provisio._.. Y Thin Provisioning
3 Select deployment iype infra_datasto..  NFS 500 GB 49999 GB 5.99 VB true
infra_swap MFS 100 GB 100 GB 352 KB frue
datastore 7.5GB 347 GB 4.03GB

4 Appliance deployment target

5 Setup appliance VM

6 Select deployment size

T Select datastore

8 Configure network setlings

9 Ready to complete stage 1

14. In the “Network Settings” section, configure the below settings:
a. Choose a Network: IB-MGMT Network
b. IP version: IPV4
c. IP assignment: static
d. System name: <vcenter-fqdn>
e. |IP address: <vcenter-ip>
f. Subnet mask or prefix length: <vcenter-subnet-mask>
g. Default gateway: <vcenter-gateway>
h. DNS Servers: <dns-server>
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Install - Stage 1: Deploy vCenter Server with an Embedded Platform Services Controller

Configure network settings
Configure network settings for this vCenter Server with an Embedded Platform Services Controller.

2 End user license agreement
Network IB-MGMT-Network v | (i

3 Select deployment type

1 Introduction

IP version IPvd v

IP assignment

4 Appliance deployment target

5 Setup appliance VM

System name ;\rc_vikings.cisco.com

6 Select deployment size

7 Select datastore IP address | 10.1.156.100

& Configure network settings
Subnet mask or prefix lemgth |255_255_255_[]

9 Ready to complete stage 1

Default gateway | 10.1.156.1

DNS servers | 192.168.156.9

15. Click Next.
16. Review all values and click Finish to complete the installation.

17. The vCenter appliance installation will take a few minutes to complete.
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Installer

Install - Stage 1: Deploy vCenter Server with an Embedded Platform Services Controller

O You have successfully deployed the vCenter Server with an Embedded

Platform Services Controller.

| | 100%

Deployment complete

To proceed with stage 2 of the deployment process, appliance setup, click Continue.

If you exit, you can continue with the appliance setup at any time by logging in to the vCenter Server Appliance
Management Interface hitps/ivc vikings.cisco.com: 5480/

18. Click Continue to proceed with stage 2 configuration.
19. Click Next.
20. In the Appliance Configuration, configure the below settings:

a. Time Synchronization Mode: Synchronize time with NTP servers.
b. NTP Servers: <ntp_server_ip>

c. SSH access: Enabled.
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Installer

Install - Stage 2: Set Up vCenter Server Appliance with an Embedded PSC

+ 1 Infroduction Appliance configuration

Time synchronization mode | Synchronize time with NTP servers v

2 Appliance configuration

NTP servers (comma-separated list) 10.1.156.4,10.1.156 5
3 S50 configuration

4 Configure CEIP

5 Ready to complete SSH access Enabled v

21. Click Next.

22. Complete the SSO configuration as shown below:
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Install - Stage 2: Set Up vCenter Server Appliance with an Embedded PSC

« 1 Infroduction SS0 configuration

+ 2 Appliance configuration 550 domain name | vsphere. local

S50 user name administrator
3 550 configuration

S50 password

4 Configure CEIP

Confirm password

5 Ready to complete

Site name I\rikingsl

In vCenter 6.5, joining a vCenter with embedded PSC to an external PSC is not supported. For more information on
recommended vCenter and PSC topologies, refer to the vCenter Server documentation.

23. Click Next.

24. If needed, select Join the VMware’s Customer Experience Improvement Program (CEIP).
25. Click Next.

26. Review the configuration and click Finish.

27. Click OK.
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Complete

° You have successfully setup this Appliance

Complete

vCenter Server appliance setup has been completed successfully. Click on one ofthe links below, to manage the
appliance. Press close to exit.

vSphere Web Client hitps:/vc.vikings.cisco.com:44 3/vsphere-client/

Appliance Getting Started Page hitps:ivcvikings.cisco.com:443

Set Up VMware vCenter Server

To set up the VMware vCenter server, complete the following steps:

1. Using a web browser, navigate to https://<vcenter-ip>/vsphere-client
2. Click Download Enhanced Authentication Plugin. Install the same by double clicking the downloaded file.

3. Log in using the Single Sign-On username and password created during the vCenter installation.
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vmware: vSphere Web Client fi= U | Administrator@VSPHERELOCAL » | Help ~
| MNavigator X @vc.vikings.cisoo.oun‘ fa 9 9 & &k | {SAcons v
Bac = J Getting Started ‘ Summary Monitor Configure Permissions Datacenters Hosts & Clusters VMs Datastores Networks Linked vCenter Server Systems  Extensions  Update Manager
] 8 )

=7 vcvikings.cisco.com

u o Create Datacenter Add Host Add Virtual Machine Complete set-up
Welcome to vCenter Server

You are ready to set up vCenter Server. The \ Y
first step is creating a datacenter. % |

A datacenter contains all inventory objects S
such as hosts and vitual machines. You x
might need only one datacenter. Large
companies might use multiple datacenters to
represent organizational units in their
enterprise.

Explore Further

To get started click Create Datacenter
Learn more about folders

i3 Create Datacenter Learn about datacenters

4. Click “Create Datacenter” in the center pane.
5. Type “FlexPod-DC” in the Datacenter name field.

6. Click OK.

New Datacenter (Z) »

Datacenter name: FlexPod-DC

Location: [E vcvikings.cisco.com

[ 0K ][ Cancel

7. Right-click the data center FlexPod-DC in the list in the center pane. Click New Cluster.
8. Name the cluster FlexPod-Management.
9. Check the box to turn on DRS. Leave the default values.

10. Check the box to turn on vSphere HA. Leave the default values.
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4] New Cluster 2 M
Mame |FIexF'nd—ru1anagement
Location FlexPod-DC
-~ DRS [w/] Turn ON
Automation Level | Fully automated | \
Migration Threshaold Conservative f——— Aggressiva
- yEphere HA [w] Turn ON
Host Monitoring [v] Enable host monitoring
Admission Control [v] Enable admission contral
= WM Monitoring
Wi Monitoring Status r
o . | Disabled |
Cwerrides for individual YMs can be setfrom the VM
Cwerrides page from Manage Settings area.
» EVC | Disable |~ |
b Virtual SAN ] Turn ON
OK ] [ Cancel ]

11. Click OK to create the new cluster.

12. In the left pane, double click the “FlexPod-DC”.

13. Click Clusters.

14. Under the Clusters pane, right-click FlexPod-Management and select Settings.

15. Select Configuration > General in the list on the left and select Edit to the right of General.

16. Select Datastore specified by host and click OK.

145



VMware vSphere 6.5 Ul Setup

Swap file location

O Virtual machine directory
Store the swap files in the same directory as the virtual machine

@ Datastore specified by host
Store the swap files in the datastore specified by the hostto be used
for swap files. If not possible, store the swap files in the same
directory as the virtual machine.

[ﬁ Using a datastore that is not visible to both hosts during vMotion might
affect the vMotion perfarmance for the affected virtual machines.

17. On the left, right-click FlexPod-Management and click Add Host.

18. In the Host field, enter either the IP address or the FQDN name of one of the VMware ESXi hosts. Click
Next.

19. Type root as the user name and the root password. Click Next to continue.
20. Click Yes to accept the certificate.

21. Review the host details and click Next to continue.

22. Assign a license or leave in evaluation mode and click Next to continue.
23. Click Next to continue.

24. Click Next to continue.

25. Review the configuration parameters and click Finish to add the host.
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Resources destination FlexFod-Management

Back Finish Cancel

[ L Add Host ? »1
' 1 Mame and location Name esxi-01.vikings cisco.com
" 2 Connecfion setings Version Aboutinfo.embeddedEsx fullName
+ 3 Hostsummary License License 2
~ 4 Assign license Networks IB-MGMT Network
~ 5 Lockdown mode Datastores datastore1 (3)
infra_datastore_2
v 6 Resource pool infra_datastore_1
v Lockdown mode Disabled

26.

Repeat the steps 17 to 25 to add the remaining VMware ESXi hosts to the cluster.

.

Two VMware ESXi hosts will be added to the cluster.

Add AD User Authentication to vCenter (Optional)

If an AD Infrastructure is set up in this FlexPod environment, you can setup in AD and authenticate from
vCenter. To add an AD user authentication, complete the following steps:

1.

In the AD Infrastructure, using the Active Directory Users and Computers tool, setup a Domain Adminis-
trator user with a user name such as flexadmin (FlexPod Admin).

Connect to https://<vcenter-ip>, and select Log in to vSphere Web Client.

Log in as Administrator@vsphere.local (or the SSO user set up in vCenter installation) with the corre-
sponding password.

Navigate to Home. In the center pane, select System Configuration under Administration.

On the left, select Nodes and under Nodes select the vCenter.

In the center pane, select the manage tab, and within the Settings select Active Directory and click Join.
Fill in the AD domain name, the Administrator user, and the domain Administrator password. Click OK.

On the left, right-click the vCenter and select Reboot.
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9. Input a reboot reason and click OK. The reboot will take approximately 10 minutes for full vCenter initial-
ization.

10. Log back into the vCenter Web Client.
11. In the center pane, select System Configuration under Administration.
12. On the left, select Nodes and under Nodes select the vCenter.

13. In the center pane under the Manage tab, select Active Directory. Make sure your Active Directory Do-
main is listed.

14. Navigate back to the vCenter Home.

15. In the center pane under Administration, select Roles.

16. On the left under Single Sign-On, select Configuration.

17. In the center pane, select the Identity Sources tab.

18. Click the green + sign to add an Identity Source.

19. Select the Active Directory (Integrated Windows Authentication) ldentity source type.
20. Your AD domain name should be filled in. Leave Use machine account selected and click OK.
21. Your AD domain should now appear in the Identity Sources list.

22. On the left, under Single Sign-0On, select Users and Groups.

23. In the center pane, select your AD domain for the Domain.

24. Make sure the FlexPod Admin user setup in step 1 appears in the list.

25. On the left under Administration, select Global Permissions.

26. Select the Manage tab, and click the green + sign to add a User or Group.

27. In the Global Permission Root - Add Permission window, click Add.

28. In the Select Users/Groups window, select your AD Domain.

29. Under Users and Groups, select either the FlexPod Admin user or the Domain Admins group.

# The FlexPod Admin user was created in the Domain Admins group. The selection here depends on
whether the FlexPod Admin user will be the only user used in this FlexPod or you would like to add
other users later. By selecting the Domain Admins group, any user placed in that group in the AD do-
main will be able to login to vCenter as an Administrator.

30. Click Add, then click Check names to verify correctness of the names. Click OK to acknowledge the cor-
rectness of the names.
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31.

32.

33.

34.

Click OK to add the selected User or Group.

Verify the added User or Group is listed under Users and Groups and the Administrator role is assigned.
Click OK.

Log out and log back into the vCenter Web Client as the FlexPod Admin user. You will need to add the

domain name to the user, for example, flexadmin@domain.

Cisco UCS Manager Plug-in for VMware vSphere Web Client

The Cisco UCS Manager Plug-in for VMware vSphere Web Client allows administration of UCS domains
through the VMware’s vCenter administrative interface. The capabilities of the plug-in include:

View Cisco UCS physical hierarchy

View inventory, installed firmware, faults, power and temperature statistics
Map the ESXi host to the physical server

Manage firmware for Cisco UCS B and C series servers

View VIF paths for servers

Launch the Cisco UCS Manager GUI

Launch the KVM consoles of Cisco UCS servers

Switch the existing state of the locator LEDs

The installation is only valid for VMware vCenter 5.5 or higher, and will require revisions of .NET Framework

4.5

and VMware PowerCLI 5.1 or greater.

Cisco UCS Manager Plug-in Installation

To begin the plug-in installation on a Windows system that meets the previously stated requirements,
complete the following steps:

1.

Download the plugin and registration tool from:
https://software.cisco.com/download/release.html?mdfid=286282669&catid=282558030&softwareid=2

86282010&release=2.0.2

Place the downloaded ucs-vcplugin-2.0.2.zip file onto the web server used for hosting the ONTAP soft-
ware and VMware ESXi ISO.

Unzip the Cisco_UCS_Plugin_Registration_Tool_1 1 3.zip and open the executable file within it.
Leave Register Plugin selected for the Action, and fill in:

a. |IP/Hostname
b. Username

c. Password
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d. URL that plugin has been uploaded to

This tool registers funregisters the Cisco UCS Plugin for YMware vSphere Web Client

URL of the plugn location in HTTP/HTTPS server
Ex: https://10. 10. 10. 1/plugins fucs-veplugin-1.0. 1. zip
[http://10. 1. 156. 150/software bears UCS fucs veplugin-2.0.2.2ip

5. A pop-up will appear explaining that ‘allowHttp=true’ will need to be added to the webclient.properties
file on the VCSA in the /etc/vmware/vsphere-client directory.
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information .

You have provided a HTTP URL. For Cisco UCS Plugin to download
through HTTP during vSphere Web Client launch, "allowHttp=true’
must be added in file ‘webclient.properties’ located in below path

File location for vSphere Web Client 6.x and above releases:
Windows: C\\ProgramData\\VMware\\vCenterServer\\cfg
\\vsphere-client

vCenter Server Appliance: /etc/vmware/vsphere-client

File location for vSphere Web Client 5.x releases:
Windows: C\\ProgramData\\VMware\\vSphere Web Client
vCenter Server Appliance: /var/lib/vmware/vsphere-client

OK

6. Take care of this issue after the plugin has been registered, click OK to close the Information dialogue
box.

7. Click Submit to register the plugin with the vCenter Server Appliance.

8. To resolve the change needed for the HTTP download of the vSphere Web Client launch, connect to the
VCSA with ssh using the root account and type:

echo ‘allowHttp=true’ >> /etc/vmware/vsphere-client/webclient.properties

‘ﬁ This will add “allowHttp=true” to the end of the webclient.properties file. Make sure to use two greater
than symbols “>>” to append to the end of the configuration file, a single greater than symbol will re-
place the entire pre-existing file with what has been sent with the echo command.

9. Reboot the VCSA.

FlexPod UCS Domain Registration

Registration of the FlexPod UCS Domain can now be performed. The account used will correlate to the
permissions allowed to the plugin, admin will be used in our example, but a read only account could be used
with the plugin if that was appropriate for the environment.

To register the UCS Domain, complete the following steps:

1. Opening up the vSphere Web Client.

2. Select the Home from the Navigator or drop-down list options, and double-click the Cisco UCS icon ap-
pearing in the Administration section.
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3. Click the Register button and provide the following options in the Register UCS Domain dialogue box that
appears:
a. UCS Hostname/IP
b. Username

Password

d. Port (if different than 443)

12

e. Leave SSL selected and click the Visible to All users option

Register UC S Domain (%)
UCS Hostname/r” 192 168.156.12
Username” admin
Password®
Port® 443
SSL K4
Visible to All users )
| OK || Cancel

4. Click OK to register the UCS Domain.

Use the Cisco UCS vCenter Plugin

The plugin can now enable the functions described at the start of this section by double-clicking the
registered UCS Domain:
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vmware* vSphere Web Client fi= ¥ | Administralor@VSPHERELOCAL ~ |

Navigator  § Cisco UCS Management Center
Home | Proactive HA Registration

<4 Back
(2] Home

& Hosts and Clusters Registered UCS Domains alisdhse

Vs and Templates
£ storage

€3 Networking

[& ContentLibraries
Global Inventory Lists

Plugin Version: 2.0(2)

UCS HostnamedIP Usemame SSL Port Visible to All users Connection State

A 192.168.156.12 admin bl 443 ol 1

|:& Policies and Profiles
(@, Update Manager
I virtual Storage Console

VW VWV VYV VYV VY Y

&% Administration

[£] Tasks
[T Events

¢/ Tags & Custom Aftrib...

Register [ Edit

3, New Search >

This will disply a view of the components associated to the domain:

vmware* vSphere Web Client  #= O | Administralor@VSPHERELOCAL ~ |
Navigator X | bboas3s2 | L | {GhActons v
<4 Back ) ' Summary | Monitor Manage Related Objects
&)l Chassis [ 1] :'304-5332 - Jaﬂuﬂ;m:mzyz s
'ersion: 2(1a
@ Rack Mounts L Virtual IPv4 Address:  192.165.156.12
B Fabricinterconnects (D HA Configuration: cluster
Chassis: 1
ESXi Servers: =p 0 & 0
Non-ESXi Servers: ap 7 W 2
VMs: ]
e
CIsCco

Selecting within the chassis or rack mounts will provide a list of ESXi or non-ESXi servers to perform
operations on the following:
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nhere Web e P wratorG R =
¥ | chassis1 | (GdActons v
Summary Monitor Manage } Related Objects
— | NGRESHSaRR | £su seners
@ Rack Mounts &3 "
S =5 CreateS_ § Manage BI # Manage H.. g Disassoc. | {g}Actons ~ Q Filte -
B Fabnic interconnects m Name Mode! Vendor Assocavon Servce Profie
Chassis blade-3 UCSB-B200-M4 Cisco Systems Inc associated org-rootis-VM-
I blade-4 UCSB-B200-M4 Cisco Systems Inc associated org-rootis-VM-
blade-1 UCSE-B200-M4 Cisco Systems Inc associated org-rootiorg-FP
blade-2 UCSB-B200-M4 Cisco Systems Inc associated org-rootiorg-FF
blade-6 UCSEB-B200-M4 Cisco Systems Inc none
blade-5 UCSE-B200-M4 Cisco Systems Inc associated org-rootis-Win-
blade-& UCSE-B200-M5 Cisco Systems Inc associated Ofg-rootis-VM-
“ @ 0
[} 7 Objects [ Export 'y Copy »

In addition to viewing and working within objects shown in the UCS Plugin’s view of the UCS Domain, direct
access of UCS functions provided by the plugin can be selected within the drop-down list of hosts
registered to vCenter:

vmware* vSphere Web Client fi= Updatedat 219 PM ) | Administrator@VSPHERE.LOCAL ~ | Help
Navigator b S ﬂmmmmli%@-@ga|ﬁmons- =v
o —
4 Back Getting Started | Summary = Monitor  Config: F i VMs D NetApp Storage Systems Objects  Update Manager
J g &l = e — nx-esxi-02 flexpod.cisco.com cPU FREE: 43.00 GHz | ]
nx-ve flexpod cisco.com — .
M NXFlaxPod-BC Hypervisor: VN ors ESX, 6.5.0, 4597570 USED: §79.00 MHz CAPAGITY: 43.98 GHz
- [ln NX-FlexPod- Model: Cisco Systems Inc UCSB-B200-M3 R . .
» B A02-M5-Test Processor Type:  Intel(R) Xeon(R) GPU E5-2660 v2 @ 2.206Hz Mo EE mos30GE
~ [J] FlexPod-Management — Logical Processors: 40 USED: 51.83 GB CAPACITY: 25503 GE
[@ mx-esxi-01.flexpod.cisc... NICs: 2 STORAGE FREE: 750.95 GE
[@ Actions - nx-esxi-02 flexpod cisco.com HMEpchines: 6 USED: 226.55 GB CAPACITY: 1.08 TE
§5 MS-SCOM :ew Virtual Machine » Connected
Gy Ms-scuM SV VAP ' 27 days
Nex D 00
% MS-3MI-8
& Ms-smi-g| @ Deploy OVF Template
(h MS-Test VI Connection v b
Gy meve Maintenance Mode » L o1 | » Configuration |
(& n-vse Power e o
& Toolbox_Li Cerificales N 0| | » Custom Attributes |
G Turbonomi ary Description Atribute Value
Storage » L
s UCSPM This list is empty. AutoDeploy.Ma...
3 Add Networking |
d
Export System Logs...
Assign ve Edit_)
Reconfigure for vSphere HA atfif | i
[Eg Assign License... l ol | = Update Manager Compliance |
Seftings nagement Status -
E
Move To.. Scan _ Detailed Status
Tags & Custom Aftributes o
Add Permission bb04-5248
Alarms 3 172
Remove from Inventory 182215(2-c958-11e6-0000-000000480002
Dis: ate Host org-rootfls-VM-Host-Infra-02 =
All Cisco UCS Plugin Actions ;ﬁ Create Service Profile for Server &
AlliCenter Orchestrator plugin Actions »| &1 panage BIOS Policy
_— W Metapp VSC » R
| Viewed | Update Manager » e
@ nresx-02nexpod.c - @ Manage Host Fimware Pack Intiator Queuad For Start Tims
[ meessi-01 flexpod cisco com Drm.ExectteVMotionLRO.label =& Disassociats Service Profile ompleted System 10ms | TATR017 22121 F

ﬁ n-esxi-08 flexpod cis co com

L umiLmd
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# The current 2.0.2 release of the Cisco UCS Manager Plug-in for VMware vSphere Web Client does not sup-
port Cisco UCS Plugin Actions within the vSphere Web Client on M5 servers. A future release of the plugin
should address this issue.

For full installation instructions and usage information, please refer to the Cisco UCS Manager Plug-in for
VMware vSphere Web Client User Guide.

FlexPod VMware vSphere Distributed Switch (vDS)

This section provides detailed procedures for installing the VMware vDS on the FlexPod ESXi Management
Hosts.

In the Cisco UCS setup section of this document one set of vNICs (Infra-A and B) was setup. The vmnic
ports associated with the Infra-A and B vNICs will be migrated to VMware vDS in this procedure. The critical
infrastructure VLAN interfaces and vMotion interfaces will be placed on the vDS.

An IB-Mgmt VLAN and a VM-Traffic VLAN port group will be added to the vDS. Any additional VLAN-based
port groups added to the vDS would need to have the corresponding VLANs added to the Cisco UCS LAN
cloud, to the Cisco UCS Infra-A and B vNIC templates, and to the Cisco Nexus 9K switches and vPC peer-
link interfaces on the switches.

Configure the VMware vDS in vCenter

VMware vSphere Web Client
To configure the vDS, complete the following steps:

1. After logging into the VMware vSphere Web Client, select Networking under the Home tab.

2. Right-click the FlexPod-DC datacenter and select Distributed Switch > New Distributed Switch.
3. Give the Distributed Switch a descriptive name and click Next.

4. Make sure Distributed switch: 6.5.0 is selected and click Next.

5. Change the Number of uplinks to 2. If VMware Network 1/0 Control is to be used for Quality of Service,
leave Network 1/0 Control Enabled. Otherwise, Disable Network 1/0 Control. Enter VM-Traffic for the
Port group name. Click Next.

6. Review the information and click Finish to complete creating the vDS.

7. On the left, expand the FlexPod-DC datacenter and the newly created vDS. Select the newly created
vDS.

8. Select the VM-Traffic port group. In the center pane, select the Edit distributed port group settings icon.
The Edit button can be used to change the number of ports in the port group to a number larger than the
default of 8. All of the other properties of the port group can also be changed under Edit.

9. Select the vDS on the left. Click the Edit distributed switch settings icon on the right.

10. On the left in the Edit Settings window, select Advanced.
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11. Change the MTU to 9000. The Discovery Protocol can optionally be changed to Link Layer Discovery
Protocol and the Operation to Both. Click OK.

i@ VDS - Edit Settings

General

MTU (Bytes): 9000 =
Advanced
R ... eing moce: Basic -
Discovery protocol
Type: Link Layer Discovery Protacal | =
Operation: Both v
Administrator contact
Name:
Other details:

OK Cancel |

12. Three port groups will be created for infrastructure use, first being for the management vmkernel. On
the left, right-click the vDS, select Distributed Port Group, and select New Distributed Port Group... with-
in the drop-down list options of Distributed Port Group.

13. For the first port group used for vMotion on the left, right-click the vDS, select Distributed Port Group,
and select New Distributed Port Group... within the drop-down list options of Distributed Port Group.

14. Enter vMotion as the name and click Next.

15. Set the VLAN type to VLAN, enter the VLAN used for vMotion, click the Customize default policies con-
figuration check box, and click Next.

16. Leave the Security options set to Reject and click Next.
17. Leave the Ingress and Egress traffic shaping options as Disabled, and click Next.

18. Select Uplink 1 from the list of Active uplinks, and click the down arrow icon twice to place Uplink 1 in
the list of Standby uplinks.

156



VMware vSphere 6.5 Ul Setup

&, Mew Distributed Port Group L kb
" 1 Selectname and location Teaming and tailower
Coantrols load balancing, nebwork Rilune deteclion, Switches notification, failback, and uplink Tailover ander
" 2 Configure setings
3 Configure policies Load balancing Riouts based on originating virual port -
" 3@ Securify _
Mebwork failure defection Link stabus only =
' ib Traffic shaping
Motify switches Yas v
Failback Yes -
3d Moniloring
Faillover order
s B J
Active uplinks
[l Uplink 2
Standby uplinks
[ Uplink 1
Unused uplinks
Select active and standby uplinks. During a failover, standby uplinks activate in the order specified above
Back Next Cancel

19. Click Next.

20. Leave NetFlow Disabled and click Next.

21. Leave Block all ports set as No and click Next.

22. Leave the additional settings dialogue options as they are shown and click Next.

23. Confirm the options and click Finish to create the port group.

24. For the second port group used for Infrastructure In-Band Management on the left, right-click the vDS,
select Distributed Port Group, and select New Distributed Port Group... within the drop-down list options
of Distributed Port Group.

25. Enter IB-MGMT as the name and click Next.

26. Set the VLAN type to VLAN, enter the VLAN used for In-Band Management, click the Customize default
policies configuration check box, and click Next.

27. Leave the Security options set to Reject and click Next.

28. Leave the Ingress and Egress traffic shaping options as Disabled, and click Next.

29. Select Uplink 2 from the list of Active uplinks, and click the down arrow icon twice to place Uplink 2 in
the list of Standby uplinks. This step is pinning In-Band Management traffic to UCS Fabric A.

30. Click Next.
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31. Leave NetFlow Disabled and click Next.

32. Leave Block all ports set as No and click Next.

33. Leave the additional settings dialogue options as they are shown and click Next.
34. Confirm the options and click Finish to create the port group.

35. Repeating this same procedure, a second time for the Infrastructure NFS vmkernel. On the left, right-
click the vDS, select Distributed Port Group, and select New Distributed Port Group... within the drop-
down list options of Distributed Port Group.

36. Enter Infra-NFS as the name and click Next.

37. Set the VLAN type to VLAN, enter the VLAN used for NFS, and click Next.

38. Click Finish to create the port group.

39. On the left, right-click the vDS and select Add and Manage Hosts.

40. Make sure Add hosts is selected and click Next.

41. Click the green + sign to add hosts. Select the two FlexPod Management hosts and click OK. Click Next.

42. Leave Manage physical adapters and Manage VMkernel adapters selected. Select Migrate virtual ma-
chine networking and click Next.

43. Select vmnicl on the first host and click Assign uplink. Select Uplink 2 and click OK. Repeat this process
to assign vmnic1(Uplink2) from both hosts to the vDS.

‘ﬂ It is important to assign vmnicl (UCS Fabric B) to Uplink2 in the vDS. This allows the port groups to be
pinned to the appropriate fabric.
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[ Add and Manage Hosts

v 1 Selecttask

Manage physical network adapters

" 3 Selectnetwork adapter tasks

Add or remove physical netwark adapters to this distributed switch.

" 2 Selecthosts

& Azsign uplink @™ Resetchanges ¢ View setings

HostPhysical Metwork Adapters 14 InUse by Switch Uplink

4 Manage physical network
adapters

o N VMkemel network + 9 esxi-01.vikings.cisco.com

~ On this switch

vmnici (Assigned) - Uplink 2
On other switches/unclaimed
vmnicO

es5xi-02 vikings cisco.com

vSwitch0 -
~ On this switch

vmnici (Assigned) - Uplink 2

= On other switches/unclaimed

vmnic0 vSwitch0 -

Back Next

Uplink Port Group

vDS-DVUplinks-21

vDS-DVUplinks-21

Cancel

44,

45.

46.

47.

48.

49.

50.

51.

Click Next.

Select vmkO on the first host and click Assign port group.
Select the IB-MGMT destination port group and click OK.
Select vmk1 on the first host and click Assign port group.
Select the vMotion destination port group and click OK.
Select vmk2 on the first host and click Assign port group.
Select the Infra-NFS destination port group and click OK.

Repeat this process for the second ESXi host.
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[ Addand Manage Hosts

+/ 1 Selecttask
v 2 Selecthosts

+ 3 Selectnetwork adapter tasks

« 4 Manage physical network
adapters

Manage ViMkemel network

J adapiers

6 Analyze impact

7 Migrate VM networking

8 Ready

complete

b

Manage VWkemel network adapters

Manage and assign VMkernel network adapters to the distributed switch.

.ﬁssign port group 7 Editadapter
HostMkemel Network Adapters 14 InUse by Switch
v esxi-01.vikings.cisco.com

~ On this switch

wmk0 (Reassigned) vSwitchd
= vmk1 (Reassigned) vSwitch0
vmk2 (Reassigned) vSwitch0

On other switches
- esx-02 vikings .cisco.com

~ On this switch

wmk0 (Reassigned) vSwitch0
B8 vmk1 (Reassigned) vSwitch0
vmlk2 (Reassigned) vSwitch0

On other switches

" Resetchanges @ View setiings

Source Port Group Destination Port Group
Management Netwark IB-MGMT
VMEernel-vMotion vMotion
VMEkernel-Infra-NFS Infra-NFS
Management Netwaork IB-MGMT
VMkernel-vMotion vMotion
VMkernel-Infra-NFS Infra-NFS
Back Next

Cancel

52. Confirm the 3 VMkernel adapters on each host have valid Destination Port Groups, and Click Next.

53. Click Next after confirming there is no impact detected in the Analyze impact screen.

54. In the Migrate VM networking window, expand the vCenter VM and select Network adapter 1.

55. Click Assign port group, select the IB-MGMT port group and click OK.
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[ Add and Manage Hosts

< L«

<

1 Selecttask
2 Selecthosts

3 Select network adapter fasks

Manage physical network
adapters

Manage VMKkemel network
adapters

4

5

6 Analyze impact

T Migrate VM networking

2 Readyto complete

Migrate VM networking
Selectvirtual machines or network adapters to migrate to the distributed switch,

Assign VMs or network adapters to a destination port group to migrate them. Press and hold down the CTRL key, and then click the
VMs to select multiple items.

f-»ss gn port group M Resetchanges @ View settings

Host\irtual Machine/Metwork Adap... 1 4 NIC Count Source Port Group Destination Port Group
- ﬁ esxi-01.vikings.cisco.com
- &1 ve 1
Network adapter 1 IB-MGMT Network IB-MGMT
Back Next Cancel

56.

57.

58.

59.

60.

61.

62.

63.

64.

65.

Click Next.

Click Finish to complete adding the two ESXi hosts to the vDS.

Select Hosts and Clusters and select ESXi Host 1.

Under the Configure tab, in the pane on the left, select Virtual switches.

In the center pane under Virtual switches, select vSwitchO.

Under Virtual switches, select the red X icon to delete vSwitchO. Click Yes to confirm.

Under Virtual switches, select the vDS.

Under Virtual switches, select the third icon to Manage the physical network adapters connected to the

virtual switch.

Click the green + icon to add an uplink.

Make sure vmnicO and Uplink 1 are selected and click OK.
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[#3 esxi-01.vikings.cisco.com - Manage Physical Network Adapters for vD$ (7)
Uplink ports: | All | Properties CDP LLDP
x Adapter Cisco Systems -
Uplink Port Inc Cisco VIC
— Ethernet MIC
in
P - Mame wmnico
vimnic
Location FCI0000:06:00.0
Uplink 2 Driver nenic
vmnic1
Status
Status Connected
Configured speed, Duplex 40000 Mb, Full
Duplex
Actual speed, Duplex 40000 Mb, Full
Duplex
Metworks Mo networks
Metwork /0 Control
Status Allowed
DirectPath 1O
Status Mot supported |7
EA|
OK ] [ Cancel l
A

66. Click OK to complete adding the adapter to the vDS on the host.

67. Repeat this process to add vmnicO to the vDS on ESXi Host 2.
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_________________________________________________________________________________________________________________________________|

NetApp Virtual Storage Console 6.2.1 Deployment Procedure

This section describes the deployment procedures for the NetApp Virtual Storage Console (VSC).

Virtual Storage Console 6.2.1P1 Pre-installation Considerations

The following licenses are required for VSC on storage systems that run ONTAP 9.1:

Protocol licenses (NFS)

NetApp FlexClone® (for provisioning and cloning only)

NetApp SnapRestore® (for backup and recovery)

e The NetApp SnapManager® Suite

Install Virtual Storage Console 6.2.1P1
To install the VSC 6.2.1P1 software, complete the following steps:

1. Build a VSC VM with Windows Server 2012 R2, 4GB of RAM, two CPUs, and one virtual network inter-
face in the IB-MGMT Network port group. The virtual network interface should be a VMXNET 3 adapter.

2. Bring up the VM, install VMware Tools, assign the IP address and gateway in the IB-MGMT subnet, and
join the machine to the Active Directory domain.

3. Activate Adobe Flash Player in Windows Server 2012 R2 by installing Desktop Experience under the User
Interfaces and Infrastructure Feature on the VM.

4. |Install all Windows updates on the VM.
5. Log in to the VSC VM as the FlexPod Admin user using the VMware console.

6. From the VMware console on the VSC VM, download the x64 version of Virtual Storage Console 6.2.1P1
from the NetApp Support site.

7. Right-click the VSC-6.2.1P1-win64.exe file downloaded in step 6 and select Run as Administrator.
8. Select the appropriate language and click OK.
9. On the Installation wizard Welcome page, click Next.

10. Select the checkbox to accept the message and click Next.

# The Backup and Recovery capability requires an additional license.

11. Click Next to accept the default installation location.
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% NetApp @ Virtual Storage Console 6.2.1P1 for VMware vSphere - |... -

Destination Folder

Click Mext to install to this folder, or dick Change to install to a different folder.

Install MetApp® Virtual Storage Console 6.2, 1P1 for YMware vSphere to:

‘_..-/ C:\Program Files\MetAppiirtual Storage Consolel,

L}
[
3
%
m
=

< Back ” Mext = | | Cancel

12. Click Install.

% NetApp @ Virtual Storage Console 6.2.1P1 for VMware vSphere - |... -

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.
If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Virtual Storage Console for VMware vSphere must be registered with vCenter for the plugin
to function. You may register once installation/upgrade completes or you can register at
any time by visiting the following URL:

https:/ flocalhost:8143 /Register.html

L}
[
3
%
m
=

< Back || Install | | Cancel

13. Click Finish.
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Register Virtual Storage Console with vCenter Server

To register the VSC with the vCenter Server, complete the following steps:

1. A browser window with the registration URL opens automatically when the installation phase is com-
plete. If the URL does not open automatically, open https://localhost:8143/Redqister.html in Internet Ex-
plorer.

2. Click Continue to This Website (Not Recommended).
3. In the Plug-in Service Information section, select the local IP address of the VSC VM.

4. In the vCenter Server Information section, enter the host name or IP address, the user name (FlexPod
admin user or root), and the user password for the vCenter Server. Click Register to complete the regis-
tration.

vSphere Plugin Registration

To register the Virtual Storage Console, select the IP Address you would like to use for the
plugin and provide the vCenter Server's IP address and port along with a valid user name
and password.

Plugin service information

Host name or IP Address: vsc.vikings.cisco.com R4

vCenter Server information

Host mame or IP Address: vevikings.cisco.com

Port: 443

User name: administratori@vsphere.local
User password: sEERRERNS

Register |

5. Upon successful registration, the storage controller discovery automatically begins.

Install NetApp NFS VAAI Plug-in
To install the NetApp NFS VAAI Plug-in, complete the following steps:

1. Download the NetApp NFS Plug-in 1.1.2 for VMware .vib file from the NES Plugin Download on the
VSC VM.

2. Rename the downloaded file NetAppNasPlugin.vib.

3. Move the file to the C:\Program Files\NetApp\Virtual Storage Console\etc\vsc\web folder.
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SN web —_I_-':'
“ Home Share Wiew

’(_:. - 1 | . < Local Disk (C:) » Program Files » MNetfpp » Virtual Storage Console » etc b wsc » web v & | | Search web L |

‘¢ Favorites Mame - Date modified Type Size

B Desktop 14 linux_geos_timeout_190-install Disc Image File ITB KB

4 Downloads |4 linux_ges_timeout-install Disc Image File 382 KB

5| Recent places | NetAppMasPlugin.vib VIE File 361 KB

|44 solaris_gos_timeout_190-install Disc Image File 368 KB

1M This PC |4 solaris_gos_timeout-install Disc Image File 368 KB

12 windows_gos_timeout Disc Image File 34 KB

Gi_i Metwork |4 windows_gos_timeout_130 Disc Image File 3 KB

Discover and Add Storage Resources

To discover storage resources for the Monitoring and Host Configuration capability and the Provisioning and
Cloning capability, complete the following steps:

1.

Using the vSphere web client, log in to the vCenter Server as the FlexPod admin user. If the vSphere
web client was previously opened, close it and then reopen it.

In the Home screen, click the Home tab and click Virtual Storage Console.
Select Storage Systems. Under the Objects tab, click Actions > Modify.

In the IP Address/Hostname field, enter the storage cluster management IP. Enter admin for the user
name and the admin password for password. Confirm Use TLS to Connect to This Storage System is se-
lected. Click OK.

Click OK to accept the controller privileges.

Wait for the Storage Systems to update. You may need to click Refresh to complete this update.

Optimal Storage Settings for ESXi Hosts

VSC allows for the automated configuration of storage-related settings for all ESXi hosts that are connected
to NetApp storage controllers. To use these settings, complete the following steps:

1.

From the Home screen, click on vCenter > Hosts and Clusters. For each ESXi host, right-click and select
NetApp VSC > Set Recommended Values for these hosts.
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I HetApp Recommended Settings x)

[w] HBA/CMA Adapter Settings
Sets the recommended HBA timeout settings for Metdpp storage systems.

[w] MPIO Settings

Configures preferred paths for MetApp storage systems. Determines which of the available paths are
optimized paths (as opposed to non-optimized paths that traverse the interconnect cable), and sets the
preferred path to one of those paths.

[v] MFS Settings
Sets the recommended MFS Heartbeat settings for MetApp storage systems.

| OK || cancel |
2. Check the settings that are to be applied to the selected vSphere hosts. Click OK to apply the settings.
# This functionality sets values for HBAs and converged network adapters (CNAS), sets appropriate
paths and path-selection plug-ins, and verifies appropriate settings for software-based I/0O (NFS).
3. Click OK.
r Set Recommended Settings ) ﬁ
& HBACMA Adapter Settinds . Success
& MPIO Settings Success
& MNFS Settings Success
[ ok |
4. From the Home screen in the vSphere Web Client, select Virtual Storage Console.
5. On the left under Virtual Storage Console, select NFS VAAI Tools.
6. Make sure that NFS Plug-in for VMware VAIl Version 1.1.2-3 is shown.
7. Click Install on Host.
8. Select both ESXi hosts and click Install.
9. For each host for which settings were adjusted in the previous step, place the host in maintenance

mode, reboot the host, and exit maintenance mode.
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Virtual Storage Console 6.2.1P1 Provisioning Datastores

Using VSC, the administrator can provision NFS, FC or iSCSI datastore and attach it to single host or multiple
hosts in the cluster. Following steps illustrates provisioning a datastore and attach it to the cluster.

Provision NFS Datastore
To provision the NFS datastore, complete the following steps:

1. From the Home screen of the vSphere Web Client, right-click the FlexPod-Management cluster and se-
lect “NetApp VSC > Provision Datastore”.
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vmware* vSphere Web Client  f=
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Alarms » |
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l—'l

2. Enter the datastore name and select the type as NFS.

¥ Delete

3. Click Next.
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I NetApp Datastore Provisioning Wizard

@1

4 1 Name and type

2 Storage system
3 Details

4 Ready to complete

Specify the name and type of datastore you want to provision.

You will be able to selectthe storage system for your datastore in the next page of this wizard.

Mame : # | infra_MFS_datastore_1

Type : % (=) NFS (VMFS

Next

Cancel

4. Select the cluster name in the Storage system and desired SVM to create the datastore. In this example,

Infra-SVM is selected.

5. Click Next.
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I HetApp Datastore Provisioning Wizard 2 »
~ 1 Name and type
Select the storage system you want to use to provision new datastore.
" ? Storage system
3 Details The list of storage systems below is filtered by the datastore type and protocol information entered on the previous page.
4 Ready to complete vCenter Server: vevikings.cisco.com
Storage system : * | bb04-affa300 (192.168.156.60) | vll
SV * [ Infra-3Vi |~
# Unusable storage systems
Back Next Cancel

6. Enter the size of the datastore and select the aggregate name.

7. Click Next.
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I NetApp Datastore Provisioning Wizard (3) »
+" 1 Name and type

Specify details of the new datastore.
+" 2 Storage system

Thin provision
¥ 3 Details D F
4 Ready to complete Size (GB) + [100
Aggregate : * | aggr1_node01-( 6287.27 GB - Free ) | v]
[] Auto grow
Datastore cluster: [ None |v|
Back Next Cancel

8. Review the details and click Finish.

I NetApp Datastore Provisioning Wizard (7) »
" 1 Name and type
Review the summary below. Click 'Finish' to complete datastore provisioning.
v/ 2 Storage system
Pravisioning destination: FlexPod-Management
v 3 Details
Storage Capability Profile: Naone
¥d 4 Ready to complete
Target storage system: bb04-affa300
SVM: Infra-SVM
Datastore type: MFS
Datastore name: infra_MFS_datastore_1
Size (GB): 100
Thin pravision: Mo
Aggregate: aggri_node0d
Autogrow: Mo
Autogrow increment (GB): NA
Autogrow maximum size (GB): A
Datastore cluster: MNone
Back Finish Cancel
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9. Click Ok.

ﬂ The datastore will be created and mounted on all the hosts in the cluster. Click Refresh from the vSphere web
client to see the newly created datastore.

Provision FC Datastore

To provision the FC datastore, complete the following steps:

1. From the Home screen of the vSphere Web Client, right-click the FlexPod-Management cluster and se-
lect “NetApp VSC > Provision Datastore”.

2. Enter the datastore name and select the type as VMFS. For VMFS protocol, select FC/FCoE.

3. Click Next.

I HetApp Datastore Provisioning Wizard

LA

4 1 Name and type

2 Storage system
3 Details

4 Ready to complete

Specify the name and type of datastore you want to provision.

You will be able to select the storage system for your datastore in the next page of this wizard.

Mame : +# |infra_iSCSI_datastore_1
Type : * MNF3 * VMF3
WMFS Protocol : * FCIFCoE *) i3CEl

Next

Cancel

4. Select the cluster name in the Storage system and desired SVM to create the datastore. In this example,

Infra-SVM is selected.

5. Click Next.
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I HetApp Datastore Provisioning Wizard 2wl
~ 1 Name and type
Select the storage system you want to use to provision new datastore.
" ? Storage system
3 Details The list of storage systems below is filtered by the datastore type and protocol information entered on the previous page.
4 Ready to complete vCenter Server: vevikings.cisco.com
Storage system : * | bb04-affa300 (192.168.156.60) | - |
SVM * | Infra-SVM [+
# Unusable storage systems
Back Next Cancel

6. Enter the size of the datastore. Select “Create new volume” checkbox and select the aggregate name.

7. Click Next.
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I NetApp Datastore Provisioning Wizard (2)
+ 1 Name and type

Specify details of the new datastore.
' 2 Storage system

Thin provision
¥ 3 Details [ g
4 Ready to complete Size (GB): * 100

[] Create new volume

Aggregate : * | aggrl_noded2 - ( 6377.6 GB - Free ) | v‘|

Datastore cluster: | MNone | v‘|

Back Next Cancel

8. Review the details and click Finish.

I NetApp Datastore Provisioning Wizard 15: 19

+ 1 Name and type
Review the summary below. Click 'Finish' to complete datastore provisioning.
+ 2 Storage system

Provisioning destination: FlexPod-Management
v 3 Details

Storage Capability Profile: Maone
v

Target storage system: bb04-affa3no

SVM: Infra-SVM

Datastore type: WMFS

Protocol: iBCsl

Datastore name: infra_iSCSI_datastore_1

Size (GB) 100

Thin provision: Mo

Create new volume: Yes

Aggregate: aggri_nodel2

Datastore cluster: MNaone

Back Finish Cancel
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9. Click Ok.

‘ﬁ The datastore will be created and mounted on all the hosts in the cluster. Click Refresh from the vSphere web
client to see the newly created datastore

Virtual Storage Console 6.2.1P1 Backup and Recovery

Prerequisites for Use of Backup and Recovery Capability
Before you begin using the Backup and Recovery capability to schedule backups and restores of your
datastores, VMs, or virtual disk files, you must confirm that the storage systems that contain the datastores
and VMs for which you are creating backups have valid storage credentials.

‘ﬁ If you plan to leverage the SnapMirror update option, add all of the destination storage systems with valid stor-
age credentials.

Backup and Recovery Configuration
To configure a backup job for a datastore, complete the following steps:

1. From the Home screen of the vSphere Web Client, select the Home tab and click Storage.
2. On the left, expand the datacenter.

3. Right-click the datastore that you need to backup. Select NetApp VSC > Schedule Backup.

# If you prefer a one-time backup, choose Backup Now instead of Schedule Backup.

4. Type a backup job name and description. Click Next.
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M Schedule Backup (Z) M

4 1 Details

2 Opfions

. * o

3 Spanned Entities Name: Infrastructure-Daily

4 Scripts Description:

5 Schedule and Retention

6 Credentials and Alerts

7 Summary

Next Cancel
5. Select the options necessary for the backup.
I Schedule Backup (7) »
+ 1 Details
. Select the options you want to include along with this backup job.

v

3 Spanned Entities [] Initiate SnapVault update

4 Scripts [] Initiate SnapMirror update

5 Schedule and Retention

[] Perform Viiware consistency snapshot
5 Credentials and Alerts
7 Summary []Include datastores with independent disks
-
\!1) SnapVault integration in VSC is supported for Clustered Data ONTAP 8.2 or higher.
Back Next Cancel
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# For consistent VM snapshots, select Perform VMware Consistency Snapshot to make a VMware
shapshot of each VM just before the NetApp Snapshot copy is made. The VMware snapshot is then

deleted after the NetApp Snapshot copy is made.

6. Click Next on the Options screen.
7. Click Next on the Spanned Entities screen.
8. Select one or more backup scripts if available, and click Next in the Scripts screen.

M Schedule Backup

v 1 Details
Select the scripts you want to run along with this backup job.

~ 2 Options

~ 3 Spanned Entities Available Seripts Selected Scripts

- (E D

5 Schedule and Retention

Back Next Cancel

9. Select the hourly, daily, weekly, or monthly schedule and retention policy that you want for this backup
job. Click Next.
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I Schedule Backup ?) M
i I}
R Configure the schedule and retention settings for this job. i
" 2 Options i
- Schedule Daily schedule details
V3 SpamnedEntities () Hourly @ Backup will be performed daily ]
+ 4 Scripts - B |
&= Starting: 2i2rizony : - |
¥4 5 Schedule and Retention - g & 01:00 AN ~]
() Weekly =
6 Credentials and Alerts B
(_) Monthly ES
7 Summary B -
() Ondemandonly Gk
Retention
(») Maximum Days: =
() Maximum Backups: =
() Backups Mever Expire
Back Next Cancel

10. Use the default vCenter credentials or enter the user name and password for the vCenter server. Click

Next.

11. Specify any needed backup notification details. Enter an e-mail address and mail server address for re-

ceiving e-mail alerts. You can add multiple e-mail addresses by using semicolons to separate them.

Click Next.
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Email notification will be senton:  MNever

[] Run Job Now

Back Finish Cancel

I Schedule Backup (Z)
1 Details The Backup Job will be created with the following options:
" 2 Options
Mame: Infrastructure-Daily

" 3 Spanned Entities

) infra_datastare_1
WO SELEE Virtual entities to be backed up:
" 5 Schedule and Retention
" 6 Credentials and Alerts Perform this backup: Every day starting 2/27/2017 at 01:00 AM.
\, Backup retention: Maximum of 7 days

12. Review the summary page and click Finish. If you want to run the job immediately, select the Run Job
Now option and then click Finish.

13. Click OK.

Success Message

1 ) Successfully created a new backup job for the selected object.

14. You can also create other backup jobs with overlapping schedules. For example, you can create weekly
or monthly backups that overlay daily backups.

15. On the storage cluster interface, automatic Snapshot copies of the volume can now be disabled because
NetApp VSC is now handling scheduled backups. To do so, enter the following command:

volume modify -vserver Infra-SVM -volume infra datastore 1 -snapshot-policy none

16. Also, to delete any existing automatic Snapshot copies that have been created on the volume, enter the
following command:

volume snapshot show -vserver Infra-SVM -volume infra datastore 1
volume snapshot delete -vserver Infra-SVM -volume infra datastore 1 -snapshot <snapshot-name>
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# The wildcard character * can be used in Snapshot names in the previous command.
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Sample Tenant Provisioning
_________________________________________________________________________________________________________________________________|

Provision a Sample Application Tenant

This section describes a sample procedure for provisioning an application tenant. The procedure here refers
to previous sections of this document and can be used as a guide and modified as needed when
provisioning an application tenant.

1. Plan your application tenant and determine what storage protocols will be provided in the tenant. In the
architecture covered in this document, fiber channel, NFS, iSCSI, and CIFS/SMB can be provided to the
tenant. Also, plan what network VLANSs the tenant will use. It is recommended to have a VLAN for virtual
machine management traffic. One or two VLANS (iSCSI needs two if VMware RDM LUNSs or iSCSI datas-
tores will be provisioned) are also needed for each storage protocol used except fiber channel. Fiber
channel will have new storage LIFs defined with the same VSANs configured for the FlexPod Infrastruc-
ture.

2. In the Nexus switches, declare all added VLANs and configure the VM VLAN as an allowed VLAN on the
Cisco UCS port channels and the vPC peer link. Also, Layer 3 with HSRP or VRRP can be configured in
the Nexus switches to provide this VLAN access to the outside. Layer 3 setup is not covered in this
document, but is covered in the Nexus 9000 documentation. Configure the storage VLANs on the Cisco
UCS and storage port channels, and on the vPC peer link. The VM VLAN can also be added to the stor-
age port channels in order to configure the tenant SVM management interface on this VLAN.

3. In the storage cluster:
a. Create a broadcast domain with MTU 1500 for the tenant SVM management interface. Create a

broadcast domain with MTU 9000 for each tenant storage protocol except fiber channel.

b. Create VLAN interface ports on the node interface group on each node for tenant SVM management
(VM VLAN) and for the VLAN for each storage protocol except fiber channel. Add these VLAN ports
to the appropriate broadcast domains.

Create the tenant SVM and follow all procedures in that section.

o o

Create Load-Sharing Mirrors for the tenant SVM.
e. Create the FC service for the tenant SVM if fiber channel is being deployed in this tenant.
f. Optionally, create a self-signed security certificate for the tenant SVM.
g. Configure NFSv3 for the tenant SVM.
Create a VM datastore volume in the tenant SVM.
i. Create a once-a-day deduplication schedule on the VM datastore volume.

j. Iffiber channel is being deployed in this tenant, configure four FCP LIFs in the tenant SVM on the
same fiber channel ports as in the Infrastructure SVM.

k. Create an NFS LIF in the tenant SVM on each storage node.

I. Create a boot LUN in the esxi_boot volume in the Infra-SVM for each tenant VMware ESXi host.
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4.

m. Add the tenant SVM Administrator, SVM management LIF on the SVM management VLAN port, and
default route for the SVM.

In Cisco UCS, one method of tenant setup is to dedicate a VMware ESXi cluster and set of UCS servers
to each tenant. Service profiles will be generated for at least two tenant ESXi hosts. These hosts can
boot from LUNs from the esxi_boot volume in the Infra-SVM, but will also have access to FC storage in
the tenant SVM.

a. Create a Server Pool for the tenant ESXi host servers.
b. Create all tenant VLANs in the LAN Cloud.
c. Add the tenant VLANS to the DVS vNIC templates.

‘ﬂ Generate service profiles from the service profile template with the vMedia policy for the tenant ESXi
hosts. Remember to bind these service profiles to the service profile template without the vMedia pol-
icy after VMware ESXi installation.

In the Cisco MDS 9148S switches:

a. Create device aliases for the tenant ESXi host vHBAs and the FC LIFs in the tenant storage SVM.

b. Create zones for the tenant ESXi hosts with fiber channel targets from both the storage Infra-SVM
and the tenant SVM.

c. Add these zones to the Fabric zoneset and activate the zoneset.
In the storage cluster:
a. Create igroups for the tenant ESXi hosts in both the Infra-SVM and tenant SVM. Also, create an

igroup in the tenant SVM that includes the WWPNSs for all tenant ESXi hosts to support shared stor-
age from the tenant SVM.

b. InInfra-SVM, map the boot LUNs created earlier to the tenant ESXi hosts. Tenant FC storage can be
created later using either NetApp VSC or NetApp SnapDrive.

1. Install and configure VMware ESXi on all tenant host servers. It is not necessary to map in-
fra_datastore_1.

2. In VMware vCenter, create a cluster for the tenant ESXi hosts. Add the hosts to the cluster.

3. Using the vCenter Web Client, add the tenant hosts to the VMware vDS. In the VMware vDS, add
port-profiles for the tenant VLANS.

4. Back in vCenter, add in any necessary VMkernel ports for storage interfaces remembering to set the
MTU correctly on these interfaces. Mount the tenant NFS datastore on the tenant cluster if one was
created.

5. Using the NetApp VSC plugin to the vCenter Web Client, set recommended values for all tenant ESXi
hosts. Install the NetApp NFS Plug-in for VMware VAAI for all tenant hosts and reboot each host.
Optionally, create a VSC backup job for the tenant NFS datastore.

6. You can now begin provisioning virtual machines on the tenant cluster. The NetApp VSC plugin can
be used to provision both fiber channel and NFS datastores.
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Cisco UCS FCoE Direct Storage Connect Base Configuration

This FlexPod deployment will show configuration steps for both the Cisco UCS 6332-16UP and Cisco UCS
6248UP Fabric Interconnects (Fl) in a design that will support Fibre Channel over Ethernet (FCoE)
connectivity to the NetApp.

Configuration steps will be referenced for both fabric interconnects and will be called out by the specific
model where steps have differed. Additionally, four FCoE LIFs are assumed to be created on the storage
controllers to be used by these fabric interconnects.

This section contains the Cisco UCS deployment with storage FCoE ports directly connected to the Cisco
UCS fabric interconnects. Fiber Channel (FC) direct connectivity is also supported but not covered in this
procedure.

The topology will circumvent the MDS within the FCoE direct storage connect configuration, connecting each
NetApp AFF A300 controller directly to each UCS Fabric Interconnect as shown in Figure 5 below.

Figure 5 FCoE Direct Connect FlexPod with Cisco UCS 6332-16UP Fabric Interconnects
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Cabling requirements are shown in Figure 6 below. The 6332-16UP cabling is shown, as with the topology
diagram previously shown, but in both cases the 6248UP can be swapped in with port changes adjusted as

appropriate.

E116 E1f15|

Figure 6 FCoE Direct Connect FlexPod Cabling with Cisco UCS 6332-16UP Fabric Interconnect
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Perform Initial Setup of Cisco UCS 6332-16UP and 6248UP Fabric Interconnects for FlexPod
Environments

This section provides detailed procedures for configuring the Cisco Unified Computing System (Cisco UCS)
for use in a FlexPod environment. The steps are necessary to provision the Cisco UCS B-Series and C-
Series servers and should be followed precisely to avoid improper configuration.

Cisco UCS Fabric Interconnect A

To configure the Cisco UCS for use in a FlexPod environment, complete the following steps:

1.

Connect to the console port on the first Cisco UCS fabric interconnect.

Enter the configuration method: gui
Physical switch MgmtO IP address: <ucsa-mgmt-ip>
Physical switch MgmtO IPv4 netmask: <ucsa-mgmt-mask>

IPv4 address of the default gateway: <ucsa-mgmt-gateway>

Using a supported web browser, connect to <https://ucsa-mgmt-ip>, accept the security prompts, and
click the ‘Express Setup’ link under HTML.

Select Initial Setup and click Submit.
Select Enable clustering, Fabric A, and IPv4.
Fill in the Virtual IP Address with the UCS cluster IP.

Completely fill in the System setup section. For system name, use the overall UCS system name. For the
Mgmt IP Address, use <ucsa-mgmt-ip>.
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Basic Settings

Cluster and Fabric setup-

= Enable clustering
T Standalone mode
© Synchronize

Fabric Setup: & Fabric A © Fabric B

& IPvd
T IPvE

Virual IP Address: |192 -|168 . (156 .|12

System setup

Enforce strong password?: * Yes © No

System name: [bbos-6332

Admin Password: [sevesees Confirm Admin password:  [esssssse

Mgmt IP Address: [192 .[168 .[156 .[10 Mgmt IP Netmask: [as5 .[ass 255 .o
Default Gateway: ’K W [E ’F

DNS Server IP: [0 i .fise .o Domain Name : [lexpod.cisco.com

—UCS Central d

UCS Central IP: . " I 8 Shared Secret:

7. Click Submit.

Cisco UCS Fabric Interconnect B
To configure the Cisco UCS for use in a FlexPod environment, complete the following steps:

1. Connect to the console port on the second Cisco UCS fabric interconnect.
Enter the configuration method: gui
Physical switch MgmtO IP address: <ucsb-mgmt-ip>
Physical switch MgmtO0 IPv4 netmask: <ucsb-mgmt-mask>
IPv4 address of the default gateway: <ucsb-mgmt-gateway>

2. Using a supported web browser, connect to https://<ucsb-mgmt-ip>, accept the security prompts, and
click the ‘Express Setup’ link under HTML.

3. Under System setup, enter the Admin Password entered above and click Submit.

4. Enter <ucsb-mgmt-ip> for the Mgmt IP Address and click Submit.
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Cisco UCS FCoE Direct Storage Connect Setup

Log into Cisco UCS Manager

# The steps are the same between the UCS 6332-16UP and the UCS 6248UP Fabric Interconnects unless oth-
erwise noted

To log into the Cisco Unified Computing System (UCS) environment, complete the following steps:

1. Open a web browser and navigate to the Cisco UCS fabric interconnect cluster address.

# You may need to wait at least 5 minutes after configuring the second fabric interconnect for UCS
Manager to come up.

2. Click the Launch UCS Manager link under HTML to launch Cisco UCS Manager.
3. If prompted to accept security certificates, accept as necessary.
4. When prompted, enter admin as the user name and enter the administrative password.

5. Click Login to log in to Cisco UCS Manager.

Upgrade Cisco UCS Manager Software to Version 3.2(1d)

This document assumes the use of Cisco UCS 3.2(1d). To upgrade the Cisco UCS Manager software and
the Cisco UCS Fabric Interconnect software to version 3.2(1d), refer to Cisco UCS Manager Install and

Upgrade Guides.

Anonymous Reporting

To create anonymous reporting, complete the following step:

1. In the Anonymous Reporting window, select whether to send anonymous data to Cisco for improving fu-
ture products. If you select Yes, enter the IP address of your SMTP Server. Click OK.
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Anonymous Reporting

Cigco Systemns, Inc. will e collecting feature configuration and usage statistics which will be
sentto Cisco Smart Call Home server anonymously. This data helps us prioritize the features
and improvements that will most benefit our customers.

Ifyou decide to enahble this feature in future, you can do so from the "Anomyvimous Repoting”
inthe Call Home settings under the Admin tab.

Yiew Sample Data

Do you authorize the disclosure of this information to Cisco Smart CallHome?

I['-"1|’|35'|5'-'r*~1|:|

" Dont show this Message again.

Cancel

Configure Cisco UCS Call Home

It is highly recommended by Cisco to configure Call Home in Cisco UCS Manager. Configuring Call Home
will accelerate resolution of support cases. To configure Call Home, complete the following steps:

1.

2.

In Cisco UCS Manager, click Admin on the left.
Select All > Communication Management > Call Home.
Change the State to On.

Fill in all the fields according to your Management preferences and click Save Changes and OK to com-
plete configuring Call Home.

Place Cisco UCS Fabric Interconnects in Fiber Channel Switching Mode

In order to use FCOE Storage Ports for storage directly connected to the UCS fabric interconnects, the fabric
interconnects must be changed from fiber channel end host mode to fiber channel switching mode.

To place the fabric interconnects in fiber channel switching mode, complete the following steps:

1.

2.

In Cisco UCS Manager, click Equipment on the left.
Select Equipment > Fabric Interconnects > Fabric Interconnect A (primary).
In the center pane, select set FC Switching Mode. Click Yes and OK for the confirmation message.

Wait for both Fabric Interconnects to reboot by monitoring the console ports and log back into Cisco
UCS Manager.
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Add Block of IP Addresses for KVM Access

To create a block of IP addresses for in band server Keyboard, Video, Mouse (KVM) access in the Cisco UCS
environment, complete the following steps:

1. In Cisco UCS Manager, click LAN on the left.
2. Expand Pools > root > IP Pools.
3. Right-click IP Pool ext-mgmt and select Create Block of IPv4 Addresses.

4. Enter the starting IP address of the block, number of IP addresses required, and the subnet mask and
gateway information.

Create Block of IPv4 Addresses ? X
Fr{_'||'|" : -92-’_1:!\’:!1\_1‘5]':'- SlzL—' - 12 :
Subnet Mask - |255.255.255.0 Default Gateway : |192.168.156.1
Primary DNS : |0-0.0.0 Secondary DNS : |0.0.0.0

5. Click OK to create the block.

6. Click OK in the confirmation message.

Synchronize Cisco UCS to NTP

To synchronize the Cisco UCS environment to the NTP servers in the Nexus switches, complete the
following steps:

1. In Cisco UCS Manager, click Admin on the left.

2. Expand All > Time Zone Management.

w

Select Timezone.

4. In the Properties pane, select the appropriate time zone in the Time Zone pulldown.
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5. Click Save Changes and then click OK.
6. Click Add NTP Server.

7. Enter <switch-a-ntp-ip> and click OK. Click OK on the confirmation.

Add NTP Server ? X

NTP Server - | 10.1.156_4]

o Cancel

8. Click Add NTP Server.

9. Enter <switch-b-ntp-ip> and click OK. Click OK to confirm.

All / Time Zone Management / Timezone

General Events

Actions Properties
Add NTP Server Time Zone - |America/New_York (Eastern
NTP Servers

T Advanced Filter 4 Export "= Print

Marme:

Edit Chassis Discovery Policy

Setting the discovery policy simplifies the addition of Cisco UCS B-Series chassis and of additional fabric
extenders for further Cisco UCS C-Series connectivity. To modify the chassis discovery policy, complete the
following steps:

1. In Cisco UCS Manager, click Equipment on the left and select Equipment in the second list.

2. In the right pane, click the Policies tab.
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3. Under Global Policies, set the Chassis/FEX Discovery Policy to match the minimum number of uplink
ports that are cabled between the chassis or fabric extenders (FEXes) and the fabric interconnects.

4. Set the Link Grouping Preference to Port Channel. If Backplane Speed Preference appears, leave it set at
40G. If the 6248UP environment being setup contains a large amount of multicast traffic, set the Mul-
ticast Hardware Hash setting to Enabled.

Equipment

Main Topology View Fabric Interconnects Servers Therma Decommissicned Firmware Management Policies

_ Autoconfig Policies Server Inheritance Policies Server Discovery Policies SEL Policy Power Groups

Chassis/FEX Discovery Policy

Action - |2 Link v
Link Grouping Preference : Mone (o) Port Channel
Backplane Speed Preference © |18 A0G Ax10G

5. Click Save Changes.

6. Click OK.

Enable Server and Uplink Ports

To enable server and uplink ports, complete the following steps:

1. In Cisco UCS Manager, click Equipment on the left.
2. Expand Equipment > Fabric Interconnects > Fabric Interconnect A (primary) > Fixed Module.
3. Expand Ethernet Ports.

4. Select the ports that are connected to the chassis, Cisco FEX, and direct connect Cisco UCS C-Series
servers, right-click them, and select “Configure as Server Port.”

5. Click Yes to confirm server ports and click OK.

6. Verify that the ports connected to the chassis, C-series servers and Cisco FEX are now configured as
server ports.

7. Select the ports that are connected to the Cisco Nexus switches, right-click them, and select Configure
as Uplink Port.

# The last 6 ports of the Cisco UCS 6332 and Cisco UCS 6332-16UP FlIs will only work with optical
based QSFP transceivers and AOC cables, so they can be better utilized as uplinks to upstream re-
sources that might be optical only.

8. Click Yes to confirm uplink ports and click OK.
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10.

11.

12.

13.

14.

15.

16.

17.

18

Select the FCoOE ports that are connected to the NetApp storage controllers, right-click them, and select
Configure as FCoOE Storage Port.

Click Yes to confirm FCoE Storage ports and click OK.
Select Equipment > Fabric Interconnects > Fabric Interconnect B (subordinate) > Fixed Module.
Expand Ethernet Ports.

Select the ports that are connected to the chassis, C-series servers or to the Cisco 2232 FEX (two per
FEX), right-click them, and select Configure as Server Port.

Click Yes to confirm server ports and click OK.

Select the ports that are connected to the Cisco Nexus switches, right-click them, and select Configure
as Uplink Port.

Click Yes to confirm the uplink ports and click OK.

Select the FCoE ports that are connected to the NetApp storage controllers, right-click them, and select
Configure as FCoE Storage Port.

. Click Yes to confirm FCoE Storage ports and click OK.

Acknowledge Cisco UCS Chassis and FEX

To

1.

2.

3.

acknowledge all Cisco UCS chassis and any external 2232 FEX modules, complete the following steps:

In Cisco UCS Manager, click Equipment on the left.
Expand Chassis and select each chassis that is listed.

Right-click each chassis and select Acknowledge Chassis.
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Acknowledge Chassis X

A Are you wure you et 1 sckncubedge Chises 1 7
This operation wal rebuld the network carnectivity between the Chasais and the Fabrics ¢ & connected
0.
Currently thers oro 2 sotive Inks to Fabo A and there ore 2 octwe bnks ta Febnc B

Yeu No

4. Click Yes and then click OK to complete acknowledging the chassis.
5. If Nexus 2232 FEX are part of the configuration, expand Rack Mounts and FEX.
6. Right-click each FEX that is listed and select Acknowledge FEX.

7. Click Yes and then click OK to complete acknowledging the FEX.

Create Uplink Port Channels to Cisco Nexus Switches

To configure the necessary port channels out of the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click LAN on the left.

& In this procedure, two port channels are created: one from fabric A to both Cisco Nexus switches and
one from fabric B to both Cisco Nexus switches.

2. Under LAN > LAN Cloud, expand the Fabric A tree.
3. Right-click Port Channels.

4. Select Create Port Channel.

5. Enter a unique ID of the port channel.

6. Enter vPC-Nexus as the name of the port channel.

7. Click Next.
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8. Select the ports connected to the Nexus switches to be added to the port channel:
9. Click >> to add the ports to the port channel.

10. Click Finish to create the port channel.

11. Click OK.

12. In the navigation pane, under LAN > LAN Cloud, expand the fabric B tree.

13. Right-click Port Channels.

14. Select Create Port Channel.

15. Enter a unique ID of the port channel.

16. Enter vPC-Nexus as the name of the port channel.

17. Click Next.

18. Select the ports connected to the Nexus switches to be added to the port channel:
19. Click >> to add the ports to the port channel.

20. Click Finish to create the port channel.

21. Click OK.

Create a WWNN Pool for FCoE Boot

To configure the necessary WWNN pool for the Cisco UCS environment, complete the following steps on
Cisco UCS Manager.

1. Select SAN on the left.

2. Select Pools > root.

3. Right-click WWNN Pools under the root organization.
4. Select Create WWNN Pool to create the WWNN pool.
5. Enter WWNN-Pool for the name of the WWNN pool.

6. Optional: Enter a description for the WWNN pool.

7. Select Sequential for Assignment Order.
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Create WWNN Pool ? X
Define Name and Description Mame o WWINN-Fool
Description
Add WWN Blocks
Assignment Order : Default (o) Sequential
Mext > Cancel
8. Click Next.
9. Click Add.

10. Modify the From field as necessary for the UCS Environment.

‘ﬁ Modifications of the WWNN block, as well as the WWPN and MAC Addresses, can convey identifying
information for the UCS domain. Within the From field in our example, the 6™ octet was changed from
00 to 48 to represent as identifying information for this being in the Cisco UCS 6248 in the 4" cabinet.

‘& When there are multiple UCS domains sitting in adjacency, it is important that these blocks, the
WWNN, WWPN, and MAC hold differing values between each set.

11. Specify a size of the WWNN block sufficient to support the available server resources.
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Create WWN Block

From: | 20:00:00:25:85:48:00:00 Size :

To ensure unigueness of WWHNs in the SAN fabric, you are strongly encouraged to use
the following WWHN prefix:

20:00:00:25:b5:x KX

12. Click OK.

13. Click Finish and OK to complete creating the WWNN pool.

Create WWPN Pools

To configure the necessary WWPN pools for the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click SAN on the left.

2. Select Pools > root.

3. In this procedure, two WWPN pools are created, one for each switching fabric.
4. Right-click WWPN Pools under the root organization.

5. Select Create WWPN Pool to create the WWPN pool.

6. Enter WWPN-Pool-A as the name of the WWPN pool.

7. Optional: Enter a description for the WWPN pool.

8. Select Sequential for Assignment Order.
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Create WWPN Pool 5
Define Mame and Description Mame o WWERP-Pool-A
Description
Add WWN Blocks ) )
Assignment Order @ |0 Default (e Sequential
Next > Cancel
9. Click Next.
10. Click Add.

11. Specify a starting WWPN.

‘& For the FlexPod solution, the recommendation is to place 02 in the next-to-last octet of the starting
WWPN to identify all of the WWPNs as fabric A addresses. Merging this with the pattern we used for
the WWNN we see a WWPN block starting with 20:00:00:25:B5:48:0A:00.

12. Specify a size for the WWPN pool that is sufficient to support the available blade or server resources.
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Create WWN Block

From : | 20:00:00-25:B85:48:04:00 Size : | 16 =

To ensure unigueness of WWNs in the SAN fabric, you are strongly encouraged to use
the following WAWN prefix:

20:00:00:25:b5S:xx:xxxx

13. Click OK.

14. Click Finish.

15. In the confirmation message, click OK.

16. Right-click WWPN Pools under the root organization.
17. Select Create WWPN Pool to create the WWPN pool.
18. Enter WWPN-Pool-B as the name of the WWPN pool.
19. Optional: Enter a description for the WWPN pool.

20. Select Sequential for Assignment Order.

21. Click Next.

22. Click Add.

23. Specify a starting WWPN.
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# For the FlexPod solution, the recommendation is to place 0B in the next-to-last octet of the starting
WWPN to identify all of the WWPNSs as fabric A addresses. Merging this with the pattern we used for
the WWNN we see a WWPN block starting with 20:00:00:25:B5:48:0B:00.

24. Specify a size for the WWPN address pool that is sufficient to support the available blade or server re-
sources.

25. Click OK.
26. Click Finish.

27. In the confirmation message, click OK.

Create Storage VSANs

To configure the necessary virtual storage area networks (VSANSs) for the Cisco UCS environment, complete
the following steps:

1. In Cisco UCS Manager, click SAN on the left.

# In this procedure, two VSANSs are created.

2. Select SAN > Storage Cloud.

3. Right-click VSANSs.

4. Select Create Storage VSAN.

5. Enter VSAN-A as the name of the VSAN to be used for Fabric A
6. Set FC Zoning to Enabled.

7. Select Fabric A.

8. Enter a unique VSAN ID and a corresponding FCoE VLAN ID for Fabric A. It is recommended to use the
same ID for both parameters and to use something other than 1.
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Create Storage VSAN ? X

Mame : | VSAN-A

FC Zoning Settings

FC Zoning : Disabled (») Enabled

Do NOT enable local zoming if fabric interconnect i1s connected to an upstream FC/FCoE switch.

Common/Global (e) Fabric A Fabric B Both Fabrics Configured Differently

You are creating a local VEAN in fabric A that maps to ANVLAN can be used to carry FCoE traffic and can be mapped to this
a VSAN ID that exists only in fabnc A. WEAN.

Enter the WSAN ID that maps to this WSAN. Enter the WLAN ID that maps to this VSAM.

VSANID: | 101 CoE WLAN : | 107

o Cancel

10.

11.

12.

13.

14.

15.

Click OK and then click OK again.

Under Storage Cloud, right-click VSANSs.

Select Create Storage VSAN.

Enter VSAN-B as the name of the VSAN to be used for Fabric B.
Set FC Zoning to Enabled.

Select Fabric B.

Enter a unique VSAN ID and a corresponding FCoE VLAN ID for Fabric B. It is recommended use the
same ID for both parameters and to use something other than 1.

201



Appendix

Create Storage VSAN ? X

Mame - | VSAM-B

FC Zoning Settings

FC Zoning : Dizabled (o) Enzbled

Do NOT enable local zoming if fabric interconnect 1s connected ta an upstream FC/FCoE switch.

Common/Global Fabiric A (e) Fabric B Both Fabncs Conhgured Differently

You are creating a local VSAN in fabric B that maps to AVLAN can be used to carry FCoE traffic and can be mapped to this
a WSAN ID that exists only in fabric B. WSAM.

Enter the WSAN ID that maps to this VSAN. Enter the VLAM ID that maps to this VSAN.

WEAMID: | 102 FCoE WLAN : 'IEIQ|

o Cancel

16. Click OK and then click OK again.

Assign VSANSs to FCoE Storage Ports

To assign storage VSANs to FCoE Storage Ports, complete the following steps:

1.

2.

In Cisco UCS Manager, click SAN on the left.

Select SAN > Storage Cloud.

Expand Fabric A and Storage FCoE Interfaces.

Select the first FCoE Interface.

For User Label, enter the storage controller name and port. Click Save Changes and OK.

Use the pulldown to select VSAN VSAN-A. Click Save Changes and OK.
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SAN | Storage Cloud [ Fabric A / Storage FCoE Interfaces /| FCoE Interface 1/15

] : 15 Slot 1D -1
el Fabric 1D A Aggregated Port 1D : 0
User Label . | bbO4-affa300-1:09
Fort Type . Physical Metwork Type © San
Transport Type © Ether Role . Fcoe Storage
Locale . External Port - sys/switch-Afslot-1/switch-ether/port-15

WVSAN - |Fabric Afvsan VSAN-A »

7. Select the second FCOE Interface.

8. For User Label, enter the storage controller name and port. Click Save Changes and OK.
9. Use the pulldown to select VSAN VSAN-A. Click Save Changes and OK.

10. Expand Fabric B and Storage FCOE Interfaces.

11. Select the first FCOE Interface.

12. For User Label, enter the storage controller name and port. Click Save Changes and OK.
13. Use the pulldown to select VSAN VSAN-B. Click Save Changes and OK.

14. Select the second FCoE Interface.

15. For User Label, enter the storage controller name and port. Click Save Changes and OK.

16. Use the pulldown to select VSAN VSAN-B. Click Save Changes and OK.

Create VHBA Templates

To create the necessary virtual host bus adapter (vHBA) templates for the Cisco UCS environment, complete
the following steps:

1. In Cisco UCS Manager, click SAN on the left.

2. Select Policies > root.

3. Right-click vHBA Templates.

4. Select Create VHBA Template.

5. Enter vHBA-Template-A as the vHBA template name.

6. Keep Fabric A selected.
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7. Leave Redundancy Type set to No Redundancy.
8. Select VSAN-A.

9. Leave Initial Template as the Template Type.
10. Select WWPN-Pool-A as the WWPN Pool.

11. Click OK to create the vVHBA template.

12. Click OK.
Create vHBA Template ?
Marme o wHBA-Template-A
Description
Fabric 1D
Redundancy
Redundancy Type : |0 Mo Redundancy () Primary Template () Secondary Template
Select VSAN o | VSAN-A v Create VSAN
Template Type : |0 Initizl Template () Updating Template
Max Data Field Size - | 2048
WWPN Pool D WAWPN-Pool-A06/18) w
QoS Policy D enotsets w
Pin Group o | =not set= L
Stats Threshold Policy @ | default

13. Right-click vHBA Templates.

14. Select Create VHBA Template.
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15. Enter vHBA-Template-B as the vHBA template name.
16. Leave Redundancy Type set to No Redundancy.

17. Select Fabric B as the Fabric ID.

18. Select VSAN-B.

19. Leave Initial Template as the Template Type.

20. Select WWwPN-Pool-B as the WWPN Pool.

21. Click OK to create the vHBA template.

22. Click OK.

Create SAN Connectivity Policy

To configure the necessary Infrastructure SAN Connectivity Policy, complete the following steps:

1. In Cisco UCS Manager, click SAN on the left.

2. Select SAN > Policies > root.

3. Right-click SAN Connectivity Policies.

4. Select Create SAN Connectivity Policy.

5. Enter FC-Boot as the name of the policy.

6. Select the previously created WWNN-Pool for the WWNN Assignment.
7. Click the Add button at the bottom to add a vHBA.

8. In the Create VHBA dialog box, enter Fabric-A as the name of the vHBA.
9. Select the Use VHBA Template checkbox.

10. In the vHBA Template list, select vHBA-Template-A.

11. In the Adapter Policy list, select VMWare.
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Create vHBA

MName . | Fabric-A

Use vHBA Template : ¥

Redundancy Pair : Peer Name :

vHBA Template © | yHEA-Template-A ¥ Create vHBA Template

Adapter Performance Profile

Adapter Policy : | VMWare ¥ Create Fibre Channel Adapter Policy
o Cancel

12. Click OK.
13. Click the Add button at the bottom to add a second vHBA.
14. In the Create vHBA dialog box, enter Fabric-B as the name of the vHBA.
15. Select the Use vHBA Template checkbox.
16. In the vHBA Template list, select vHBA-Template-B.
17. In the Adapter Policy list, select VMWare.
18. Click OK.
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Create SAN Connectivity Policy 7 X
Mame . | FC-Boot
Description :

A server is identified on a SAN by its World Wide Node Name (WWHNN). Specify how the system should assign a WWINN to the server associated
with this profile.
World Wide Node Name

WWNN Assignment: WWNN-Pool{16/16) v

Create WWHNN Poaol

The WWMNHN will be assigned fram the selected pool.
The available/total WWHNNs are displayed after the pool name.

MName WWPN
p VHEA Fabric-B Derved
p vHBA Fabric-A Derved

() Add

19. Click OK to create the SAN Connectivity Policy.

20. Click OK to confirm creation.

Create MAC Address Pools

To configure the necessary MAC address pools for the Cisco UCS environment, complete the following
steps:

1. In Cisco UCS Manager, click LAN on the left.

2. Select Pools > root.

‘ﬁ In this procedure, two MAC address pools are created, one for each switching fabric.
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3. Right-click MAC Pools under the root organization.

4. Select Create MAC Pool to create the MAC address pool.
5. Enter MAC-Pool-A as the name of the MAC pool.

6. Optional: Enter a description for the MAC pool.

7. Select Sequential as the option for Assignment Order.

8. Click Next.

9. Click Add.

10. Specify a starting MAC address.

& For the FlexPod solution, the recommendation is to place 0A in the next-to-last octet of the starting
MAC address to identify all of the MAC addresses as fabric A addresses. In our example, we have
implemented this practice, giving us 00:25:B5:48:0A:00 as our first MAC address.

11. Specify a size for the MAC address pool that is sufficient to support the available blade or server re-
sources, noting that 6 virtual network interfaces (VNICs) will be created on each server.

Create a Block of MAC Addresses

FirstMACAddress:|DD:2&:BEJ:118:0A:DO ‘ Size : [64] s

To ensure uniqueness of MACS in the LAN fabric, you are strongly encouraged to use the following MAC
prefic:
00:25:B5n0exxxx
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12. Click OK.

13. Click Finish.

14. In the confirmation message, click OK.

15. Right-click MAC Pools under the root organization.

16. Select Create MAC Pool to create the MAC address pool.
17. Enter MAC-Pool-B as the name of the MAC pool.

18. Optional: Enter a description for the MAC pool.

19. Select Sequential as the option for Assignment Order.
20. Click Next.

21. Click Add.

22. Specify a starting MAC address.

# For the FlexPod solution, it is recommended to place 0B in the next to last octet of the starting MAC
address to identify all the MAC addresses in this pool as fabric B addresses. Once again, we have
implemented this practice, giving us 00:25:B5:48:0B:00 as our first MAC address.

23. Specify a size for the MAC address pool that is sufficient to support the available blade or server re-
sources.

24. Click OK.
25. Click Finish.

26. In the confirmation message, click OK.

Create UUID Suffix Pool

To configure the necessary universally unique identifier (UUID) suffix pool for the Cisco UCS environment,
complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.

2. Select Pools > root.

3. Right-click UUID Suffix Pools.

4. Select Create UUID Suffix Pool.

5. Enter UUID-Pool as the name of the UUID suffix pool.

6. Optional: Enter a description for the UUID suffix pool.
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10.

11.

12.

13.

14.

15

Keep the prefix at the derived option.

Select Sequential for the Assignment Order.

Click Next.

Click Add to add a block of UUIDs.

Keep the From field at the default setting.

Specify a size for the UUID block that is sufficient to support the available blade or server resources.
Click OK.

Click Finish.

. Click OK.

Create Server Pool

To configure the necessary server pool for the Cisco UCS environment, complete the following steps:
# Consider creating unique server pools to achieve the granularity that is required in your environment.

1. In Cisco UCS Manager, click Servers on the left.

2. Select Pools > root.

3. Right-click Server Pools.

4. Select Create Server Pool.

5. Enter Infra-Pool as the name of the server pool.

6. Optional: Enter a description for the server pool.

7. Click Next.

8. Select two (or more) servers to be used for the VMware management cluster and click >> to add them to

the Infra-Pool server pool.
9. Click Finish.
10. Click OK.

Create VLANs

To
fol

1.

configure the necessary virtual local area networks (VLANS) for the Cisco UCS environment, complete the
lowing steps:

In Cisco UCS Manager, click LAN on the left.
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ﬁ In this procedure, five unique VLANSs are created. See Table 2

2. Select LAN > LAN Cloud.

3. Right-click VLANSs.

4. Select Create VLANS.

5. Enter Native-VLAN as the name of the VLAN to be used as the native VLAN.
6. Keep the Common/Global option selected for the scope of the VLAN.

7. Enter the native VLAN ID.

8. Keep the Sharing Type as None.

9. Click OK, and then click OK again.

Create VLANSs ? X

VLAN Name/Prefix o Native-V0LAN

Create Multicast Policy

Multicast Policy Mame © | zpot set>

o Common/Global Fabric A Fabric B Both Fabrics Configured Differently

You are creating global VLANS that map to the same VLAN 1Dz in all available fabrics.
Enter the range of VLAN [Ds.(e.g. * 2009-2019%, " 29,35, 40-45" , * 23", " 23,34-45")

VLAM IDs: | 2

Sharing Type : |(®) Mone Primary Isolated Community

Check Overlap o Cancel

10. Expand the list of VLANSs in the navigation pane, right-click the newly created Native-VLAN and select
Set as Native VLAN.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.

Click Yes and then click OK.

Right-click VLANSs.

Select Create VLANs

Enter 1B-MGMT as the name of the VLAN to be used for management traffic.
Keep the Common/Global option selected for the scope of the VLAN.
Enter the In-Band management VLAN ID.

Keep the Sharing Type as None.

Click OK, and then click OK again.

Right-click VLANSs.

Select Create VLANS.

Enter Infra-NFs as the name of the VLAN to be used for NFS.

Keep the Common/Global option selected for the scope of the VLAN.
Enter the Infrastructure NFS VLAN ID.

Keep the Sharing Type as None.

Click OK, and then click OK again.

Right-click VLANSs.

Select Create VLANS.

Enter vMotion as the name of the VLAN to be used for vMotion.
Keep the Common/Global option selected for the scope of the VLAN.
Enter the vMotion VLAN ID.

Keep the Sharing Type as None.

Click OK, and then click OK again.

Right-click VLANSs.

Select Create VLANS.

Enter vM-Traffic as the name of the VLAN to be used for VM Traffic.

Keep the Common/Global option selected for the scope of the VLAN.
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37. Enter the VM-Traffic VLAN ID.
38. Keep the Sharing Type as None.
39. Click OK and then click OK again.

VLANs
_v LAN

w LAN Cloud Y, Advanced Filter 4 Export  # Print

, A -
» Fabric A MName 1C - Type Transport Mative WLAN Shar...

» Fabric B
» CJoS Systemn Class
LAMN Pin Groups
» Threshold Policies
WLAN Groups
VLANs
WLAM default (1) o - o ) Add

WVLAM IB-MGMT (113)
Details

VLAN Infra-NFS (3050)
General Org Permissions VLAM Group Membership Faults Events

VLAN Native-VLAN (2)

VLAN WM-Traffic (900) .
Fault Summary Properties

VLAN wMotion (3000)
FvY A, ol [ L aiee

Modify Default Host Firmware Package

Firmware management policies allow the administrator to select the corresponding packages for a given
server configuration. These policies often include packages for adapter, BIOS, board controller, FC adapters,
host bus adapter (HBA) option ROM, and storage controller properties.

To create a firmware management policy for a given server configuration in the Cisco UCS environment,
complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.

2. Select Policies > root.

3. Expand Host Firmware Packages.

4. Select default.

5. In the Actions pane, select Modify Package Versions.

6. Select the version 3.2(1d) for both the Blade and Rack Packages.
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Modify Package Versions X
Blade Package : |3.2(1d)2 v

Rack Package : ‘S.Eim}: -

Service Pack  : | <not set> v

The images from Service Pack will take precedence over the images from Blade or Rack Package

Excluded Components:

Adapter -

BIOS

Board Controller

CIMC

FC Adapters

Flex Flash Controller

GPUs

HBA Option ROM

Host NIC

Host NIC Option ROM
+| Local Disk

PSU

SAS Fxnander : ¥
<| i >

OK Apply Cancel Help

7. Click OK, then click OK again to modify the host firmware package.

Set Jumbo Frames in Cisco UCS Fabric

To configure jumbo frames and enable quality of service in the Cisco UCS fabric, complete the following
steps:

1. In Cisco UCS Manager, click LAN on the left.

2. Select LAN > LAN Cloud > QoS System Class.

3. In the right pane, click the General tab.

4. On the Best Effort row, enter 9216 in the box under the MTU column.
5. Click Save Changes in the bottom of the window.

6. Click OK.
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fm % m h

(7]

=
=
2,

LAN Cloud | QoS System Class
3 FSA
Prog
Owner : Local
Priority Enabled CoS Packet Weight
Drop
Platinum r 5 r
Gold r 4 3
Silver r 2 R
Bronze r 1 =
Best F Any F 5
Effort
Fibre 4 3 r

Weight

(%)

NiA

N/A

NIA

NIA

NIA

MTU

Multicast
Optimized

r

r

Only the Fibre Channel and Best Effort QoS System Classes are enabled in this FlexPod implementation. The
UCS and Nexus switches are intentionally configured this way so that all IP traffic within the FlexPod will be
treated as Best Effort. Enabling the other QoS System Classes without having a comprehensive, end-to-end
QoS setup in place can cause difficult to troubleshoot issues. For example, NetApp storage controllers by de-
fault mark IP-based storage protocol packets with a CoS value of 4. With the default configuration on the
Nexus switches in this implementation, storage packets will pass through the switches and into the UCS Fab-
ric Interconnects with CoS 4 set in the packet header. If the Gold QoS System Class in the UCS is enabled,
these storage packets will be treated according to that class and if Jumbo Frames is being used for the stor-
age protocols, but the MTU of the Gold QoS System Class is not set to Jumbo, packet drops will occur.

Create Local Disk Configuration Policy (Optional)

A local disk configuration for the Cisco UCS environment is necessary if the servers in the environment do
not have a local disk.

# This policy should not be used on servers that contain local disks.

To create a local disk configuration policy, complete the following steps:

1.

2.

In Cisco UCS Manager, click Servers on the left.
Select Policies > root.
Right-click Local Disk Config Policies.

Select Create Local Disk Configuration Policy.

Enter SAN-Boot as the local disk configuration policy name.

Change the mode to No Local Storage.

Click OK to create the local disk configuration policy.

215



Appendix

Create Local Disk Configuration Policy ? X
Name : | SAN-Boot
Description
Mode - [Mo Local Storage -
FlexFlash
FlexFlash State : |(® Disable Enable

If FlexFlash State iz disabled, S0 cards will become unavailable immediatehy
Please ensure S0 cards are not in use before disabling the FlexFlash State.

FlexFlash RAID Reporting State @ |(e) Disable Enzble

o Cancel

8. Click OK.

Create Network Control Policy for Cisco Discovery Protocol (CDP) and Link Layer Discovery
Protocol (LLDP)

To create a network control policy that enables CDP and LLDP on virtual network ports, complete the
following steps:

1. In Cisco UCS Manager, click LAN on the left.
2. Select Policies > root.

3. Right-click Network Control Policies.

4. Select Create Network Control Policy.

5. Enter Enable-CDP-LLDP as the policy name.
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6. For CDP, select the Enabled option.
7. For LLDP, scroll down and select Enabled for both Transmit and Receive.

8. Click OK to create the network control policy.

Create Network Control Policy ? X

CoP : Disabled s Enabled |

MAC Register Mode : |(s) Only Native Vlan All Host Vlans

Action on Uplink Fail : |(e Link Down Warning

MAC Security

Farge : |(e Allow Deny |

LLDP
Transmit ; Disabled (») Enabled ‘
Receive : . Disabled '») Enabled ‘ l]
Cancel
9. Click OK.

Create Power Control Policy

To create a power control policy for the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click Servers tab on the left.

2. Select Policies > root.

3. Right-click Power Control Policies.

4. Select Create Power Control Policy.

5. Enter No-Power-Cap as the power control policy name.
6. Change the power capping setting to No Cap.

7. Click OK to create the power control policy.

8. Click OK.
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Create Power Control Policy ? X

Marme - | No-Power-Cap
Description

Fan Speed Policy © | Any v
Power Capping

[f you choose cap, the server is allocated a certain amount of power based on its priority
within its power group. Prionty values range from 1 to 10, with 1 being the highest priority. If
you choose no-cap, the server is exempt from all power capping.

o Mo Cap cap

Cisco UCS Manager only enforces power capping when the servers in a power group reguire
more power than is currently available. With sufficient power, all servers run at full capacity
regardless of their pnonty.

o Cancel

Create Server Pool Qualification Policy (Optional)

To create an optional server pool qualification policy for the Cisco UCS environment, complete the following
steps:

ﬂ This example creates a policy for Cisco UCS B200 M5 servers for a server pool.

1. In Cisco UCS Manager, click Servers on the left.
2. Select Policies > root.

3. Right-click Server Pool Policy Qualifications.

4. Select Create Server Pool Policy Qualification.
5. Name the policy ucs- B200M5.

6. Select Create Server PID Qualifications.

7. Select UCSB-B200-M5 from the PID drop-down list.
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Create Server PID Qualifications

PID: [UCSB-B200-Mg
UCSB-B420-M4

B230-BASE-M2

B440-BASE-M2

UCSB-EX-M4-3
N20-B6625-2

N20-B6625-1

UCSC-C3X60-SVRNB
UCSC-C3X60-M4SRB
UCSC-C3K-M4SRB
UCSB-B420-M3
UCSB-B22-M3
UCSB-EX-M4-1
UCSB-EX-M4-2
UCSB-B480-M5

UCSC-C24-M352
UCSC-C24-M3L

UCSC-C22-M3L

UCSC-C22-M3S

8. Click OK.
9. Optionally select additional qualifications to refine server selection parameters for the server pool.

10. Click OK to create the policy then OK for the confirmation.

Create Server BIOS Policy

To create a server BIOS policy for the Cisco UCS environment, complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.
2. Select Policies > root.

3. Right-click BIOS Policies.

4. Select Create BIOS Policy.
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5. Enter vM-Host as the BIOS policy name.

Create BIOS Policy

Name : VM-Host

Description

Reboot on BIOS Settings Change : O

Cancel

6. Select and right click the newly created BIOS Policy.

7. Within the Main tab of the Policy:
8. Change CDN Control to enabled.

9. Change the Quiet Boot setting to disabled.
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Policies [ root | BIOS Policies | VM-Host
Main Advanced Boot Options Server Management
Actions

Delete

Shew Policy Usage

Properties
MName © VM-Host
Description

Owner : Local
Reboot on BIOS Settings Change : [

T, Advanced Fiter 4 Export /& Print

Events

BIOS Tokens

[ CDN Control

-
St it v

Disabled ']
Resume on AC power loss Platforrm Default v

10. Click the Advanced tab, leaving the Processor tab selected within the Advanced tab.

11. Set the following within the Processor tab:
12. DRAM Clock Throttling -> Performance:

a. Frequency Floor Override -> Enabled

b. Processor C State -> Disabled
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Policies | root | BIOS Policies /| VM-Host

Mamn Advanced l Boot Options Server Management Events

Processor Intel Directed 10 RAS Memory Serial Port use PCI apl LOM and PCle Slots Trusted Platform Graphics Configuration
Y, Advanced Fiter 4 Export  # Print el

BIOS Tokens Settings
Attitude Platform Default v =
CPU Hardware Power Management Platform Default v
CPU Performance Platform Default v
Core Multi Processing Platform Default ¥

L DRAM Clock Throttling Performance ']
Direct Cache Access Platform Default ¥
Energy Performance Tuning Platform Default ol
v

Enhanced Intel SpeedStep Tech

Execute Disable Bit

Platform Default

Platform Default

[_ Frequency Floor Ovemide

Enabled

ntel HyperThreading Tech
intel Turbo Boost Tech

ntel Virtualization Technology
Channel Interleaving

Memory Interleaving

Rank Interleaving

Local X2 Apic

Max Variable MTRR Setting

P STATE Coordination

Package C State Limit

Platform Default

Platform Default

Platform Default

Platform Default

Plati

Default

Platform Default

Platform Default

Platform Default

Platform Default

Platform Default

[ Processor C State

Disabled

13

Processor C1E -> disabled

a.
b. Processor C3 Report -> disabled

o

Processor C7 Report -> disabled

d. Energy Performance -> performance
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Palicies | root |/ BIOS Policies | VM-Host

Main Advanced Boot Options Server Management Events

m Intel Directed 10 RAS Memory Serial Port usB PCl aPl LOM and PCle Slats Trusted Platform Graphics Configuration

T, Advanced Fiter 4 Export @ Print £
BIOS Tokens Settings
Memary Interleaving Platform Default " 3
Rank Interleaving Platform Default v
Local X2 Apic Platform Default "
Max Variable MTRR Setting Platform Default i
P STATE Coordination Platform Default v
Package C State Limit Platform Default v
Processor C State Disabled v
Processor C1E Disabiled o
Processor C3 Report Disabled v
Processor Cf Report Platform Default &
Disabled 'j
Processor CMCI Platform Default o
Power Technology Platform Default "
[ Energy Performance Performance ']
Adjacent Cache Line Prefetcher Pl Default ol
DCU IP Prefetcher Platform Default B
DCU Streamer Prefetch Platform Default v
Hardware Prefetcher Platform Default v
Demand Scrub Platform Default v
Patrol Serub Platform Default r
Workload Configuration Platform Default v =1
Save Changes Reset Values

14. Click the RAS Memory tab, and select LV DDR Mode -> performance-mode.
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Policies | root | BIOS Policies | VM-Host

Main Advanced Boot Options Server Management Evania

i el reses 10 _ senalPert ee el QP LOM and PCle Slots Trusted Platform Graphics Configuration

T, Advanced Fiter 4 Export & Print "
BIOS Tokens

15. Click Save Changes.

16. Click OK.

Update the Default Maintenance Policy

To update the default Maintenance Policy, complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.
2. Select Policies > root.

3. Select Maintenance Policies > default.

4. Change the Reboot Policy to User Ack.

5. Click “On Next Boot” to delegate maintenance windows to server administrators.
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Maintenance Policy X
General Events
Actions Properties
Name - default
Show Policy Usage Description
Owner : Local
Soft Shutdown Timer : | 150 Secs v
Storage Config. Deployment Policy : Immediste (s User Ack |
Reboot Policy . Immediate (s User Ack Timer Automatic

+| On Next Boot {Apply pending changes at next reboot )

OK Cancel Help

6. Click Apply.

7. Click OK to accept the change.

Create VNIC Templates

To create multiple virtual network interface card (vNIC) templates for the Cisco UCS environment, complete
the following steps. A total of 2 vNIC Templates will be created.

Create Infrastructure vNICs

1. In Cisco UCS Manager, click LAN on the left.
2. Select Policies > root.

3. Right-click vNIC Templates.

4. Select Create vNIC Template.

5. Enter Infra-A as the vNIC template name.
6. Keep Fabric A selected.

7. Select the Enable Failover checkbox.
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# Selecting Failover is a critical step to improve link failover time by handling it at the hardware level,
and to guard against NIC any potential for NIC failure not being detected by the virtual switch.

8. Select Primary Template for Redundancy Type.

9. Leave the Peer Redundancy Template set to <not set>.

10. Under Target, make sure that only the Adapter checkbox is selected.
11. Select Updating Template as the Template Type.

12. Under VLANS, select the checkboxes for IB-MGMT, Infra-NFS, vMotion, VM-Traffic, and Native-VLAN
VLANS.

13. Set Native-VLAN as the native VLAN.

14. Select vNIC Name for the CDN Source.
15. For MTU, enter 9000.

16. In the MAC Pool list, select MAC-Pool-A.

17. In the Network Control Policy list, select Enable-CDP-LLDP.
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Create vNIC Template ? X
Template Type : | Initial Template [« Updating Template
V0LANs VLAN Groups
T, Advanced Filter 4 Export & Print o
Select Name Mative VLAN
IOM-iSCSI-B
IOM-NFS
o MNative-VLAN .
i VM-Traffic
v vMotion
b
Creates VLAN
CDN Source o vNIC Mame User Defined
MTU 9000
MAC Pool MAC-Pool-A(60/64)
QoS Policy <not set> ¥
MNetwork Control Policy : Enable-CDP-LLDP v |
Pin Group <not set> v =
Stats Threshold Policy : | default v
Connection Policies ;I

18. Click OK to create the vNIC template.

1

9. Click OK.

Create the secondary redundancy template Infra-B:

1.

2.

Select Fabric B.

Select LAN on the left.
Select Policies > root.
Right-click vNIC Templates.
Select Create vNIC Template

Enter Infra-B as the vNIC template name.
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7. Select the Enable Failover checkbox.
8. Set Redundancy Type to Secondary Template.
9. Select Infra-A for the Peer Redundancy Template.

10. In the MAC Pool list, select MAC-Pool-B.

# The MAC Pool is all that needs to be selected for the Secondary Template, all other values will be
propagated from the Primary Template.

11. Click OK to create the vNIC template.

12. Click OK.

Create LAN Connectivity Policy for FC Boot

To configure the necessary Infrastructure LAN Connectivity Policy, complete the following steps:

1. In Cisco UCS Manager, click LAN on the left.

2. Select LAN > Policies > root.

3. Right-click LAN Connectivity Policies.

4. Select Create LAN Connectivity Policy.

5. Enter FC-Boot as the name of the policy.

6. Click the upper Add button to add a vNIC.

7. In the Create VNIC dialog box, enter 00-Infra-A as the name of the vNIC.
8. Select the Use vNIC Template checkbox.

9. Inthe vNIC Template list, select Infra-A.

10. In the Adapter Policy list, select VMWare.

11. Click OK to add this vNIC to the policy.
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Create vNIC

Mame - | 00-Infra-A
Use vNIC Template - #

Redundancy Pair - Peer Mame -

vNIC Template © | |nfra-A » Create vNIC Template

Adapter Performance Profile

?

Adapter Policy S WMWare v Create Ethernet Adapter Policy

12.

13.

14.

15.

16.

17.

Click the upper Add button to add another vNIC to the policy.

In the Create VNIC box, enter 01-Infra-B as the name of the vNIC.
Select the Use vNIC Template checkbox.

In the vNIC Template list, select Infra-B.

In the Adapter Policy list, select VMWare.

Click OK to add the vNIC to the policy.
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Create LAN Connectivity Policy ?

MName - FC-Boot

Description :

Click Add to specify one or more vNICs that the server should use to connect to the LAN.

B, TTal. P 5 _ 5
MName MAC Address Jative VLAN

vNIC 01 =Infra-B

vNIC 00-Infra-A Derived

(%) Add

{# Add iSCSI vNICs

18. Click OK, then click OK again to create the LAN Connectivity Policy.

Create vMedia Policy for VMware ESXi 6.5 U1 ISO Install Boot

In the NetApp Data ONTAP setup steps an HTTP web server is required, which will be used for hosting
NetApp Data ONTAP as well as VMware software. The vMedia Policy created will map the VMware ESXi 6.5
U1 ISO to the Cisco UCS server in order to boot the ESXi installation. To create this policy, complete the
following steps:

1. In Cisco UCS Manager, select Servers on the left.

2. Select Policies > root.

w

Right-click vMedia Policies.

4. Select Create vMedia Policy.
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10.

11.

12.

13.

Name the policy ESXi-6.5U1-HTTP.

Enter “Mounts ISO for ESXi 6.5 Ul” in the Description field.
Click Add.

Name the mount ESXi-6.5U1-HTTP.

Select the CDD Device Type.

Select the HTTP Protocol.

Enter the IP Address of the web server.

# Since DNS server IPs were not entered into the KVM IP earlier, it is necessary to enter the IP of the
web server instead of the hostname.

Enter VMware-VMuvisor-Installer-6.5.0.update01-5969303.x86_64.iso as the Remote File name.

# This VMware ESXi 6.5 U1 ISO can be downloaded from VMware Downloads.

Enter the web server path to the ISO file in the Remote Path field.
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Create vMedia Mount ?7 X

Name

Description

Device Type

Protocol
Hostname/IP Address
Image Name Variable
Remote File

Remote Path
Username

Password

Remap on Eject

/&) CDD () HDD

ESXi-65.U1-HTTP

NFS CIFS (e HTTP HTTPS |

10.1.156.150

+ Mone Service Profile Mame

visor-Installer-6.5.0,update01-5969303.xB6_64.is0

bears/vSphere%206.5|

14.

15.

Click OK to create the vMedia Mount.

Click OK then OK again to complete creating the vMedia Policy.

.=

For any new servers added to the Cisco UCS environment the vMedia service profile template can be used to
install the ESXi host. On first boot the host will boot into the ESXi installer since the SAN mounted disk is
empty. After ESXi is installed, the vMedia will not be referenced as long as the boot disk is accessible.

Create Boot Policy (FCoE Boot)

This procedure applies to a Cisco UCS environment in which two FCoE logical interfaces (LIFs) are on cluster
node 1 and two FCOE LIFs are on cluster node 2 for each Cisco UCS Fabric Interconnect:

To create a boot policy for the Cisco UCS environment, complete the following steps:

1.

2.

w

In Cisco UCS Manager, click Servers on the left.

Select Policies > root.

Right-click Boot Policies.

Select Create Boot Policy.
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5. Enter Boot-FC-Fabric-A as the name of the boot policy.

6. Optional: Enter a description for the boot policy.

ﬂ Do not select the Reboot on Boot Order Change checkbox.

7. Keep the Reboot on Boot Order Change option cleared.

8. Expand the Local Devices drop-down menu and select Add Remote CD/DVD.
9. Expand the vHBAs drop-down menu and select Add SAN Boot.

10. Select the Primary Type.

11. Enter Fabric-A in the vHBA field.

12. Confirm that Primary is selected for the Type option.

Add SAN Boot ? X

vHBA : | Fabric-]

Type : |(®) Primary Secondary Any

13. Click OK to add the SAN boot initiator.
14. From the vHBA drop-down menu, select Add SAN Boot Target.
15. Keep 0 as the value for Boot Target LUN.

16. Enter the WWPN for fcp 1if0la.

# To obtain this information, log in to the storage cluster and run the network interface show
command.

17. Select Primary for the SAN boot target type.
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Add SAN Boot Target ? X

Boot Target LUN - |0

Boot Target WWPN : | 20:01:00:20:928:5b:43:86]

Type o (@) Primary Secondary

18. Click OK to add the SAN boot target.

19. From the vHBA drop-down menu, select Add SAN Boot Target.
20. Enter 0 as the value for Boot Target LUN.

21. Enter the WWPN for fcp 1if02a.

22. Click OK to add the SAN boot target.

23. From the vHBA drop-down menu, select Add SAN Boot.

24. In the Add SAN Boot dialog box, enter Fabric-B in the vHBA box.
25. The SAN boot type should automatically be set to Secondary.
26. Click OK to add the SAN boot initiator.

27. From the vHBA drop-down menu, select Add SAN Boot Target.
28. Keep 0 as the value for Boot Target LUN.

29. Enter the WWPN for fcp 1if01b.

30. Select Primary for the SAN boot target type.

31. Click OK to add the SAN boot target.

32. From the vHBA drop-down menu, select Add SAN Boot Target.
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33. Keep 0 as the value for Boot Target LUN.
34. Enter the WWPN for fcp 11£02b.
35. Click OK to add the SAN boot target.

36. Expand CIMC Mounted Media and select Add CIMC Mounted CD/DVD.

Create Boot Policy ?

Name . | Boot-FC-Fabric-A
Description

Reboot on Boot Crder Change -

Enforce wNIC/VHBASISCSI Name : ¥

Boot Mode : [(®) Legacy Uefi

WARNIMNGS:

The type (primary/secondary) does not indicate a boot order presence.

The effective order of boot devices within the same device class (LAN/Storage/iSCSI) is determined by PCle bus scan order.

If Enforce vNIC/vHBA/fiSCSI Name is selected and the vNIC/VHBANSCSI does not exist, a config error will be reported.

If it is not selected, the vNICs/vHBAS are selected if they exist, otherwise the vNIC/vHBA with the lowest PCle bus scan order is used.

(= Local Devices Boot Order
4+ — T,Advanced Filter 4 Export % Print -I:I-
Add Local Disk
Name 4 VNIC/vHBA/ISCSI wNIC e WWN
Add Local LUN
Add Local JBOD Remote CD/DVD
Add SD Card w San 2
Add Internal USB » SAN Primary Fabric-A

2 dernal USE
Add External USBE > SAN Secondary Fabric-B

Add Embedded Local LUN
CIMC Mounted CD/DVD
Add Embedded Local Disk

Add Local C

Add Floppy

Add Local Floppy

37. Click OK, then click OK again to create the boot policy.

Create Service Profile Templates (FCoE Boot)

In this procedure, one service profile template for Infrastructure ESXi hosts is created for Fabric A boot.
To create the service profile template, complete the following steps:

1. In Cisco UCS Manager, click Servers on the left.
2. Select Service Profile Templates > root.

3. Right-click root.
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4. Select Create Service Profile Template to open the Create Service Profile Template wizard.

5. Enter VM-Host-Infra-FC-A as the name of the service profile template. This service profile template is
configured to boot from storage node 1 on fabric A.

6. Select the “Updating Template” option.

7. Under UUID, select UUID_Pool as the UUID pool.

Create Service Profile Template ? X

You must enter a name for the service profile template and specify the template type. You can also specify how a UUID will be assigned to this
Identify Service Profile Template template and enter a description.

Storage Provisioning Name : |VM-Host-Infra-FC-A

The template will be created in the following organization. Its name must be unique within this organization.
Networking Where © org-root

The template will be created in the following organization. Its name must be unique within this organization.

SAN Connectivity Type Inttial Template () Updating Template
Specify how the UUID will be assigned to the server associated with the service generated by this template.
uuiD
Zoning
vNIC/vHBA Placement UUID Assignment UUID-Pool(16/16) v
The UUID will be assigned from the selected pool.
vMedia Policy The available/total UUIDs are displayed after the pool name.

Server Boot Order
Optionally enter a description for the profile. The description can contain information about when and where the service profile should be used.
Maintenance Policy

Server Assignment

Operational Policies

Next > m Cancel

8. Click Next.

Configure Storage Provisioning

1. If you have servers with no physical disks, click on the Local Disk Configuration Policy and select the
SAN-Boot Local Storage Policy. Otherwise, select the default Local Storage Policy.

2. Click Next.

Configure Networking Options

1. Keep the default setting for Dynamic vNIC Connection Policy.
2. Select the “Use Connectivity Policy” option to configure the LAN connectivity.

3. Select FC-Boot from the LAN Connectivity Policy drop-down list.
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4. Leave Initiator Name Assignment at <not set>.

Create Service Profile Template ?

Optionally specify LAN configuration information.
Identify Service Profile

Template
Dynamic vNIC Connection Policy:) Select a Policy to use (no Dynamic vNIC Policy by default) v
Storage Provisioning

Create Dynamic vNIC Connection Policy

Networking
How would you like to configure LAN connectivity?
SAN Connectivit: . . .
v () Simple () Expert () No vNICs (&) Use Connectivity Policy
Zoning LAN Connectivity Policy © | FC-Boot v Create LAN Connectivity Policy

Initiator Name

wNIC/vHBA Placement
Initiator Name Assignment =<not set> A

vMedia Policy Create ION Suffix Pool

WARNING: The selected pool does not contain any available entities.,

Server Boot Order You can select it, but it is recommended that you add entities to it.

Maintenance Policy
Server Assignment

Operational Policies

< Prev Next > m Cancel

5. Click Next.

Configure Storage Options
To configure the storage options, complete the following steps:

1. Select the Use Connectivity Policy option for the “How would you like to configure SAN connectivity?”
field.

2. Pick the FC-Boot option from the SAN Connectivity Policy drop-down list.
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Create Service Profile Template

Optionally specify disk policies and SAN configuration information.
Identify Service Profile

Template
How would you like to configure SAN connectivity?

e ) Simple () Expert{_) No vHBAs (e) Use Connectivity Policy
Storage Provisioning - - - -

SAMN Connectivity Policy © | FC-Boot v Create SAN Connectivity Policy
MNetworking
SAN Connectivity
Zoning
vNIC/vHBA Placement
vMedia Policy
Server Boot Order
Maintenance Policy

Server Assignment

Operational Policies

< Prev Next > m

?

Cancel

3. Click Next.

Configure Zoning Options

1. Set no Zoning options and click Next.

Configure vNIC/HBA Placement

1. Inthe “Select Placement” list, leave the placement policy as “Let System Perform Placement”.
2. Click Next.

Configure vMedia Policy

1. Do not select a vMedia Policy.
2. Click Next.

Configure Server Boot Order

1. Select Boot-FC-Fabric-A for Boot Policy.
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Create Service Profile Template ¥

Optionally specify the boot policy for this service profile template.
Identify Service Profile

Template
Select a boot policy.

Storage Provisioning Boot Policy:| Boot-FC-Fabric-A v Create Boot Policy

MName . Boot-FG-Fabric-A
Networking Description

Reboot on Boot Order Change  © No
SAN Connectivity Enforce vNIC/VHBASISCSI| Name : Yes

Boot Mode © Legacy
Zoning WARNINGS:

The type (primary/secondary) does not indicate a boot order presence
The effective order of boot devices within the same device class (LAN/Storage/iSCSI) is determined by PCle bus scan order.
If Enforce vNIC/vHBASiSCSI Name is selected and the vNIC/AHBANSCS! does not exist, a config error will be reported.

NIC/vHBA PI t
NI acemen If it is not selected, the vNICs/vHBAS are selected if they exist, otherwise the wNIC/VHBA with the lowest PCle bus scan order is used.

Boot Order
wvMedia Policy
+ — YsAdvancedFilter 4 Export /& Print 'K!‘
P T Name Order &  wNIC/VHBE.. Type WWN LUN Mame  Slot Mum... Boot Name Boot Path Description
- o TaonC—~ FInTEry
. . Prirmary 20:01:00:.. 0
Maintenance Policy fimary !
Secondary 0
Server Assignment w SA Fabric-B Secondary
Primary 20:02:00.... 0

Operational Policies
Secondary  20:03:00: 0

< Prev Mext > m Cancel

2. Click Next to continue to the next section.

Configure Maintenance Policy

1. Change the Maintenance Policy to default.
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Identify Service Profile
Template

Storage Provisioning

MNetworking

SAN Connectivity

Zoning

vNIC/vHBA Placement

vMedia Policy

Server Boot Order

Maintenance Policy

Server Assignment

Operational Policies

Create Service Profile Template

7 X

Specify how disruptive changes such as reboots, network interruptions, and firmware upgrades should be applied to the server associated with this

service profile.

(=) Maintenance Policy

Select a maintenance policy to include with this service profile or create a new maintenance policy that will be accessible to all service profiles.

Maintenance Policy: dafaull v

MName
Description

Soft Shutdown Timer

Storage Config. Deployment Policy -
© User Ack

Reboot Policy

. default

: 150 Secs

User Ack

Create Maintenance Policy

< Prev Next >

Cancel

2. Click Next.

Configure Server Assignment
To configure server assignment, complete the following steps:

1. Inthe Pool Assignment list, select Infra-Pool.

2. Select Down as the power state to be applied when the profile is associated with the server.

3. Optional: select “B200-M5” for the Server Pool Qualification to select only B200 M5 servers in the pool.

4. Expand Firmware Management at the bottom of the page and select the default policy.
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Create Service Profile Template ¥

Optionally specify a server pool for this service profile template.
Identify Service Profile

Template
You can select a server pool you want to associate with this service profile template.
Storage Provisioning Pool Assignment:| |nfra-Pool w Create Server Pool
N i Select the power state to be applied when this profile is associated
etworking with the server.

SAN Connectivity
Zoning The service profile template will be associated with one of the servers in the selected pool.

If desired, you can specify an additional server pool policy qualification that the selected server must meet. To do so, select the guahfication from

the list.
vNIC/vHBA Placement o

Server Pool Qualification © | <pot set> w

vMedia Policy Restrict Migration =

(=) Firmware Management (BIOS, Disk Controller, Adapter)
Server Boot Order -
If you select a host firmware policy for this service profile, the profile will update the firmware on the server that it is associated with.

. ) Otherwise the systemn uses the firmware already installed on the associated server.
Maintenance Policy

Host Firmware Package: default

Server Assignment
Create Host Firmware Package

Operational Policies

< Prev Mext > m Cancel

5. Click Next.

Configure Operational Policies
To configure the operational policies, complete the following steps:

1. In the BIOS Policy list, select VM-Host.

2. Expand Power Control Policy Configuration and select No-Power-Cap in the Power Control Policy list.
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3.

4.

Create Service Profile Template

Optionally specify information that affects how the system operates.
Identify Service Profile

Template
(= BIOS Configuration

Storage Provisioning

Networking BIOS Paolicy © | WM-Host w
SAN Connectivity

(#) External IPMI Management Configuration
Zoning

) Management IP Address
vNIC/vHBA Placement

(# Monitoring Configuration (Thresholds)
vMedia Policy

(=) Power Control Policy Configuration

Server Boot Order . o i i o R
Power control policy determines power allocation for a server in a given power group.

Power Control Palicy © | No-Power-Cap v Create Power Control Policy
Maintenance Policy
Server Assignment (@ Scrub Policy
Operational Policies # KVM Management Policy
< Prev

If you want to override the default BIOS settings, select a BIOS policy that will be associated with this service profile

v

Click Finish to create the service profile template.

Click OK in the confirmation message.

Create vMedia Service Profile Template

To create service profiles from the service profile template, complete the following steps:

1.

2.

Connect to UCS Manager, click Servers on the left.

Select Service Profile Templates > root > Service Template VM-Host-Infra-FC-A.
Right-click Service Template VM-Host-Infra-FC-A and select Create a Clone.
Name the clone VM-Host-Infra-FC-A-vM and click OK.

Select Service Template VM-Host-Infra-FC-A-vM.

In the right pane, select the vMedia Policy tab.

Under Actions, select Modify vMedia Policy.

Using the drop-down list, select the ESXi-6.5-HTTP vMedia Policy.
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9. Click OK then OK again to complete modifying the Service Profile Template.

Create Service Profiles

To create service profiles from the service profile template, complete the following steps:

1. Connect to UCS Manager, click Servers on the left.

2. Select Service Profile Templates > root > Service Template VM-Host-Infra-FC-A-vM.
3. Right-click VM-Host-Infra-FC-A-vM and select Create Service Profiles from Template.
4. Enter VM-Host-Infra-0 as the service profile prefix.

5. Enter 1 as “Name Suffix Starting Number.”

6. Enter 2 as the “Number of Instances.”

7. Click OK to create the service profiles.

Create Service Profiles From Template ? X

Maming Prefix | VM

Mame Suffix Starting Mumber @ | 1

Mumber of Instances o s

8. Click OK in the confirmation message.

Add More Servers to FlexPod Unit

Additional server pools, service profile templates, and service profiles can be created in the respective
organizations to add more servers to the FlexPod unit. All other pools and policies are at the root level and
can be shared among the organizations.

Gather Necessary Information

After the Cisco UCS service profiles have been created, each infrastructure server in the environment wiill
have a unique configuration. To proceed with the FlexPod deployment, specific information must be
gathered from each Cisco UCS server and from the NetApp controllers. Insert the required information into
Table 8 and Table 9 .
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Table 8 WWPNs from NetApp Storage

SVM Target LIF WWPN (FC)
Infra-SVM fcp_lif0la

fcp_lif01b

fcp_lif02a

fcp_lifo2b

# To obtain the FC WWPNSs, run the network interface show command on the storage cluster manage-
ment interface.

Table 9 FC WWPNs for Fabric A and Fabric B

Cisco UCS Service Profile Name Initiator: WWPNs (FC) Variables

VM-Host-Infra-01 <vm-host-infra-01-wwpna>

<vm-host-infra-01-wwpnb>

VM-Host-Infra-02 <vm-host-infra-02-wwpna>

<vm-host-infra-02-wwpnb>

# To obtain the FC vHBA WWPN information in Cisco UCS Manager GUI, go to Servers > Service Profiles >
root. Click each service profile and then click the “Storage” tab, then “vHBAs” tab on the right. The WWPNs
are displayed in the table at the bottom of the page.

AddDirect Connected Tenant FCoE Storage

To add FCoE storage from an additional storage SVM, two storage connection policies, one for each fabric
must be added in Cisco UCS Manager and attached to VHBA Initiator Groups in the SAN Connectivity Policy.
These steps were not shown in the initial deployment above because it is not necessary to zone boot
targets. Boot targets are automatically zoned in the fabric interconnect when zoning is enabled on the fabric
VSAN. To add direct connected tenant FCoE storage from a tenant SVM, complete the following steps:

Create Storage Connection Policies

In this procedure, one storage connection policy is created for each fabric.
To create the storage connection policies, complete the following steps:

1. In Cisco UCS Manager, click SAN on the left.

2. Right-click SAN > Policies > root > Storage Connection Policies and select Create Storage Connection
Policy.

3. Name the policy to indicate a tenant on Fabric A.

4. Select the Single Initiator Multiple Targets Zoning Type.
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10.

11.

12.

13.

14.

15.

16.

17.

Click Add to add a target.

Enter the WWPN of the first fabric A FCoE LIF in the tenant SVM connected to fabric interconnect A. Se-
lect Path A and VSAN VSAN-A. Click OK.

Click Add to add a target.

Enter the WWPN of the second fabric A FCoE LIF in the tenant SVM connected to fabric interconnect A.
Select Path A and VSAN VSAN-A. Click OK.

Click OK then click OK again to complete adding the Storage Connection Policy.

Right-click SAN > Policies > root > Storage Connection Policies and select Create Storage Connection
Policy.

Name the policy to indicate a tenant on Fabric B.
Select the Single Initiator Multiple Targets Zoning Type.
Click Add to add a target.

Enter the WWPN of the first fabric B FCoE LIF in the tenant SVM connected to fabric interconnect B. Se-
lect Path B and VSAN VSAN-B. Click OK.

Click Add to add a target.

Enter the WWPN of the second fabric B FCoE LIF in the tenant SVM connected to fabric interconnect B.
Select Path B and VSAN VSAN-B. Click OK.

Click OK then OK again to complete adding the Storage Connection Policy.

Map Storage Connection Policies VHBA Initiator Groups in SAN Connectivity Policy

In this procedure, storage connection policies are mapped to VHBA initiator groups for each fabric.

To create the storage connection policy mappings, complete the following steps:

1.

2.

In Cisco UCS Manager, click SAN on the left.

Select SAN > Policies > root > SAN Connectivity Policies > FC-Boot.
In the center pane, select the vHBA Initiator Groups tab.

Click Add to add a vHBA Initiator Group.

Name the group Fabric A and select the Fabric A Initiator.

Use the pulldown to select the Fabric A Storage Connection Policy.
Click OK and OK to complete adding the Initiator Group.

Click Add to add a vHBA Initiator Group.
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9. Name the group Fabric B and select the Fabric B Initiator.
10. Use the drop-down list to select the Fabric B Storage Connection Policy.

11. Click OK and OK to complete adding the Initiator Group.

FlexPod Backups

Cisco UCS Backup

Automated backup of the UCS domain is important for recovery of the UCS Domain from issues ranging
catastrophic failure to human error. There is a native backup solution within UCS that allows local or remote
backup using FTP/TFTP/SCP/SFTP as options.

Backups created can be a binary file containing the Full State, which can be used for a restore to the original
or a replacement pair of fabric interconnects. Alternately this XML configuration file consisting of All
configurations, just System configurations, or just Logical configurations of the UCS Domain. For scheduled
backups, options will be Full State or All Configuration, backup of just the System or Logical configurations
can be manually initiated.

Specification of the backup can be done by completing the following steps within the Cisco UCS Manager
GUI:

1. Select Admin within the Navigation pane and select All.
2. Click on the Policy Backup & Export tab within All.
3. For a Full State Backup, All Configuration Backup, or both, specify the following:

a. Hostname : <IP or FQDN of host that will receive the backup>
b. Protocol: [FTP/TFTP/SCP/SFTP]

User: <account on host to authenticate>

o o

Password: <password for account on host>
e. Remote File: <full path and filename prefix for backup file>
f. Admin State: <select Enable to activate the schedule on save, Disable to disable schedule on save>

g. Schedule: [Daily/Weekly/Bi Weekly]
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Al

General Policy Backup & Export

Full State Backup Policy

Hostname 10.1.158.150

Pratocol FTP TFTP (=) SCP SFTP

User : | root

Password @ sessssss

Remate File ~onfigs/ucs/6332 full
Admin State Disable (e Enable

Schedule Daily Weekly () Bi Weskly

MaxFiles : 0

Description Database Backup Policy

All Configuration Backup Policy

Hosmname : | 10.1.156.150

Protocol : FTP TFTP (s} SCP SFTP

User roat

Password  © sessssss

Remote File : fi 332.config
Admin State : Disable (e Enable

Schedule  : |le) Daily | Weekly () Bi Weekly

Max Files o

Description : | Configuration Export Polcy

Backup/Export Config Reminder

Admin State -

Save Changes Reset Values

4. Click Save Changes to create the Policy.

Cisco Nexus Backups

The configuration of the Cisco Nexus 9000 switches can be backed up manually at any time with the copy
command, but automated backups can be put in place with the NX-OS feature scheduler. An example of
setting up automated configuration backups of one of the FlexPod 9332PQ switches is shown below:

bb04-9332-a# conf t

Enter configuration commands, one per line. End with CNTL/Z.
bb04-9332-a(config)# feature scheduler

bb04-9332-a (config)# scheduler logfile size 1024
bb04-9332-a (config)# scheduler job name backup-cfg

bb04-9332-a (config-job)# copy running-config
tftp://192.168.156.155/9332/$ (SWITCHNAME) —cfg.$ (TIMESTAMP) vrf management
bb04-9332-a(config-job)# exit

bb04-9332-a (config)# scheduler schedule name daily

bb04-9332-a (config-schedule)# job name backup-cfg
bb04-9332-a(config-schedule) # time daily 2:00
bb04-9332-a (config-schedule) # end
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Show the job that has been setup:

bb04-9332-a# sh scheduler job
Job Name: backup-cfg

copy running-config tftp://192.168.156.155/9332/$ (SWITCHNAME) -cfg.$ (TIMESTAMP) vrf

management

bb04-9332-a# show scheduler schedule
Schedule Name : daily

admin
Run every day at 2 Hrs 0 Mins

User Name
Schedule Type

Last Execution Time Sun Apr 9 02:00:00 2017
Last Completion Time: Sun Apr 9 02:00:01 2017
Execution count : 3

Job Name Last Execution Status
backup-cfg Success (0)

For detailed information about the feature scheduler, see:

http://www.cisco.com/c/en/us/td/docs/switches/datacenter/nexus9000/sw/7-

x/system_management/configuration/quide/b_Cisco_Nexus 9000 _Series_NX-

OS_System_Management_Configuration_Guide_7x/b_Cisco_Nexus_9000_Series NX-

OS_System_Management_Configuration_Guide_7x_chapter_01010.html

VMware VCSA Backup

Basic backup of the vCenter Server Appliance is also available within the native capabilities of the VCSA,
though within the default solution this is manually initiated provide a scheduled solution. To create a backup,

complete the following steps:

1. Connect to the VCSA Console at https://10.1.156.100 IP>:5480.

€ ) D& https//100,156.100:5480/ 2/ appliance/summaryTlocalesen [

vCenter Server Appliance

Navigator il Summary
W Summary Hostname: nx-ve.flexpod.cisco.com
Type: wCenter Server with an embedded Platform Services
B Access f’ﬂ Controller
Product: Viware vCenler Server Appliance
& Networking Version: 6.5.0,5600
@) Time
& Update = Hedalth Status ~ Single Sign-On
Ovarall Health - Good Single Sign-0n Domain
, Agministration Last Health Check TRRTR017, 12:53:09 PM Status
crU @ cood
[ig Syslog Configuration Memary & Good
Database @ cood

HEB cPu ang Memory

[i Database = Health Messages

Mo Messages Available.

Create Support Bundle Reboot Shutdown

vsphere local

Running

2. Click Backup within the Summary section to open up the Backup Appliance Dialogue.
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3. Specify:

a. the Protocol to use [HTTPS/HTTP/SCP/FTPS/FTP]

b. location of an empty directory to be used for the backup

c. the User name and password

Backup Appliance

1 Enter backup details
2 Select parts to backup

3 Ready to complete

Enter backup details
Specify the location details and credentials to establish connection with the server. Optionally, encrypt your backup.

Protocol: SCP v

Location: 10.1.156.150/var/www/html/bears/configs/ucs |
Part 22

User name: root

Password: | ........

|| Encrypt Backup Data

MNext Cancel

4. Click Next.

5. De-select some parts if they should be excluded from the backup.
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Backup Appliance

Select paris to backup

1 Enter backup details _ ) ) -
S B Selectfiles you want to backup and optionally provide a description for your backup.
2 Select parts to backup - - . . : L .
A minimum set of data needed to restore the appliance will be backed up by default. This includes data such as OS, VC
services and Inventory. In addition to this, you can also choose to backup additional parts below
3 Ready to complete

Parts
¥ common Inventory and configuration. 532 MB
o Stats, Events, Historical data (Statistics, Events and Tasks) in vCenter 34 MB
Alarms, and Server database
Tasks
Description

Back Mext Cancel

6. Click Next.
7. Review the options selected and click Finish to begin the backup.

Restoration can be initiated with the backed up files using the Restore function of the VCSA 6.5 Installer.

Breakout Interface Configuration in the Cisco Nexus 9332PQ Switches

The 40Gb end to end FlexPod design in this document uses a pair of Nexus 9332PQ which is built with all
ports being of the 40 Gbps Quad Small Form Factor Pluggable Plus (QSFP+) type. If there is a need to
directly support a 10Gb Small Form Pluggable Plus (SFP+), this can be configured within the switch, and
connected to the 10Gb SFP+ device using a supported QSFP+ Breakout Cable.

Configuration of the QSFP+ ports will use the interface breakout command as shown in this example to turn
the 40G interface Ethernet 1/1 into 4x10G interfaces:

bb04-9332-a (config)# show running-config interface Ethernetl/1l

interface Ethernetl/1
no switchport

bb04-9332-a (config)# interface breakout module 1 port 5 map 10g-4x
bb04-9332-a(config)# show running-config interface Ethernetl/1/1-4
interface Ethernetl/1/1

interface Ethernetl/1/2
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interface Ethernetl/1/3

interface Ethernetl/1/4

Breakout configurations that are no longer needed can be reverted with the no interface breakout command:

bb04-9332-a(config)# no interface breakout module 1 port 1 map 10g-4x

bb04-9332-a (confiqg) #

Cisco Workload Optimization Manager (CWOM) Addition to a FlexPod

CWOM Autonomic Platform continuously analyzes application workload compute, storage and network
resource demand across private or public clouds in real time and matches it to the underlying infrastructure
supply. The platform assures the performance of application workloads while maximizing utilization. With
real-time and automatable placement, scaling and provisioning decisions provided by CWOM, operators are
empowered to proactively manage the environment, ensuring performance, rather than tracking down alerts
and trying to interpret the meanings of dashboards and reports.

Workload management allows for automatic execution of placement, scaling and provisioning actions. It
identifies actions the user can take to drive the environment to its Desired State - where performance is
assured. The user can perform actions manually, direct CWOM to perform the actions on command (e.qg.
based on a change management process), or direct CWOM to perform actions automatically as they arise.

Execution of the actions ensures workloads are continuously matched with the available shared resources to
assure the performance of business-critical applications. Operational policies and service priorities are also
continuously adhered to. As a result, the platform significantly reduces the time required to manage the
environment and resolve minor or major issues common in today’s large scale and highly dynamic cloud
environments.
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Figure 7  Architecture for Cisco Workload Optimization Manager
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CWOM - Minimum Requirements

You can run Workload Optimization Manager on host the to meet the following minimum requirements:

Supported Hypervisors

Storage Requirements

Memory

CPUs

VMware vCenter version
4.X,5.X,6.x

150 GB or greater disk
storage+swap space to
match the RAM allocation

16 GB

2vCPUs-4 vCPUs
Preferred

‘ﬁ Minimum requirements depend on the size of your environment's inventory. The more data stores, hosts, VMs,
and applications. you have, the more resources you need to run the installation effectively. Also note that other
management software might recommend that you run the Workload Optimization Manager VM with lower re-
sources. Please be sure to give Workload Optimization Manager enough resources, using the guidelines

above

CWOM Installation and Configuration

Download VMWare ovf based image of Cisco Workload Optimization Manager from the following link:

https://software.cisco.com/download/release.html?mdfid=286316697&flowid=82751&softwareid=2863170

11&release=1.0.0&relind=AVAILABLE&rellifecycle=&reltype=latest

To install and configure Cisco Workload Optimization Manager, complete the following steps:

1. Through the vSphere client, connect to vCenter installed which is installed on your management network.

252


https://software.cisco.com/download/release.html?mdfid=286316697&flowid=82751&softwareid=286317011&release=1.0.0&relind=AVAILABLE&rellifecycle=&reltype=latest
https://software.cisco.com/download/release.html?mdfid=286316697&flowid=82751&softwareid=286317011&release=1.0.0&relind=AVAILABLE&rellifecycle=&reltype=latest

Appendix

2. Right-click and select Deploy OVF Template, select Local File, and choose Browse to navigate to the lo-
cation of the downloaded OVA file.

¥4 Deploy OVF Template

4 1 Selecttemplate Selecttemplate
| Select an OVF template

2 Selectname and location

Enter a URL to download and install the OVF package from the Internet, or browse to a location accessible from your computer,
such as a local hard drive, a network share, or a CD/DVD drive.

5 Selectstorage URL

) Local file
| Browse... | 1file(s)selected, click Next to validate

A\ Use multiple selection to select all the files associated with an OVF template (.ovf, vmdk, etc.)

Next Cancel

3. Select the OVA file then click Next.
4. Select name and location for the CWOM and Click Next.

5. In select resource page, Host/Cluster, click Next.
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@ Deploy OVF Template 2 »
+ 1 Selecttemplate Review details
Verify the template details.
+ 2 Selectname and location
v 3 Selecta resource Publisher @ No certificate present
4 Review dotnlls Download size 17GB
5 Accept license agreements i X 26 GB (thin provisioned)
Size on disk 150.0 GB fthick isioned
6 Selectstorage : ithick provisioned)
7 Select networks
& Readyto complete
Back Next Cancel )
6. Click Next after Review detail.
7. Click on Accept EULA Agreement and click Next.
¥4 Deploy OVF Template. o
+ 1 Selecttemplate Accept license agreements
Read and accept the license agreements associated with this template before continuing.
v 2 Selectname and location
v 3 Selecta resource
V' 4 Review defails TURBONOMIC END-USER LICENSE AGREEMENT -
5 Acceptlicense agreements Note to user: In this document, "You™ means the licensee of the Software and "Turbonomic™ means Turbonomic, Inc., the Licensor N
6 Selectstorage of the Software.
7 Selectnetworks BEFORE YOU DOWNLOAD AND USE TURBONOMIC VIRTUAL APPLIANCE PRODUCTS AND
ANY RELATED DOCUMENTATION, INCLUDING USER MANUALS (COLLECTIVELY THE
8 Readyto compiete "SOFTWARE"), PLEASE CAREFULLY REVIEW ALL TERMS AND CONDITIONS IN THIS
END-USER LICENSE AGREEMENT ("AGREEMENT") AND BE SURE YOU UNDERSTAND
THEM. CHOOSING "l ACCEPT", OR PROCEEDING WITH THE DOWNLOAD AND USING
THE SOFTWARE IN ANY WAY INDICATES YOUR ACKNOWLEDGEMENT THAT YOU
HAVE READ THIS LICENSE AGREEMENT, THAT YOU UNDERSTAND IT, AND THAT YOU
AGREE TO BE LEGALLY BOUND BY ITS TERMS. IF YOU ARE ENTERING THIS
AGREEMENT ON BEHALF OF A COMPANY OR OTHER ORGANIZATION, YOU ARE
REPRESENTING AND WARRANTING THAT YOU ARE AUTHORIZED TO BIND SUCH
COMPANY OR ORGANIZATION. IF YOU DO NOT AGREE TO ANY OF THE TERMS AND
CONDITIONS LICENSE AGREEMENT YOU MUST NOT CHOOSE "I ACCEPT" CR
DOWNLOAD THE SOFTWARE.
1. Title, Intellectual Property Rights. The Software furnished under this Agreement is licensed, not sold
or transferred, to you and is protected by the copyright, patent and trade secret laws of the United States
and international treaties, and is subject to export control laws and regulations of the United States. =
[ Accept |
Back Next Cancel
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8. Select virtual disk format as “Thin Provisioning” and then select your Datastore.

¥¢ Deploy OVF Template (?)
v 1 Selectiemplate Selectstorage
Select location to store the files for the deployed template
" 2 Selectname and location
+ 3 Selecta resource Select virtual disk format: | Thin provision =
v 4 Rewvew details VM storage policy. | MNone -
~ 5 Acceptlicense agreements )

D Show datastores from Storage DRS clusters i ]

6 Selectstora —
Firer

7 Selectnetworks .
[ Datastores | Datastore Clusters

& Readyto complete

® (& (q Filer -
Name Status VM siorage policy Capacity Frea
(U B datastore1 & Mormal VM Encryption F._. 75 GB 347 GB
= B infra_datastore_1 & MNormal = 550 GB 301.52 GB
i B infra_datastore_2 & Normal - 550 GB 42719 GB
4 . L
] 3 Objects [{5Copy~
Back Next Cancel
9. Select your virtual network and click Next.
10. Review your configuration and click Finish to deploy CWOM.
#g Deploy OVF Template (7) "
+ 1 Selectemplate Readyto complete
Review configuration data,
+ 2 Selectname and location
v 3 Selecta resource Name R%-CWOT
v 4 Review details Source VM name cwom&4-opsmgr-1.0.0.0
" 5 Acceptlicense agreements Download size 1.7 GB
v 6 Selectstorage Size on disk 26GB
T Selectnetworks Datacenter MX-FlexPod-DC
b & Readyio complete Resource nx-esxi-01 flexpod.cisco.com
v Storage mapping 1
+ Network mapping 1
» IP allocation settings IPv4, Static - Manual
Back Finish Cancel |
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CWOM Initial Setup

Many installations use DHCP for dynamic IP address allocation. You can also specify a static address via the
virtual machine’s IP configuration. Workload Optimization Manager includes a script to assist you with this.
As root, run ipsetup from the command line. If you need to execute the action manually, follow the steps
listed:

To specify a static IP address, complete the following steps:

1. Turn On and Open a console window to the Workload Optimization Manager VM.
2. Default login as : root

Password : vmturbo

cwomb4-opsmgr-1.0.0.0 - VMware Remote Console

VMRC ~ -~ & I €

urbonomic login:

3. After root login.

4. Write “ipsetup” to assign the ip address. System will open IP assignment wizard.

5. Do you want to user DHCP or set a static IP (dhcp/static):: static

6. Please enter the IP Address for this machine :: IP Address from OOB Mgmt. Network
7. Please enter the network mask for this machine :: sunbet mask of OOB Mgmt. Network

8. Please enter the Gateway address for this machine :: Gateway of OOB Mgmt. Network
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9. Enter DNS Server(s) IP Address for the machine (Separate from each other by a space) :: DNS Server ip
address

10. Enter Domain name for this machine:: domain name of the CWOM
11. Do you sure you want to use these settings? (y/n) :: y
12. Do you want to configure Proxy Server? (y/n) ::n

13. Do you want to restart network the network now? (y/n) y

# Give your Proxy Server setting, if you want to configure your proxy server.

cwom64-opsmgr-1.0.0.0 - VMware Remote Console [= o S|

VMRC ~ » o 1 &
Thu Jul

honomic ™

:18.1.156.2

Enter Domain Name for this machine :: cwom.flexpod.

1 to configure, youw will be disconnected from the se
56.21 after 38 seconds

Operations Manager is now running with IP: 18.1.156.21

[root@turbonomic ™1

14. To verify the given network information, write “ifconfig eth0” and close console connection.

CWOM NTP Server Configuration

It is important that you synchronize the clock on the Workload Optimization Manager server with the devices
on the same network. You will specify the timeserver or servers that Workload Optimization Manager will use
to synchronize its clock. You should also set the system clock to your current time zone. Workload
Optimization Manager runs regular data maintenance processes. To minimize performance impact, it runs
these processes at night. To ensure that these processes run at the proper local time, you should
synchronize the VM with your local time zone.
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Workload Optimization Manager includes a script to assist you with this. As root, run timesync from the
command line. If you need to execute the action manually, complete the following steps:

1. Open a console window to the Workload Optimization Manager VM, using the SSH user created during
installation.

2. Execute the vi/etc/chrony.conf command.
3. This opens up the configuration file for chrony.

4. Replace the timeservers found at the bottom of the file with your timeservers.

# Enable kernel RTC synchronization.
rtcsync

# In first three updates step the system clock instead of slew
# if the adjustment is larger than 18 seconds.
makestep 18 3

# Allow MTP client access from local network.
#allow 192.1468/714

# Listen for commands only on localhost.

bindcmdaddress 127.8.8.1
bindcmdaddress ::1

# Serve time ewven if not synchronized to any NTP server.
#local stratum 18
server B.centos.pool.ntp.org iburst

keyfile fetc/chrony.keys

# Specify the key used as password for chronyc.
commandkey 1

5. Execute the systemctl restart chronyd command.
6. This restarts the chrony service.

CWOM Opening Ports
To use the Cisco Workload Optimization Manager in your environment, open the following ports:

Port: To Support
80 Incoming browser connections over HTTP
443 e Incoming browser connections over HTTPS

e Proactive Support (automatically generate support tickets for Cisco Workload
Optimization Manager issues)
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For browser connection with the server, you should use either port 80 or 443

# Various targets that you use with Cisco Workload Optimization Manager may require you to open ports on
those targets servers to allow communications with CWOM.

CWOM License Installation and First Time Login

To use Cisco Workload Optimization Manager, open a Web browser to the IP Address of the installed VM,
and complete the following steps:

1. Connect to your Workload Optimization Manager server via a Web browser.
2. Log into Workload Optimization Manager.

By default you can use the following credential:
Username: administrator
Password: vmturbo

3. As you perform the initial login, you will be prompted to change the password for the administrator ac-
count. To continue, provide the new password for this account.

User Login

ol I I I L]
CISCO
Cisco Workload Optimization Manager

Usar Nama:

Create your new password
Mew Rassword:

[ kees me 1egged in

| enfirn |

¥ou must change your password.

4. Wizard will be open the License Installation, Target Configuration, and Email setup.
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Sepory Cran worsoed Dwptoy o B vwatmry samn Poiny Bepors + Qe a
Wink (0« 0 uf 8 rw—y) ocRang =
Ahewm AN 7
x
am | o=
Try our new User Interface
—_ 5:VMs_Beta\Clus,
A This wizard will walk you through the following configuration steps: 2ure-o T
(/ O 1. Ucense Installation
s TR 2. Tergét Configiration CREATE RESERVAT?
@ i ‘ 3. Email Notification Setup
Hean - Prpwiia Machines v arre |4 Setting Nutad Comvargame osnn =
pu . . -
Dynamic Supply jal Placement
Pravious | | Next || rinioh
TRY NOW
Maybe later
[] Don't show again
Time

= | |

5. Click Next for your License Installation.

6. Select License type and click Next.

s

Wintual Maching

b

O

ual Dats Corter

Phycal Machine

Try our new User Interface

:\VMs_Beta\Clus.

b on azure-dec-southc

License Installation

O I have a license for full product
O I would like to request a license for a 30-day trial
O I would like to request a license for the free Virtual Health Monitor

'
© 1 O I would like to request a license for the free Operations Manager Lite

al Placement

Dynamic Supply

Previous | Next | | Finish |

TRY NOW

Maybe later

[] Don't show again

CREATE RESERVATI

7. Install your license.
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# For a first run of the CWOM product, you will see a wizard that directs you to install your license.

8. If you have already received a license, choose | have a license for full product and continue with Wiz-
ard. At the License Page of the wizard copy and paste your license key information (sent to you in a sep-
arate email) into the license window. Then complete wizard.

9. If you want to try out the full-featured product for 30 days, choose | would like to request a license for a
30-day trial. Or to try Virtual Health Monitor edition, choose | would like to request a license for the free
Virtual Health Monitor. When you continue, the wizard displays a form you can fill out to request a li-
cense. Cisco will send you an email message with license data. Copy and paste your license key infor-
mation into the license window, and then complete the wizard.

10. Copy and paste your license and Click Save.

Trr avir meaar | lear Intarfana

License Installation

Copy and paste the text string contained in the license.xmil file, then click Save to validate:

<
| Save | | Clear

Dynamic ment

Previous

11. When License Validation Succeed Click Next for Target Configuration.
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Trinur naullear Intarface
License Installation
labies Conflouration. |
Licensed Product Licsnse Validatien
. Proceed with
action_scipt | configuration AVGVMs_Beta\Clus.
1 actve_drestory
oggmgmion
apolcatons
* automated_sctions CREATE RESERVATY
ﬁ;. doud_cost

Dynamic Initial Placement

Pravious Next |

Maybe lutar

12. In Target Configuration page, click Add.

x
Target Configuration
Targets
Name Or IP Address Username Target Type Target Status Validation Time

Environment Summary |

B Dpiscovered | Activevms || PowerOff vMs Suspended VMs | Unknown State VMs
] 20 40 &0 B0 100

| Previous || Next || Finish

13. Select your Target type and give the credential detail to add the Target. For instance, select vCenter to
Add VMware vCenter Account:
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14. Click Add.
15. Click Apply .
Target Configuration
— TargetType —— ) \Center () RHEV-M () XenServer () Hyper-V () IBM PoweryM
== Cloud Management Address v]e
= Paas Username administrator@flexpodlabl.com #
= Load Balancer Password | % sk kak #
[~ Storage
Al Fabric )
—— Pending targets
2 Network
Edit Delete
I
Name Or IP Address Username Target Type
administrator@flexpodlabl.com vCenter
=
Previous | | Next | | Finish |

Target will be Added.
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Target Configuration

Targets
© Add Edit Delete 3 | Rediscover All | | Validate Al
MName Or IP Address Username Target Type Target Status Validation Time
administrator@flexpodlabl.co vCenter Validated Mon Jun 26 11:38:32 GMT-07
Environment Summary
. Discovered || ActiveVMs [] PowerOff VMs Suspended VMs || Unknown State VMs
a 20 40 &0 80 100

| Previous || Next || Finish

16. Click Add to Add the Next Target.
17. Click Fabric and Select Cisco UCS Account to added it as Target in CWOM.

18. Provide Cisco UCS Manager Account Credentials to add it:
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Target Configuration

— Target Type (=) Cisco UCS (_) Cisco UCS Central (_) HP OneView
53 Hypervisor
s Cloud Management Add ZI e
= Pa2S Username admin #*
' Load Balancer Password | ®x%xx ™
1 Storage
,‘ Fabric Address: Address of UCS target

Username: User name to use to connect to a target
3 Network Password: Password to use to connect to a target

—— Pending targets
Name Or IP Address Username Target Type
admin Cisco UCS
=
| Previous | | Next | | Finish |

19. Click Add and Apply.
20. Select Target type as Storage to Add the Storage controller in CWOM.
21. Provide your Storage Credential to add it in CWOM.

22. Click Add and then click Apply.

265



Appendix

Target Configuration
— Target Type ——— (+) NetApp () EMCVNX () HP3PAR () Pure Storage () Nutanix ( ) EMC XtremlO () Dell Compellent () EMC VMAX () EMC Scalel0
£S5 Hypervisor
s Cloud Management Address | ——— j‘
= P25 Username admin #*
= Load Balancer Password  *EsssEkkk® #
il Fabric __ pending ta
5 Network
Edit Delete
Name Or IP Address Username Target Type
admin NetApp
| Previous | | Next | | Finish |

23. Confirm your Target under Target detail.

Target Configuration
Targets
© Add Edit Delete ter by Target Type 3 Rediscover All | | validate Al
Name Or IP Address Username Target Type Target Status Validation Time

administrator@flexpoadlabl.co vCenter Validated Mon Jun 26 11:38:32 GMT-07
admin Ciseo UCS Validated Mon Jun 26 11:48:04 GMT-07
admin NetApp Validated Mon Jun 26 11:54:20 GMT-07

Environment Summary

B piscovered || ActivevMs ] PowerOff VMs Suspended VMs || Unknown State VMs

1] 20 40 60 80 100
Previous | [ Next | [ Finish
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24. Click Next to Add Email Setup & SMTP Relay Host detail.

Try our new User Interface

Email Notification Setup

[ Receive emails for Critical Operations Manager notifications

Email Address: clsco.com

SMTP Relay Host: RVATI

Note: [

This sets up the default recipient of email notifications. You can always change these settings at a later time.
Change SMTP Host configuration via Admin View > Maintenance, in the SMTP Relay form.
Change the recipient address via Policy View > Email/Trap Notification > 'To' Address.

Dy

| Previous || Next || Finish |

Maybe later

Don't show again

25. Click Next.

26. When the CWOM installation is completed, a page will pop-up providing access to the Documentation,
Videos, and Support .
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Getting Started

Congratulations and thank you for installing Operations Manager. You are one step closer to a better
performing and more efficient virtualized environment! To help you get started, we recommend the following:

Operations Manager Documentation
Click here to open the online help. The Operations Manager User Guide is organized by functionality. It
can walk you through the capabilities of Operations Manager in a very systematic fashion, if that's how you
learn best.

Operations Manager Product Videos
Click here to get the most out of Operations Manager. These videos show the unique capabilities of Operations
Manager and how it enables you to assure application performance while maximizing efficiency.

Support
=, Click here to visit the VMTurbo Knowledge Center. This is your portal to Operations Manager Support,
" giving you access to forums, a knowledge base, and support request forms.

Previous Finish
27. Click Finish.

28. On the New User Interface, click Try it Now. It will open another login page.

o),
cisco

Cisco Workload Optimization Manager

USERNAME

PASSWORD

| Remember me
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# A pop-up will appear for a Quick Tour, you can click TAKE THE TOUR or Skip. TAKE THE TOUR will
lead you all the tab and relevant information about new GUI how to use them. If you have this infor-
mation you can skip it.

I
CISCO
Quick Tour Before You Start

Operations Manager functionality is the same whether you interact with it from
here or the old UI.
Plans begin by snapshotting your environment.

Plan results can be committed and applied to the environment.
This is work in progress... your feedback is important.
Click the @ button at the bottom-left to share your feedback.

[

SKIP TAKE THE TOUR

# When you complete your TAKE THE TOUR or SKIP it, you will see different object and their relationship under
the Global Environment which system builds automatically based on your environment.

CWOM Summary

With the CWOM Platform and Cisco UCS data center operators are empowered to deliver differentiated
performance while making best use of the holistic environment. The joint solution offers insights into private
or public cloud resources critical in maintaining efficiency of the applications, optimizing operational costs
and delivering the performance end-users depend on.

Deploying CWOM in a UCS environments provides the following benefits:

¢ Intelligently place and scale workloads based on matching real-time demand to underlying shared
infrastructure to assure performance while optimizing costs

e Define and maintain service levels by managing optimal resource allocation to prevent under
provisioning and avoid performance degradation

e Automate actions including new workload placement and server profile provisioning, to effectively and
efficiently scale

e Gain visibility into UCS integrated infrastructure performance and capacity for service profiles, chassis,
I/0 modules, adapters, virtual interface cards, ports, and uplinks for detailed data center monitoring
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e Plan for changes in the environment from migrating to a new hypervisor, to refreshing hardware,
consolidating data centers or migrating to the public cloud

The combination of Cisco UCS and CWOM enables data center operators to accelerate service delivery,
assure performance and optimize costs.

CWOM Documentation Quick Links
e Target Configuration: http://docs.turbonomic.com/target-configuration

e Fabric Manager Targets: http://docs.turbonomic.com/fabric-manager-targets
e Complete CWOM Documentation: http://docs.turbonomic.com/

e Green Circle Community Forum: https://greencircle.vmturbo.com/welcome

e CWOM Resource Library: https://turbonomic.com/resources/
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